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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.  

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).



Table of Contents

Preface
Purpose of the User Manual. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
New and Updated Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
Manual Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Default User Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Rebranding of FactoryTalk Linx Software . . . . . . . . . . . . . . . . . . .  11
Action Identifier  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Configure Programs Menu. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12
Additional Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Chapter 1
Configure Network 
Infrastructure

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
PlantPAx Topology Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16
VLAN Basics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Common Network Switch Configurations . . . . . . . . . . . . . . . . . . . . . .  20
Verify Workstation IP Address Settings . . . . . . . . . . . . . . . . . . . . .  20
Configure the Switch Express Setup. . . . . . . . . . . . . . . . . . . . . . . . .  21
Complete Switch Optimization  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Distribution Switch Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
Enable Switch Routing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37
Configure EtherChannels (Link Aggregation)  . . . . . . . . . . . . . . .  38
Configure Switch Ports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39
Using a Terminal Emulator (PuTTY) . . . . . . . . . . . . . . . . . . . . . . .  41
Enabling IP Helper . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Chapter 2
Control Network Switch 
Configurations

Before You Begin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Configure Smartports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47
I/O Network Switch Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . .  52
Star Topology Switch Configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . .  53

Configure Controller Switches  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54
Configure I/O Switches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55
Configure MCC Switches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Ring Topology Switch Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . .  58
Configure Controller Switches  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59
Enable a DLR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60
Configure MCC Switches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62

Redundant Star Switch Configuration . . . . . . . . . . . . . . . . . . . . . . . . . .  63
Configure Controller Switches  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64
Configure PRP Distribution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68
Enable PRP I/O (RedBox) Switch . . . . . . . . . . . . . . . . . . . . . . . . . .  71
Configure MCC Switches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  72

Optimize Switches for Redundant Controllers. . . . . . . . . . . . . . . . . . .  73
Configure Switch Routing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73
Configure a Static IP Address. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  74
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 3



Table of Contents
Chapter 3
Configure System Servers Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  78

Configure the Primary Domain Controller . . . . . . . . . . . . . . . . . . . . . .  79
Configure a Secondary Domain Controller . . . . . . . . . . . . . . . . . . . . . .  86
Create a Reverse DNS Lookup Zone. . . . . . . . . . . . . . . . . . . . . . . . . . . .  93

Map Host Name to IP Address . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  96
Enable DHCP in the Primary and Secondary Controllers  . . . . . . . .  99

Add DHCP Server Role  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  99
Configure DHCP Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  102
Enable DHCP Scope (Control Network)  . . . . . . . . . . . . . . . . . .  104
Enable DHCP Scope (Supervisory Network) . . . . . . . . . . . . . . .  107
Configure Failover. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  110

Join the Domain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  113
Confirm Computers in DNS Server. . . . . . . . . . . . . . . . . . . . . . . .  116
Confirm Computers in DHCP Server  . . . . . . . . . . . . . . . . . . . . .  117

Create Groups and Users  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  118
Unit Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  118
Role Groups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119
Area Groups  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Create Users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  123
Assign Users to a Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  125

Chapter 4
Configure Group Policy 
Management

Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  131
Default Domain Controller Policy. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  133

Configuring the NTP Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  133
Configuring Windows Time Service  . . . . . . . . . . . . . . . . . . . . . . .  139
Enforcing the Domain Controller Policy . . . . . . . . . . . . . . . . . . .  140

Default Domain Policy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  143
Configuring an NTP Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  143
Configuring Windows Time Service  . . . . . . . . . . . . . . . . . . . . . . .  147
Configuring Password Strength. . . . . . . . . . . . . . . . . . . . . . . . . . . .  148
Configuring Account Lockout Policy  . . . . . . . . . . . . . . . . . . . . . .  150
Configuring Kerberos Policy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154
Configuring an Interactive Logon. . . . . . . . . . . . . . . . . . . . . . . . . .  155
Enforcing the Domain Policy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158

PlantPAx Users Policy Object . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
Define Group Access Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160
USB Drive Protection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161
Configure Portable Device Enumerator Service  . . . . . . . . . . . . .  163
Software Access Restriction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  165
4 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Table of Contents
Chapter 5
Configure FactoryTalk 
Components

Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  167
Configure the FactoryTalk Directory . . . . . . . . . . . . . . . . . . . . . . . . . .  169

Enable Windows Firewall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171
Define Network Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  172

Use FactoryTalk Activation to Apply Licenses . . . . . . . . . . . . . . . . . .  175
Open Activation Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  175

Use FactoryTalk Patches From the PCDC . . . . . . . . . . . . . . . . . . . . .  177

Chapter 6
Configure FactoryTalk Security Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  183

Configure FactoryTalk Users and Groups . . . . . . . . . . . . . . . . . . . . . .  185
Assign User Domain to FactoryTalk Directory. . . . . . . . . . . . . .  185
Create Internal Users and Groups  . . . . . . . . . . . . . . . . . . . . . . . . .  191

Define FactoryTalk System Policies . . . . . . . . . . . . . . . . . . . . . . . . . . . .  193
Use Default Terminal Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  193
Use the Same FactoryTalk Log On. . . . . . . . . . . . . . . . . . . . . . . . .  194
Restrict Application Authorization . . . . . . . . . . . . . . . . . . . . . . . .  195
Audit Security Actions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196

Define the Security System Policy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  197
Define FactoryTalk Product Policies . . . . . . . . . . . . . . . . . . . . . . . . . . .  199
Create Permission Sets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  200

Chapter 7
Configure the Controller Consideration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  203

Use Architect for Controller Initiation. . . . . . . . . . . . . . . . . . . . . . . . .  205
Change Controller Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  207
Configure Network Adapters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  210
Synchronize the Project. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  212
Configure RSLinx Classic Software . . . . . . . . . . . . . . . . . . . . . . . . . . . .  213
Download the Controller . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  216
Enable Controller Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  217

Create a Controller Logical Name  . . . . . . . . . . . . . . . . . . . . . . . . .  219
Configure Authority Identifier  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  220
Configure Communication Restrictions. . . . . . . . . . . . . . . . . . . .  223
Configure Data Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  224
Configure Code Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  225
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 5



Table of Contents
Chapter 8
Configure Time 
Synchronization

Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  233
Configure UTC Time Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  234

Configure Internet Time Synchronization. . . . . . . . . . . . . . . . . .  234
NTP to PTP Clock Conversion  . . . . . . . . . . . . . . . . . . . . . . . . . . .  236
Configure GPS Time Synchronization . . . . . . . . . . . . . . . . . . . . .  236

Configure PTP Time Synchronization for Ethernet Bridges  . . . . .  239
Enable Switch Port Modes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240
Configure PTP Time Synchronization for Controllers  . . . . . .  241

Chapter 9
Configure the Process 
Automation System Server 
(PASS)

Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  243
Configure Servers on PASS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  245

Configure the Application  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  245
Configure the HMI Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  247
Primary HMI Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  247
Configure the Data Server. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  250
Configure the Alarm and Event Server  . . . . . . . . . . . . . . . . . . . . .  254

Commit Project. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  256
Configure Redundancies. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  257

Enable HMI Redundancy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  257
Enable Data Server Redundancy . . . . . . . . . . . . . . . . . . . . . . . . . . .  266
Shortcut Configuration Paths  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  267
Redundant ControlLogix Controller. . . . . . . . . . . . . . . . . . . . . . .  274
Enable Alarm and Event Redundancy . . . . . . . . . . . . . . . . . . . . . .  279

Create Alarm and Event Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  281
Define HMI Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  284

Configure FactoryTalk SE Security  . . . . . . . . . . . . . . . . . . . . . . . .  284
Configure PanelView Plus  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  293

Create a FactoryTalk View ME Project . . . . . . . . . . . . . . . . . . . . .  293
Configure FactoryTalk View ME Security . . . . . . . . . . . . . . . . . .  300
Configure Time Synchronization for PanelView Terminals . .  306
Download the Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  309
6 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Table of Contents
Chapter 10
Configure an Application Server 
Information Server (AppServ-
Info) 

Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  313
FactoryTalk Historian . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  313
FactoryTalk VantagePoint  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  313

Configure Historian SE Server Collective  . . . . . . . . . . . . . . . . . . . . . .  315
Create a Firewall Rule for Primary Historian Server  . . . . . . . . .  315
Create a Firewall Rule for Secondary Historian Servers  . . . . . .  318
Change the Historian Identification . . . . . . . . . . . . . . . . . . . . . . .  319
Set Security Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  321
Create a Server Collective . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  327

Configure a Historian SE Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  331
Create a Historian Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  331
Create a Synchronization Path. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  340

Configure a Node Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  346
Configure Primary Node Interface Server. . . . . . . . . . . . . . . . . . .  346
Configure Secondary Node Interface Server  . . . . . . . . . . . . . . . .  362

Configure FactoryTalk Live Data Connectors . . . . . . . . . . . . . . . . . .  362
Configure a FactoryTalk Live Data Primary Connector. . . . . .  363
Configure a FactoryTalk Live Data Secondary Connector  . . .  366
Confirm Unit Failover Diagnostics  . . . . . . . . . . . . . . . . . . . . . . . .  374

Configure a Performance Monitor Interface . . . . . . . . . . . . . . . . . . . .  377
Create PIPerfMon System User. . . . . . . . . . . . . . . . . . . . . . . . . . . .  377
Configure the PIPerfMon Interface . . . . . . . . . . . . . . . . . . . . . . . .  379
Import PIPerfMon Digital State . . . . . . . . . . . . . . . . . . . . . . . . . . .  383
Create PIPerfMon Interface Health Points . . . . . . . . . . . . . . . . .  386
Monitor PIPerfMon Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  390

Enable Performance Monitor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  391
Adding PIPerfMon User . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  391
Adding PIPerfMon Firewall Rule . . . . . . . . . . . . . . . . . . . . . . . . . .  394
Enabling PIPerfMon Counter Service . . . . . . . . . . . . . . . . . . . . . .  399

Configure FactoryTalk Historian Connectivity . . . . . . . . . . . . . . . . .  400
View PI Builder Excel Add-in  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  402
Configure FactoryTalk VantagePoint Historian Tags  . . . . . . . . . . .  403

Chapter 11
Configure Asset Management 
(AppServ-Asset)

Considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  407
Configure Diagnostic Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  409

View Audit Log  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  411

Appendix A
Access the Attachments Open Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  413

How to Use Attachments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  414
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 7



Table of Contents
Appendix B
Define a Workgroup and 
DeskLock Utility

Enable the Windows DeskLock Utility (optional)  . . . . . . . . . . . . . .  417

Appendix C
Firewall Configurations Common Ports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  421

Rockwell Automation TCP/UDP Ports  . . . . . . . . . . . . . . . . . . . . . . .  421

Index
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  425
8 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Preface

The PlantPAx® system provides a modern approach to distributed control by 
using common technology (integrated architecture) shared with all other 
automation disciplines within the plant. This approach creates a seamless 
information flow across the plant to create optimization opportunities and 
enables a Connected Enterprise.

Our scalable platform provides you with the flexibility to implement a system 
appropriate for your application. Figure 1 shows the documents (this manual in 
the highlighted section) that are available to help design and implement your 
system requirements.

Figure 1 - PlantPAx System Implementation and Documentation Strategy

• Define and Procure – Helps you understand the elements of the PlantPAx 
system to make sure that you buy the proper components.

• Install – Provides direction on how to install the PlantPAx system.
• Prep – Provides guidance on how to get started and learn the best 

practices to follow before you develop your application.
• Develop – Describes the actions and libraries necessary to construct your 

application that resides on the PlantPAx system.
• Operate – Provides guidance on how to verify and maintain your systems 

for operation of your plant.

Purpose of the User Manual

This manual provides screen facsimiles and step-by-step procedures to configure 
infrastructure components for your system requirements. While flexibility and 
scalability are among the strengths of the PlantPAx system, we offer suggestions, 
such as how to set IP addresses and naming conventions, to help you get started. 
We suggest that you perform the tasks in the order that is outlined in each 
chapter. However, we explain each procedure from the start to help you reference 
specific topics if you choose to skip around to other chapters.

Each chapter has a flowchart that summaries the topics, similar to a mini
Table of Contents. See page 10 for descriptions of the tools that are used in
the documentation.

Procure Install Prep etarepOpoleveD

• Infrastructure User Manual
PROCES-UM001

• Selection Guide
PROCES-SG001

• Virtualization User Manual
9528-UM001

• Reference Manual
PROCES-RM001

• Reference Manual
PROCES-RM001

• Library of Process Objects
PROCES-RM002

• Application User Manual
PROCES-UM003

• Verify and Troubleshoot User Manual
PROCES-UM004

• Reference Manual
PROCES-RM001

• Library of Process Objects
PROCES-RM002
PROCES-RM013
PROCES-RM014
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Preface
New and Updated 
Information

This table contains the change that was made to this revision.

Manual Conventions For instructional purposes, this manual uses visual tools to complement the 
procedures. Icons that represent system elements are shown at the start of a 
section to help identify the system element that is being configured in the steps.

The abbreviation for an element is listed with the icon for identification as shown 
in the example.

See page 10 for visual naming conventions.

See Table 1 for descriptions and abbreviations of the system element icons.

Topic Page

Create OSIsoft certificates on the Primary and Secondary servers 334

Use a domain controller 
with these procedures.

PADCA

System Element Icon

System Element Identifier (see Table 1) 

System Element Description

Table 1 - Visual Naming Conventions

Icon Description Abbreviation Element Names Topic Page

Stratix switch • Stratix 5400 or Stratix 5410 Layer 2 access switch
• Stratix 5700 Layer 2 access switch

16, 21, 29, 31, 33, 35, 
38, 53, 59, 55, 56, 58, 
63, 64, 68, 71, 72

Stratix switch • Stratix 5400 or Stratix 5410 Layer 3 distribution switch 16,21, 29, 31, 33, 35, 
37, 39, 63, 73, 231, 
232

PlantPAx Domain controllers • PADCA(1) - PlantPAx parent domain controller
• PADCB(2) - PlantPAx child domain controller

79, 86, 93, 99, 102, 
116,118, 133, 140, 
143, 148, 150, 154, 
155, 158, 160, 161, 
163, 231, 232, 234, 
348, 377

PlantPAx workstations • OWS01(3) - Operator workstation
• EWS01(3) - Engineering workstation

16, 20, 113, 167, 177, 
185, 191, 193, 197, 
199, 205, 207, 210, 
212, 213, 217, 231, 
232, 236, 239, 234, 
245, 247, 254, 261, 
281, 284, 288, 293, 
383, 390, 391, 394, 
399, 400, 402, 409, 
415, 417

PlantPAx Application servers • ASIS01 - AppServ-Info SQL server
• ASIH01 - AppServ-Info Historian server
• ASIV01 - AppServ-Info VantagePoint® server
• ASAM01 - AppServ-Asset Management server
• ASBM01 - AppServ-Batch server
• ASEWS01 - AppServ-Engineering Workstation server 
• ASOWS01 - AppServ-Operator Workstation server

16, 37, 38, 39, 113, 
116, 167, 231, 232, 
315, 319, 321, 324, 
326, 327, 331, 338, 
340, 346, 350, 374, 
379, 383, 386, 390, 
394, 399, 403, 409
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Preface
Default User Name

In this manual, we use ‘Admin’ and ‘Administrator’ as referenced user names in 
sample screen examples. But, we recommend that you do not use these user 
names in production. 

Rebranding of FactoryTalk Linx Software

As of version 6.00, RSLinx® Enterprise software is known as
FactoryTalk Linx software.

Action Identifier

Dialog boxes have red boxes to identify areas that require some type of user 
action, such as to type text or click ‘Next’.

Firewall Firewall 231

PASS
(Process Automation System Server)

• PASS01 - FactoryTalk® directory
• PASS02A(1) - Primary HMI server
• PASS02B(2) - Secondary HMI server

16,175, 239, 257, 260, 
284, 331, 338, 340, 
346, 353, 362, 363, 
366, 371, 374

Logix controllers • LGXC01 - Controller
• LGXC02 - Controller

16, 58, 59, 63, 64, 68, 
73, 231, 232, 248, 250, 
252, 267, 269, 274

(1) A = Parent and/or Primary element
(2) B = Child and/or Secondary element
(3) EWS and OWS are used throughout the manual but the same procedures apply for AppServ-EWS and AppServ-OWS.

Table 1 - Visual Naming Conventions

Icon Description Abbreviation Element Names Topic Page
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Preface
Configure Programs Menu We strongly suggest that you perform the following procedure in the system 
computers to group folders under ‘Programs’ on the taskbar. When complete, you 

access Windows and software folders by clicking the Programs  symbol. 

1. Click the Windows  symbol.

2. Click Control Panel and choose Folder Options.

The Folder Options dialog box appears.

3. On the View Tab, select ‘Show hidden files, folders, and drives’
and click OK.

4. Right-click in the taskbar, click Toolbars, and choose New Toolbar.

5. On the New Toolbar window, designate a path for your Programs folder.
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Preface
For example: 
C:\ProgramData\Microsoft\Windows\StartMenu\Programs.

6. Click Select Folder.

Additional Resources These documents contain additional information that concern-related products 
from Rockwell Automation.
Table 2 - Additional Documentation

Resource Description

PlantPAx Distributed Control System Selection Guide, 
publication PROCES-SG001

Provides basic definitions of system elements and sizing 
guidelines for procuring a PlantPAx system.

PlantPAx Distributed Control System Reference Manual, 
publication PROCES-RM001

Provides characterized recommendations for 
implementing your PlantPAx system.

PlantPAx Distributed Control System Application 
Configuration User Manual, publication PROCES-UM003

Describes procedures to start development of your 
PlantPAx distributed control system. 

Rockwell Automation Library of Process Objects,
publication PROCES-RM002

Provides information on how to use the Rockwell 
Automation Library of Process Objects.

Rockwell Automation Library of Process Objects: Logic 
Instructions Reference Manual, 
publication PROCES-RM013

Provides controller codes and tags for Rockwell
Automation Library objects. The objects are grouped by 
family and attached as Microsoft Excel files to the man-
ual PDF file.

Rockwell Automation Library of Process Objects: Display Ele-
ments Reference Manual,
publication PROCES-RM014

Provides common display elements for the Rockwell 
Automation Library. For improved accessibility, the ele-
ments are combined into one manual.

Activate Rockwell Software® Products,
publication FTA-QS002

Explains how FactoryTalk Activation generates 
activation files and distributes them over the Internet to 
activate software.

Converged Plantwide Ethernet (CPwE) Design and 
Implementation Guide, publication ENET-TD001

Describes tested and validated industrial network 
architectures, recommendations and best practices, 
including network resiliency and security

Resilient Converged Plantwide Ethernet Architecture 
Technical Data, publication ENET-TD010

Describes design considerations to implement a 
scalable and secure CPwE architecture that helps 
maximize plant efficiency.

Stratix Managed Switches User Manual,
publication 1783-UM007

Describes how to set up, configure, and troubleshoot 
Stratix switches. 
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Preface
You can view or download publications at
http://www.rockwellautomation.com/literature/. To order paper copies of 
technical documentation, contact your local Allen-Bradley distributor or 
Rockwell Automation sales representative.

Embedded Switch Technology Reference Architectures, 
publication ENET-RM003

Provides design recommendations for connecting 
device-level topologies to larger, switch networks 
comprised of Layer 2 access switches. Document 
describes the implementation of embedded switch 
technology within the Converged Plantwide Ethernet 
(CPwE) Cell/Area zone. 

Application Code Manager User Manual,
publication LOGIX-UM003

Provides procedures for installing and creating projects 
and configuring library objects.

Securely Traversing IACS Data Across the Industrial 
Demilitarized Zone Technical Data, publication ENET-TD009

Describes requirements and design considerations to 
deploy an Industrial Demilitarized Zone (IDMZ) within 
Industrial Automation and Control System (IACS)
plant-wide architectures.

Ethernet Design Considerations Reference Manual, 
publication ENET-RM002

Explains the infrastructure components that allow this 
open network to communicate seamlessly throughout 
a plant, from shop floor to top floor.

Integrated Architecture® and CIP Sync Configuration 
manual, publication IA-AT003

Explains CIP Sync technology and how you can 
synchronize clocks within the Rockwell Automation® 
Integrated Architecture® system.

PlantPAx Virtualization User Manual,
publication 9528-UM001

Describes the catalog numbers and details for using 
virtual image templates to configure virtual machines.

Table 2 - Additional Documentation

Resource Description
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Chapter 1

Configure Network Infrastructure

Overview A traditional distributed control system (DCS) is typically limited to a single 
model option for servers, workstations, and network switches. A traditional 
DCS provides specific configurations that are based on closed and fixed 
networks. This traditional approach makes it difficult to manage IT support 
and integrate with business systems.

The PlantPAx® system leverages a more 
modern approach, being open to 
commercial off-the-shelf servers, 
workstations, and servers. The PlantPAx 
system supports the adoption of the 
latest IT technology for automation, 
including virtualization. The use of virtualization breaks the dependency 
between your server and workstation system elements from the specific 
hardware that hosts those elements. By rationalizing to a common IT 
infrastructure, companies can mitigate security risks and improve uptime to 
help protect people, assets, and information.

However, without specific guidance, poor infrastructure configuration can 
cause system performance and functionality of your control system to be 
degraded. The PlantPAx System Infrastructure User Manual steps you through 
the procedures that are necessary to prepare your system infrastructure, 
inclusive of operating systems and network configuration.

The performance of the PlantPAx system is dependent upon following the 
sizing guidelines and application rules that are provided by the PlantPAx 
Reference Manual. These rules and guidelines are developed through a process 
called characterization. 

Characterization is the activity of measuring system performance against key 
operational criteria called Critical System Attributes (CSA). CSAs provide 
specific recommendations for application sizing and system performance. 
Follow the instructions that are contained in this manual to help make sure 
that your control system is built as prescribed by the PlantPAx Reference 
Manual and characterization.

If you have more complex requirements, you can take advantage of the 
flexibility of the PlantPAx system. For more information, see Distributed 
Control Systems under the Products webpage.

The Converged Plantwide Ethernet (CPwE) Design and Implementation 
Guide provides a broader set of manufacturing focused reference architectures.
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Chapter 1 Configure Network Infrastructure
The CPwE manual helps accelerate the deployment of standard networking 
technologies and convergence of manufacturing and enterprise/business 
networks. You also can engage technical specialists by using Network and 
Support Services from Rockwell Automation®.

PlantPAx Topology Examples

This manual describes how to install infrastructure components,
including switches and routers, to serve as a blueprint for commissioning
a PlantPAx network.

Figure 2 is an example of a PlantPAx system topology for high availability. The 
illustration comprises different network layers, including Supervisory, 
Controller, and I/O. Each of these network layers is described in Chapter 2.

Figure 2 - PlantPAx Architecture Example

Operators and 
Engineering 
Workstations

Application Servers 
(hypervisor)

Redundant Controllers

ControlLogix® I/O
PanelView™

MCC

Supervisory Network (VLAN 601)

Control Network (VLAN 501)
I/O Network (VLAN 503)
MCC Network (VLAN 504))
Trunk - (Native VLAN 301)

EtherChannel
Secondary Connection
Logix Redundancy (RM)

Field Devices

Stratix® Switches

Supervisory Network

Control Network

I/O Network
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Configure Network Infrastructure Chapter 1
VLAN Basics

A VLAN (virtual local area network) creates network segmentation that forms 
network groups that are identified by VLAN IDs. The grouping of computers 
into VLANs enables the switches and routers to control the flow of 
information on a network.

Switches are inter-connected through trunk ports. Trunk ports send 
information from multiple VLANs between switches.

A dedicated VLAN called native VLAN is defined on trunk ports. A native 
VLAN transports, by default, all VLANs on a trunk port. But, a native VLAN 
is isolated because of security concerns of mixing a native VLAN with access 
and management VLANs. The native VLAN is not to have any assigned IP 
addresses. By default, the native VLAN ID is 1 but it is recommended to 
change it. For example, the native VLAN is assigned a VLAN ID of 301 in the 
example in Table 3 on page 18.

All computers, controllers, and I/O modules are connected through access 
ports. Access ports are assigned to a VLAN within the ID range of 501...509 
and 601…603 depending on the device and your architecture.

We recommend implementing physical security, like plugging unused ports 
and disabling ports that are not going to be used. For more information on 
physical security recommendations, see the PlantPAx Distributed Control 
System Reference Manual, publication PROCES-RM001.

The instructions in this manual use IP addresses that have a CIDR (Classless 
Inter-domain Routing), which contains a slash mark before a number. We 
recommend that you use the number (24) that means that the first 24 bits of 
the IP address constitutes the network address. In the example, the network 
mask is configured to 255.255.255.0 for the routing functionality to work.

Subnets are used to segment the devices in a network into smaller groups. The 
IP address and associated subnet mask are unique identifiers for the switch in a 
network. The subnet mask is the network address that identifies the 
subnetwork (subnet) to which the switch belongs.

IMPORTANT Network Address Translation (NAT) is another way to enable network 
segmentation by using switches and routers. But, we do not provide NAT 
guidelines in this manual.

IMPORTANT It is recommended to use the Crypto firmware for Stratix switches to add 
additional levels of security. The procedures in this section require the
Crypto firmware.

IMPORTANT Make sure that the IP address that you assign to the switch is not being used 
by another device in your network.

Example: 172.18.0.20/24
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Chapter 1 Configure Network Infrastructure
Table 3 describes typical VLANs and media access control (MAC) address 
ranges that are suggested for use on the PlantPAx system. More VLANs can be 
used depending on your configuration.

The following pages describe how to configure network segmentation with 
switches on the Control and Supervisory networks. 

Table 3 - Descriptions for VLANs and Ethernet Address Ranges(1)

VLAN ID (Name) EtherNet/IP Address Range Description

1 — — Not used

300 (Management VLAN)(2) 172.18.0.1 Default gateway

172.18.0.2 172.18.0.9 VLAN routing – switch addresses(3)

172.18.0.10 172.18.0.253 Application - switch addresses

301 (Native VLAN) — — Not to have any assigned IP addresses

501 (Control network) 172.18.1.1 Default gateway

172.18.1.2 172.18.1.9 VLAN routing

172.18.1.10 — Domain/DNS primary server

172.18.1.11 Domain/DNS secondary server

172.18.1.12 172.18.1.99 Servers and workstations (DHCP)

172.18.1.100 172.18.1.253 Ethernet interface to controllers for HMI and system communication

502…509 (I/O network) 172.18.[2…].1 172.18.[…9].1 Default gateway

172.18.[2…].2 172.18.[…9].9 VLAN routing

172.18.[2…].10 172.18.[…9].253 Ethernet interface between controllers and I/O modules (fixed)

601 (Supervisory network - 
wired network)

172.20.1.1 172.20.1.1 Default gateway

172.20.1.2 172.20.1.9 VLAN routing

172.20.1.10 172.20.1.25 Workstation interface

602 (Supervisory network - 
wireless network)

172.20.2.1 172.20.2.1 Default gateway

172.20.2.2 172.20.2.9 VLAN routing

172.20.2.10 172.20.2.253 Mobile interface

602 (External - untrusted network)
Note: From IDMZ (industrial 
demilitarized zone)

172.20.3.1 172.20.3.1 Default gateway

172.20.3.2 172.20.3.9 VLAN routing

172.20.3.10 172.20.3.253 External interface

(1) The referenced IP Addresses can be changed for your system requirements.
(2) All networks do not use a dedicated management VLAN, but it is a good practice. Many times, a supervisory VLAN is the same VLAN as the management VLAN.
(3) If there are more than eight Layer 3 switches on your system, more IP addresses must be reserved.

IMPORTANT One network range is assigned per VLAN only. For example, the 172.18.1.xxx 
network range is assigned to VLAN 501. Table 3 identifies nine VLANs for 
access ports to provide logical segregation of your system. More VLANS can 
be used, if necessary.
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Configure Network Infrastructure Chapter 1
Figure 3 lists the configuration topics that are described in this chapter. Click 
the page number or the links for quick access to specific information in
each subsection.

Figure 3 - PlantPAx Network Infrastructure Workflow

Start

Common Network Switch Configurations

See page 20

See Chapter 2 Control Network Switch Configurations

• Verify Workstation IP Address Settings
• Configure the Switch Express Setup
• Complete Switch Optimization

• Enable Switch Routing
• Configure EtherChannels (Link Aggregation)
• Configure Switch Ports
• Using a Terminal Emulator (PuTTY)
• Enabling IP Helper

Control Network Switch Configuration

See page 37

• See page 53 for switch configurations for Star,
Ring (DLR), and Redundant Star (PRP)
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Chapter 1 Configure Network Infrastructure
Common Network Switch 
Configurations

This section describes how to configure the Express Setup for each Stratix 
switch. We recommend that you complete the tasks in the order that they are 
listed. These tasks help to define IP addresses, create and assign VLANs, and 
enable faster network convergence time with Rapid PVST+.(1)

Verify Workstation IP Address Settings

Before you start switch setup, you must verify that no fixed IP address is 
assigned to the workstation that is being used to configure the switch. You 
want the switch to manage the IP address configuration in your computer. 
Complete these steps.

1. Click the Windows  symbol.

2. Click Control Panel and choose Network and Sharing Center>Change 
adapter settings.

The Network Connections dialog box appears.

3. Right-click the network and choose Properties.

4. Double-click Internet Protocol Version 4 (TCP/IPv4).

The Internet Protocol Version 4 Properties dialog box appears.

5. Select Obtain an IP address automatically and Obtain DNS server 
address automatically, and click OK. 

You are ready to assign an IP address to the switch by using the express setup.
See page 21.

(1) Default mode (MST) is comparably the same performance as RPVST+, just a different standard.

Use an Engineering Workstation 
with these procedures.

EWS
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Configure Network Infrastructure Chapter 1
Configure the Switch Express Setup

You must configure Switch Express Setup for each switch in your system. The 
settings enable the switches to operate as managed switches with a default 
configuration that supports industrial automation.

Initiate Express Setup

The following steps require a switch with factory defaults. An out-of-box 
switch is ready for these steps. You can reset an existing switch by pressing the 
Express Setup button for 16…20 seconds to default switch settings. After a 
restart, the switch can be initialized.

1. On the Ethernet switch, press once on the Express Setup button (as 
identified on the devices by red circles).

2. Connect a network cable from your workstation to the flashing
switch port.

Continue with Configure Security Exception on page 22.

IMPORTANT We walk you through how to configure a 5410 Stratix switch. The steps are 
basically the same for different switch types. Make sure that for each switch 
you repeat the steps on pages 21…36.

TIP The Express Setup button is recessed in the hole. Use a small tool or 
a paper clip to reach the button. 

Use Layer 2 and Layer 3 switches with these procedures.

Stratix 54x0 
Layer 3

Stratix 54x0 
Layer 2

Stratix 5700 
Layer 2

Stratix 5410

Stratix 5400 Stratix 5700
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Chapter 1 Configure Network Infrastructure
Configure Security Exception

We recommend that you use the Crypto version of Stratix switches. This 
version provides a self-signed certificate to each switch. You must add a 
security exception for the application to initialize each switch.

1. Start a web browser session.

2. Type the IP address 169.254.0.1 into the browser and press Enter to 
navigate to the switch that you are setting up.

Follow the browser message prompts in steps 3…5.

3. Click Advanced.

IMPORTANT Our recommended web browsers are Internet Explorer and Mozilla Firefox.
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Configure Network Infrastructure Chapter 1
4. Click Add Exception.

5. Click Confirm Security Exception.
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Chapter 1 Configure Network Infrastructure
6. On the switch Login page, leave the Username blank and type ‘switch’ 
for the default password.

7. Click Log In.

The Device Manager dialog box appears.

Continue to Configure a Switch in Device Manager on page 25.

TIP The ‘switch’ password lets you continue to the Device Manager for 
additional steps. We recommend that you change the default 
password in step 2 on page 25.
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Configure Network Infrastructure Chapter 1
Configure a Switch in Device Manager

You must complete this section for each switch in your system to define 
settings for managed switches. The Device Manager has two sections: Network 
Settings and Advanced Settings (see page 26).

The Network Settings portion of the dialog box provides the ability to perform
the following:

• Name the switch
• Select the VLAN
• Set IP addresses
• Create a password (to replace the ‘switch’ default).

1. Type the switch configuration that is similar to the example shown in 
the illustration and the IP addresses in Table 4.

2. Type a user name.

Change the default ‘admin’.

3. Type a password (which replaces the default ‘switch’).

Retype the password to confirm your entry.

Table 4 - Management Network IP Addresses

Host Name Management (VLAN) IP Address Mask Default Gateway NTP Server(1)

SW001 300 (management) 172.18.0.1 255.255.255.0 172.18.0.1 172.18.1.10

(1) NTP server can be a different address according to the Time Synchronization application option.

IMPORTANT The IP addresses and default gateway for the 5410 switch example 
are for illustration purposes only.
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Chapter 1 Configure Network Infrastructure
4. In the Advanced Settings, make sure that you click the SSH
(secure shell) checkbox.

SSH provides more security for remote connections than Telnet by 
providing strong encryption.

5. Click Submit.

A message appears.

See Table 5 on page 27 to configure additional managed switches in 
your system.

Must be checked
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6. Table 5 shows the IP addresses to be used with these procedures for each 
switch in your system.

Table 5 - Network IP Addresses

Host Name (Switch Type) Management (VLAN) IP Address Mask Default Gateway NTP Server(1)

SW010 300 (Management) 172.18.0.10 255.255.255.0 172.18.0.1 172.18.1.10

SW020 172.18.0.20

SW022 172.18.0.22

SW030 172.18.0.30

SW040 172.18.0.40

SW042 172.18.0.42

SW043 172.18.0.43

SW044 172.18.0.44

(1) NTP server can be a different address according to the Time Synchronization application option.
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Complete Switch Optimization

After you have completed the Express Setup procedures for all your system 
switches, you must log in to each switch. The following pages describe how to 
optimize switch operation for these functions:

• Create a VLAN
• Enable CIP VLAN
• Enable Rapid PVST+
• Enable Precision Time Protocol (PTP)
• Enable Simple Network Management Protocol (SNMP)

Login to Switches

Use your login name and password to access a desired switch.

1. On the workstation that is being used, change your network
adapter address to a fixed mode by following steps on page 21
through page 27.

Choose an IP address under the management network range 
(172.18.0.xxx)/255.255.255.0/172.18.0.1. See suggestions in
Table 4 and Table 5.

2. Connect to another switch port.

3. Log into the switch by using the same information that you entered on 
the Device Manager on page 25.

4. Click Log In and proceed to page 29.
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Create a VLAN

A VLAN segments switches and routers in specific subnets to control the flow 
of information.

1. From the main menu of the Device Manager, click Configure and 
choose Network>VLAN Management.

2. Click Add.

3. Create the native VLAN ID and click OK.

Our example is 301.

IMPORTANT This procedure requires that the VLAN and IP addresses are assigned as 
outlined in Table 3 on page 18. Do not use VLAN 1. The following example
is for switch SW001.

Use Layer 2 and Layer 3 switches with these procedures.

Stratix 54x0 
Layer 3

Stratix 54x0 
Layer 2

Stratix 5700 
Layer 2

IMPORTANT A native VLAN is separate from the infrastructure VLANs as well as 
the other CIP VLANs that are used.
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4. Repeat step 2 and create a range of VLANS (501…509 and 601…603).

5. Click OK.

The VLANs appear as listed in the graphic.
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Enable CIP VLAN

The CIP VLAN is used to create infrastructure diagnostics and configurations 
in the application level. For our example, CIP VLAN is isolated from the 
management VLAN (300).

Table 6 shows example IP addresses to be associated with the switches for
CIP VLAN.

Complete these steps to configure CIP VLAN for each applicable switch.

1. From the main menu of the switch Device Manager, click the Admin tab 
and choose Device Management>Express Setup.

Table 6 - Example CIP VLAN Configuration(1)

(1) If there are more than eight switches on your system, more IP Addresses must be reserved. Additional switch IP Addresses start 
with a higher number.

Host Name CIP (VLAN) IP Address Mask

SW020 501 (Control network) 172.18.1.200 255.255.255.0

SW022 172.18.1.202

SW023 172.18.1.203

SW030 172.18.1.210

SW040 172.18.1.220

SW042 172.18.1.222

SW043 172.18.1.223

SW044 172.18.1.224

SW045 172.18.1.225

Use Layer 2 and Layer 3 switches with these procedures.

Stratix 54x0 
Layer 3

Stratix 54x0 
Layer 2

Stratix 5700 
Layer 2
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2. In the Advanced Settings section, type the information as shown
in Table 6.

T

3. Click Submit.

IMPORTANT SW001 and SW010 (Stratix 5410 switches) do not enable
CIP VLAN because these switches are not used in the
controller I/O configuration.
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Enable Rapid PVST+

Complete these steps for all switches to enable Rapid Per-VLAN Spanning 
Tree Plus (Rapid PVST+). This functionality provides better convergence 
time for communication.

1. From the main menu of the switch Device Manager, click Configure and
choose Network>Spanning Tree>STP Settings.

2. Select Rapid PVST+ from the Spanning Tree Mode pull-down, and 
click Submit.

A warning message appears.

IMPORTANT  This procedure requires that the VLAN and IP addresses are assigned as 
outlined in Table 5 on page 27. The following example is for SW001.

Use Layer 2 and Layer 3 switches with these procedures.

Stratix 54x0 
Layer 3

Stratix 54x0 
Layer 2

Stratix 5700 
Layer 2
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The Spanning Tree of all the VLANs is enabled.

In order to create a predictable spanning tree 
convergence, we recommend that you change the 
VLAN priorities (lower number is higher priority). 
For example, configure all SW001 VLANs with a 
priority of16384.

IMPORTANT Do not enable Rapid PVST + if you have non-Cisco/Stratix switches 
on your network. The use of Rapid PVST+ with non-Cisco/Stratix 
switches could result in a longer convergence time after a fault
has occurred.
34 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure Network Infrastructure Chapter 1
Enable Precision Time Protocol (PTP)

PTP functionality is necessary for end devices to operate in the same time 
frame as with the clock that is deemed the Grandmaster clock. This section 
describes how to enable PTP in switch ports.

For details on time synchronization, see Chapter 8.

1. From the main menu of the switch Device Manager, click Configure and
choose Network>PTP.

2. Do one of the following from the Mode pull-down depending on the 
switch that is used:
• For the 5400 switch, select NTP-PTP clock and type Priority 1

and Priority 2
• For the 5700 switch, select Boundary.

By default, PTP is enabled for the ports.

3. Click Submit.

Use Layer 2 switches with these procedures.

Stratix 5400 
Layer 2

Stratix 5700 
Layer 2

IMPORTANT Boundary clock is required when using a PRP network topology or a 
DLR redundant gateway. By selecting boundary clock, it’s necessary 
to configure the VLAN ID to be propagated (for example, 300) under 
device clock details in the device manager or via the terminal 
emulator interface (CLI).
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Enable Simple Network Management Protocol (SNMP)

Enable SNMP to provide connectivity for FactoryTalk® AssetCentre inventory 
discovery and FactoryTalk® Network Manager™. Complete these steps.

1. From the main menu of the switch Device Manager, click Configure and
choose Security>SNMP.

2. Click Community Strings.

3. Click Add.

A popup window appears.

4. Type a community string in the Community text field.

Our example shows ‘PlantPAx’.

5. Use the default of ‘ro’ (read-only) from the RO/RW pull-down menu.

6. Click OK.

IMPORTANT You must repeat the steps on pages 21…36 for each switch in your
PlantPAx system.
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Distribution Switch 
Configuration

The Control Network is aptly named for its control of switches between the 
Supervisory Network and the I/O Network. If different subnets are
applicable, Control Network switches serve as distribution switches to
perform routing.

Figure 4 - Control Network Switches

Enable Switch Routing

Complete these steps to enable routing for the SW001 switch. While switches 
apply VLAN segmentation and forward data within a VLAN on the same 
network, routers send data between multiple VLANs and connect different 
networks. Routers act as dispatchers to choose the best path to travel for faster, 
efficient communication.

1. From the main menu of the Device Manager, click Configure and 
choose Routing.

2. Click Enable Routing

3. Validate the gateway is set to 172.18.0.1

4. Click Submit.

To Supervisory Network

To Control Network

For color legend, see page 16.

SW001

SW010

Gi1/1
Gi1/2

Te1/25 Te1/26

Gi1/1-12

Gi1/13 Gi1/14

Gi1/4

Gi1/3
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Configure EtherChannels (Link Aggregation)

Port link aggregation, also called EtherChannel, lets you combine multiple 
Ethernet ports to improve the aggregated file transfer speed. Link aggregation 
also provides redundancy if one of the links fails

An aggregation group combines a number of physical ports to create a single 
data path. This single data path shares the traffic load among the member ports 
in the group.

Table 7 identifies EtherChannel ports.

Complete these steps to configure the EtherChannels for SW001 and for the 
Layer 2 switches that link back to SW001.

1. On the Device Manager, click Configure and choose EtherChannels.

SW001
Gi1/2
Gi1/1Host 1 Host 2

Port channel 1 Port channel 2

Gi1/4

For color legend, see page 16.

SW010

Gi1/3

Te1/25 Te1/26

Port channel 3

Table 7 - Control Network Access

Port Role VLAN

Gi1/1…Gi1/2
(EtherChannel Po1)

Desktop for Automation 501 (Control network)

Gi1/3 … Gi1/4
(EtherChannel Po2)

Gi1/5…Gi1/24 Switch for Automation 301 (Native VLAN)

Te1/25 … Te1/26
(EtherChannel Po3)

Te1/27…Te1/28 — —
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2. Click the Add button.

3. Type a group number for the EtherChannel.

4. From the Channel Mode pull-down, select LACP (Active).

5. In the Port List, select the ports that are used for the EtherChannel.

6. Click OK.

Configure Switch Ports

The greater the number of available ports the more additional devices, as 
necessary, you can add to your PlantPAx system.

See page 38 for an illustration and a table with port descriptions.

Complete these steps to configure ports.

1. On the Device Manager, click Configure and choose Port Settings.
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2. Select an EtherChannel port and click Edit.

3. Do the following to configure the port:
a. Type a port description
b. Click the Administrative Mode pull-down and select Trunk
c. Change the Access VLAN and Native VLAN to ‘Native 301’

d. Click OK
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4. Repeat steps 1…3 on SW001 to create an EtherChannel port for each 
Layer 2 switch that is to be connected.

5. Follow the same steps on the Layer 2 switches to complete the 
EtherChannel.

Using a Terminal Emulator (PuTTY)

Besides the Device Manager, the Cisco IOS command-line 
interface (CLI) enables you to configure, monitor, and 
maintain Cisco switches. The CLI interface is not available via 
a web browser like the Device Manager. Therefore, you must 
configure a terminal emulator to use the CLI interface.

We recommend that you use a terminal emulator, such as 
PuTTY, to access the CLI interface. PuTTY is an open-source software that is 
available with source code, which a group of volunteers develops and supports.

Complete these steps for an Ethernet connection.

1. From the PuTTY Configuration dialog box, click the Session category.

2. Type a host name or an IP address.

IMPORTANT Access the switch by using a Secure Shell (Ethernet) connection (SSH) or via 
a Console (Serial) Port. By using SSH, it’s necessary to be connected through 
a management VLAN (300).

TIP The following steps are for enabling an SSH (secure shell) connection. See 
page 42 if you are using a Serial connection.
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3. Select SSH and click Open.

Complete these steps for a Serial connection.

1. From the PuTTY Configuration dialog box, click the Serial category.

2. Use the dialog box options as shown and click Open.

When you click Open with either connection procedure (SSH or 
Serial), the Cisco CLI appears.

TIP Skip this procedure if you are enabling an SSH connection, which is 
explained on page 41.

COM5 is an example only. 
You must use the COM 
port that corresponds to 
your specific devices.
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Enabling IP Helper

In this section, we are configuring the IP helper-address for each VLAN, which 
uses the system DHCP servers. An IP helper-address command is required 
when the DHCP server is connected to a different subnet.

Complete these steps to configure SW010 (as shown on page 39).

1. Repeat steps 1…2 on page 41 or steps 1…2 on page 42 if you are using an 
Ethernet or Serial connection to access the command line
interface (CLI).

When you click Open with either connection procedure (SSH or 
Serial), the command interface appears. 

On the terminal emulator interface (CLI), type the text exactly as shown 
in boldface for each prompt. Press Enter after each entry.

2. Type the following to login.
login as: admin
Using keyboard-interactive authentication.
Password:

3. Enable configuration mode.
SW001#configure terminal
Enter configuration commands, one per line. End with CNTL/Z.

4. Copy and paste the information in Table 8 into a text editor, such
as Notepad.

5. In a text editor, edit the configuration according to application 
requirements.

6. Copy from the text editor, and paste into the terminal emulator 
configuration software.

7. Type end and press Enter.

Table 8 - Routing Configuration

SW001

!
interface Vlan601
ip helper-address 172.18.1.10 redundancy 172.18.1.11
!
interface Vlan602
ip helper-address 172.18.1.10 redundancy 172.18.1.11
!
interface Vlan603
ip helper-address 172.18.1.10 redundancy 172.18.1.11

IMPORTANT Do not use the Ctrl+V command to paste the data into the PuTTy 
software. Right-click the mouse to paste the information in one, 
single file.
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8. At the SW001# prompt, type copy running-config startup-config.

9. Confirm the routing status by using the terminal emulator interface.
SW001#show running config

IMPORTANT If you do not execute step 8 your configuration is lost during a
power cycle.
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Chapter 2

Control Network Switch Configurations

This chapter describes switch configurations for several topologies depending 
on your application requirements. Each of these topologies for a PlantPAx® 
system is explained separately to provide illustrations and procedures for the 
necessary port settings on the Control Network.

Topologies, and respective pages, include the following:
• Star, see page 52
• Ring (redundant DLR), see page 58
• PRP (redundant Star), see page 63

Regardless of your experience with switch configuration, we recommend that 
you follow the procedures on how to select the correct type of ports for devices, 
starting on page 47.

This chapter includes illustrations and procedures on how to configure 
redundant media. Port aggregation links two Ethernet ports to provide 
redundancy if one of the links fails.

Before You Begin Before starting the procedures in this chapter, you must complete common 
network configuration for all switches in your PlantPAx system. See Chapter 1 
for how to initiate switches.

Managed switch configuration includes the following:
• Switch Express Setup
• VLAN segmentation
• Rapid PVST+
• Precision Time Protocol (PTP)
• Simple Network Management Protocol (SNMP)
• Switch routing
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Figure 5 lists the topics that are described in this chapter. Click the page 
number or the links for quick access to specific information in each subsection.

Figure 5 - PlantPAx Topology Configuration Workflow

Start

Configure Smartports

See page 47

Topology

Star Topology Switch Configuration

See page 53

Ring Topology Switch Configuration

See page 58

Redundant Star Switch Configuration

See page 63

Optimize Switches for Redundant Controllers

See page 73

See Chapter 3

• Identify Connected Devices with a Port Description
• I/O Network Switch Configuration

• Configure Controller Switches
• Configure I/O Switches
• Configure MCC Switches

• Configure Controller Switches
• Enable a DLR
• Configure MCC Switches

• Configure Controller Switches
• Configure PRP Distribution
• Enable PRP I/O (RedBox) Switch
• Configure MCC Switches

Configure System Servers

• Configure Switch Routing
• Configure a Static IP Address
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Configure Smartports Device Manager is a web-based management tool for configuring, monitoring, 
and troubleshooting individual switches. You can display Device Manager 
from anywhere in your network through a web browser. Device Manager 
displays real-time views of switch configuration and simplifies configuration 
tasks with features such as Smartports.

Smartports help designate the ports that are pre-defined for the application. 
Port roles are based on the type of devices to be connected to the switch ports. 
For example, the Desktop for Automation port role is specifically for switch 
ports to be connected to computers.

Table 9 describes the port types that are selected with procedures in
this section.

Table 9 - Available Ports

Smartport Description

Automation Device The Automation Device Smartport is used for any EtherNet/IP devices. Devices include controllers, HMI displays,
distributed I/O, and so forth. The Automation Device Smartport enables the following features:
• Sets the port to host mode that enables Spanning Tree PortFast and BPDU Guard
• Enables port security (one MAC address per port)
• Sets the VLAN number
• Enables the automation QoS policy
• Configures the output queues
• Enables the alarm profile
• Disables Cisco Discovery Protocol (CDP)

Multiport Automation device Apply this role to ports connected to multiport EtherNet/IP devices, such as multiport EtherNet/IP devices arranged in a linear 
or daisy chain topology. You also can use this role for Device Level Ring (DLR). The following devices apply:
• 1783-ETAP module (for connection to the device port only)
• Unmanaged switches (such as the Stratix® 2000)
• Managed switches with Rapid Spanning Tree Protocol (RSTP) disabled:

– Port is set to Access mode
– No port security
– Optimize queue management for CIP™ traffic

Desktop for Automation The Desktop for Automation Smartport can be used for computers on the Cell/Area zone EtherNet/IP network. Do not use this 
port role for any systems that run virtual machines without turning off the port security configuration. This Smartport enables 
the following features:
• Sets the port in access mode
• Set the VLAN number
• Enables port security (one MAC address per port)
• Enables Spanning Tree PortFast
• Enables Spanning Tree BPDU Guard
• Enables the automation QoS policy
• Sets the alarm profile
• Provides up to two MAC addresses per port (physical computer and virtual machine)

VM-Desktop for Automation Apply this role to ports connected to computers that run virtualization software. This port role can be used with devices that run 
two MAC addresses.
IMPORTANT: Do not apply the Virtual Desktop for Automation role to ports that are connected to switches, routers, or
access points.
VM-Desktop for Automation enables the following features:
• Sets the port access mode
• Enables port security (two MAC addresses per port)
• PortFast is enabled
• Set the VLAN number
• CIP-PTP-Traffic Policy enabled

Switch for Automation The Switch for Automation Smartport is used on ports that connect to other managed Ethernet switches that support STP 
(Spanning Tree Protocol). This port role enables the following features:
• Sets the port in trunk mode
• Sets the native VLAN
• Sets Spanning Tree to use a point-to-point link
• Sets the port to trust QoS policy
• Configures the output queues
• Sets the alarm profile
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Complete these steps to configure Smartports. This procedure must be 
repeated for each switchport based on the devices that you are using.

1. From the main menu of the switch Device Manager, click Configure and
choose Network>Smartports.

2. Select the desired ports and click Edit.

3. Select a desired role from the Role pull-down menu.

4. Select an Access VLAN or Native VLAN based on the use as described 
in Table 9 on page 47.

For example:

VLAN 501 – Control network

5. Click OK.
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6. Select another Smartport from the Role pull-down menu, and
click OK.

7. Select each port, click Edit, and type a Native VLAN.

For example:

VLAN 301 – Trunk
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8. Repeat step 6 and step 7 for each port that is being used.

IMPORTANT If you have a virtualized system, connect the hypervisor to a port 
with the Desktop for Automation role.
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Identify Connected Devices with a Port Description

Port settings define the application requirements. You can change these 
settings to fit your network needs and to troubleshoot network problems. The 
settings on a switch port must be compatible with the port settings of the 
connected device.

We recommend that you configure each switch port with a port description to 
help with diagnostics and maintenance. Complete these steps.

1. From the main menu of the switch Device Manager, click Configure and
choose Network>Port Settings.

2. Select a port and click Edit.

3. We recommend that in the Description text box, type the
connected device.

4. Click OK.

The switch description is listed next to the port name.
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I/O Network Switch 
Configuration

This section describes three topologies on the I/O Network, starting with a 
Star configuration. The switches that are used for each are described in their 
respective sections. Each section includes set up for controller, I/O, and
MCC switches.

See the following pages for basic PlantPAx topologies:
• Star, page 53
• Device Level Ring, page 58
• Redundant Star, page 63

Figure 6 - Control and I/O Network

LGXC01

SW020

SW022 SW023

OWS20

Control Network

I/O Network

MCC

To SW001 

Supervisory Network (VLAN 601)

Control Network (VLAN 501)

I/O Network (VLAN 502)

Safety Network (VLAN 401)

Trunk - (Native VLAN 301)
Management (VLAN 300)

Secondary Connection

Secondary Connection
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Star Topology Switch 
Configuration

Access switches serve as an uplink from the servers to the workstations. Layer 2 
switches also send packets at the controller level from the end devices. With 
multiple network levels, access switches control the flow of information to 
make sure that packets are delivered to the correct network level. Complete 
these steps.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

2. Select the desired ports and click Edit.

3. Select a desired role from the Role pull-down menu.

Example I/O configurations:

VLAN 301 – Trunk

4. Click OK.

IMPORTANT See page 47 for Smartport descriptions.

Use Layer 2 switches with these procedures.

Stratix 5700 switch
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Configure Controller Switches

Complete these steps to configure SW020 and SW021 switches to route data 
from I/O Network (Level 1) devices.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

2. Select the desired ports and click Edit.

3. Select a desired role from the Role pull-down menu and click OK.

4. Use information in Table 10 to configure switch ports.

5. Select the desired ports and click OK.

Use Layer 2 switches with these procedures.

Stratix 5700 switch

Table 10 - Control Network - Control Star

Port Role VLAN SW020

Fa1/1 Automation Device
—

501 (Control Network) LGXC01EN01A

Fa1/2 LGXC01EN01B

Fa1/3 LGXC01EN01T

Fa1/4 502 (I/O Network) LGXC01EN02

Fa1/5…Fa1/8 — — —

Fa1/9 Switch for Automation Trunk (Native VLAN 301) SW022-G1/1

Fa1/10 SW023-G1/1

Fa1/11…Fa1/12 Automation Device 501 (Control Network) SIS01EN01A

Fa1/13…Fa1/18 — — SIS01EN01B

Gi1/1(1)

(1) Ports Gi1/1 and Gi1/2 must be configured as an EtherChannel to connect to SW001.

Switch for Automation Trunk (Native VLAN 301) SW001-G1/13

Gi1/2(1) — SW001-G1/14

SW020LGXC01

Fa1/1

Fa1/2

Fa1/3

Fa1/4

Fa1/10

Fa1/12

Fa1/11

SW001 Gi1/13

SW022 SW023

LGXC01EN01A - 172.18.1.100/24
LGXC01EN01B - 172.18.1.101/24
LGXC01EN01T - 172.18.1.102/24

LGXC01EN02 - 172.18.2.010/24

Controllers - VLAN 501

I/O - VLAN 502

For color legend, see page 52.

Fa1/9

SW001 Gi1/14
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Configure I/O Switches

In our example, the SW022 switch is used for the I/O connection and the 
OWS/EWS access connection.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

2. Select the desired ports and click Edit.

3. Select Switch for Automation from the Role pull-down and click OK.

4. Use the information in Table 11 to configure switch ports.

Use Layer 2 switches with these procedures.

Stratix 5700 switch

Table 11 - I/O Network - I/O Star

Port Role VLAN SW022

Fa1/1 Automation Device 502 (I/O Network) LGXC01EN02R01

Fa1/2 LGXC01EN02R02

Fa1/3 LGXC01EN02FM01

Fa1/4…Fa1/8 —

Fa1/9 Desktop for Automation 501 (Control Network) OWS20

Fa1/10…Fa1/18 — — —

Gi1/1 Switch for Automation Trunk (Native VLAN 301) SW020 Fa1/9

Gi1/2 — — —

SW022 Gi1/1

Fa1/9

Fa1/3

OWS20
Fa1/1

Fa1/2

LGXC01EN02R02 - 172.18.2.2.12/24

SW020 - Fa1/9

LGXC01EN02R01 - 172.18.2.2.11/24

For color legend, see page 52.

IMPORTANT See page 47 for Smartport descriptions.
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Configure MCC Switches

Complete these steps to configure a Linear or Star topology for motor control 
center (MCC) devices.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

2. Select the desired ports and click Edit.

3. Select a role type from the Role pull-down and click OK.

Star

Linear

SW024 21 10

Gi1/1 Gi1/2 Gi1/1

MCC

SW023
MCC

Gi1/1

Gi1/1 Gi1/1 Gi1/11 2 10

Fa1/1

Fa1/10

For color legend, see page 52.

Gi2/1

SW025

IMPORTANT See page 47 for Smartport descriptions.
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4. Use the information in Table 12 and Table 13 to configure switch ports.
Table 12 - I/O Network - MCC Linear/Star

Port Role VLAN SW024 - Linear

Fa1/1…Fa1/15 Automation Device 502 (I/O Network) —

Fa1/16 Desktop for Automation 300 (Management) —

Fa1/17…Fa1/18 — — —

Gi1/1 Switch for Automation Trunk (Native VLAN 301) SW020-F1-10

Gi1/2 SW025-G1-1

Table 13 - I/O Network - MCC Star (Additional)

Port Role VLAN SW023 - Star

Fa1/1…Fa1/15 Switch for Automation 301 (Native VLAN) —

Fa1/16 Desktop for Automation 300 (Management) —

Fa1/17…Fa1/18 — — —

Gi1/1 Switch for Automation 301 (Native VLAN) SW020-F1-10

Gi1/2 — — —
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Ring Topology Switch 
Configuration

This section details the switch configuration for a Ring topology by using a 
Device Level Ring (DLR) on the I/O Network.

A DLR topology is a device-level network topology that helps prevent a loss of 
communication between devices if a fault occurs. Multiport EtherNet/IP 
devices equipped with DLR technology connect directly to neighboring nodes 
and form a ring topology at the end devices. If a break in the line is detected, 
the network provides an alternate routing of the data to help recover the 
network at fast rates. 

All end devices that are tightly coupled to a controller must be a part of the 
same embedded switch topology. This peer-to-peer architecture reduces the 
physical amount (and therefore cost) of cabling.

Enhanced diagnostics built into DLR-enabled products identify the point of 
failure, helping to speed maintenance and reduce mean time to repair. 

For more information, see the Embedded Switch Technology Reference 
Architectures, publication ENET-RM003.

Primary Controller Secondary Controller

SW032

SW030

MCC

ControlLogix® I/O1715 Redundant I/O

Field Devices

OWS

For color legend, see page 52.
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Configure Controller Switches

Complete these steps to select the switch ports for SW030.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

2. Select the desired ports and click Edit.

LGXC02A LGXC02B

SW030

Gi1/1 Gi1/2

Gi1/5
Gi1/7
Gi1/9

Gi1/6

SW001 G11/15 SW001 Gi1/16

LGXC02EN01A - 172.18.1.105/24
LGXC02EN03A - 172.18.3.010/24

LGXC02EN04A - 172.18.4.010/24

LGXC02EN01B - 172.18.1.106/24
LGXC02EN03B - 172.18.3.011/24
LGXC02EN04B - 172.18.4.011/24

SW032 Gi1/1 MCC MCCRemote I/O

For color legend, see page 52.

Gi1/8
Gi1/10

Table 14 - Control Network - Control DLR

Port Role VLAN SW030

Gi1/1(1) Switch for Automation Trunk (Native VLAN 301) SW001-G1/15

Gi1/2(1) SW001- Gi1/16

Gi1/5 Automation Device 501 (Control Network) LGXCO2EN01A

Gi1/6 LGXCO2EN01B

Gi1/7 503 (I/O Network) LGXCO2EN03A

Gi1/8 LGXCO2EN03B

Gi1/9 504 (MCC Network) LGXCO2EN04A

Gi1/10 LGXCO2EN04B

(1) Ports Gi1/1 and Gi1/2 must be configured as an EtherChannel to connect to SW001.

IMPORTANT See page 47 for Smartport descriptions.
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3. Select Switch for Automation from the Role pull-down.

4. Select a Native Vlan and click OK.

5. Use the information in Table 14 to configure switch ports.

Enable a DLR

Our single DLR example in this section is between the controllers and access 
switch (SW030) for server-to-controller communication.

1. From the main menu of the Device Manager, click Configure and
choose Network>DLR.

IMPORTANT See page 47 for Smartport descriptions.
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2. Select Ring 1 from the DLR Ring ID pull-down.

3. Select Supervisor from the Mode pull-down.

4. Select the ports.

5. Select Primary for the Role (Precedence) pull-downs.

Continue to the next gateway section by scrolling down the
DLR dialog box.
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Configure MCC Switches

Complete these steps to configure SW033 and SW034 switches on a
DLR network.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

2. Select the desired ports and click Edit.

3. Select a role type from the Role pull-down and click OK.

4. Use the information in Table 15 to configure switch ports.

Table 15 - I/O Network - MCC DLR

Port Role VLAN SW033 - Ring SW034 - Ring

Fa1/1…Fa1/15 Automation Device 504 (MCC Network) Device tag Device tag

Fa1/16 Desktop for Automation 300 (Management)(2) — —

Fa1/17…Fa1/18 — — — —

Gi1/1 Switch for Automation(1) Trunk (Native VLAN 301) LGXC02EN04A SW033 - Gi1/2

Gi1/2 SW034 - Gi/1 LGXC02EN04B

(1) Ports Gi1/1 and Gi1/2 must be configured for DLR.
(2) Optional.

1 SW033 2 SW034

Ring (DLR)

Gi1/1 Gi1/2 Gi1/1 /2

Fa1/1-15

LGXC02EN04A LGXC02EN04BFor color legend, see page 52.

Gi2/1

IMPORTANT See page 47 for Smartport descriptions.
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Redundant Star Switch 
Configuration

This section details the switch configuration for a Redundant Star topology 
with a Parallel Redundancy Protocol (PRP) on the I/O Network.

PRP is available on Stratix 54x0 switches. PRP offers alternative network 
topologies for interconnecting EtherNet/IP devices. PRP technology builds 
redundancy into the end devices so that network infrastructure can be 
duplicated by using standard components, such as managed and
unmanaged switches.

For more information, see the Stratix Managed Switches User Manual, 
publication 1783-UM007.

LGXC03A

OWS

MCC

RedBox

LAN A
LAN B

RedBox RedBox

R = Redundant Box
A = LAN A
B = LAN B

LGXC03B

SW001 - Gi1/17 SW001 - Gi1/18
For color legend, see page 52.

IMPORTANT You must use a 1756-EN2TP, PRP communication module for PRP topologies.
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Configure Controller Switches

Complete these steps to select the switch ports for redundant switches. The 
PRP switch is referred to as a RedBox.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

LGXC03A LGXC03BGi1/1 Gi1/2

Gi1/1 Gi1/2

SW040

SW001 - Gi1/17 SW001 - Gi1/18

LAN A  LAN B  LAN B  LAN A

For color legend, see page 52.

Gi1/4Gi1/3

R = Redundant Box
A = LAN A
B = LAN B

Table 16 - Control Network - Control PRP

Port Role VLAN SW040

Gi1/1 Switch for Automation Trunk (Native VLAN 301) SW042 - Gi1/1

Gi1/2 SW043 - Gi1/1

Gi1/3(1) SW001-Gi1/17

Gi1/4(1) SW001-Gi1/18

Gi1/5…Gi1/20 —

(1) Ports Gi1/3 and Gi1/4 must be configured as an EtherChannel to connect to SW001.

IMPORTANT You must use a 1756-EN2TP, PRP communication module
for PRP topologies.

TIP See page 47 for Smartport descriptions.
64 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Control Network Switch Configurations Chapter 2
2. Select the desired ports and click Edit.

3. Select Switch for Automation from the Role pull-down.

4. Select a Native Vlan and click OK.

5. Use the information in Table 16 to configure switch ports.
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Enable PRP (RedBox) Switch

A RedBox switch allows non-PRP devices to be added to both LANs. Devices 
that are connected to both LANs through a RedBox are called Virtual Doubly 
Attached Nodes (VDANs). VDANs do not have media redundancy between 
the device and the RedBox, however, media redundancy exists on the
LAN A/LAN B side of the RedBox.

Complete these steps.

1. From the main menu of the Device Manager, click Configure and
choose Configure>PRP.

2. Click Add and select Trunk from the Administrative Mode pull-down.

3. Select All VLANs for the Allows VLAN.

4. Select Native-301 from the Native VLAN pull-down.
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5. Click OK.
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Configure PRP Distribution

The two ports for each PRP device are attached to two separated networks of 
similar topology to minimize downtime and enhance high availability.

Fa1/9
Fa1/11
Fa1/13

Gi1/1

SW042 SW043

Fa1/1-4

Fa1/10
Fa1/12
Fa1/14

Fa1/14
Fa1/12
Fa1/10

PRP Distribution
LAN A
LAN B

For color legend, see page 52.

SW045
Gi1/1

SW044
Gi1/2

Gi1/2

SW044 
Gi1/1

SW045 
Gi1/2

R = Redundant Box
A = LAN A
B = LAN B

Gi1/1 Gi1/2

Table 17 - I/O Network - Control PRP

Port Role VLAN SW042 (LAN A) SW043 (LAN B)

Fa1/1 Switch for Automation 301 (Native VLAN - Trunk) SW044 - Gi1/1 SW044 - Gi1/2

Fa1/2 SW045 - Gi1/1 SW045 - Gi1/2

Fa1/3-4 — —

Fa1/5…Fa1/8 — — — —

Fa1/9-10 Multiport Automation 501 (Control Network) LGXC03A LGXC03B

Fa1/11-12 505 (I/O Network)

Fa1/13-14 506 (MCC Network)

Fa1/15…Fa1/18 — — — —

Gi1/1 Switch for Automation 301 (Native VLAN - Trunk) SW040 - Gi1/1 SWO40 - Gi1/2
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1. From the main menu of the Device Manager, click Configure
and choose Smartports.

2. Select the desired ports and click Edit.

3. Select Switch for Automation from the Role pull-down.

4. Select a Native Vlan and click OK.

5. Use the information in Table 17 to configure switch ports.
.

6. From the main menu of the Device Manager, click Admin and
choose MTU.

7. Select an MTU value and click Submit.

IMPORTANT The next procedure must be performed to configure the MTU 
(maximum transmission) for each distribution switch in your 
application. The PRP architecture can support a maximum
of seven hops.
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A warning message appears.

8. Click OK to restart.
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Enable PRP I/O (RedBox) Switch

This section describes how to configure a redundant switch on the PRP
I/O Network.

1. From the main menu of the Device Manager, click Configure and
choose Smartports.

R = Redundant Box (PRP)

LAN A

Gi1/1 Gi1/2

Gi1/7

Gi1/5

Gi1/6

SW044

LAN B

1788-EN2FF

Port SW042 Port SW043For color legend, see page 52.

Table 18 - I/O Network - PRP

Port Role VLAN SW044

Gi1/1…Gi1/2 Switch for Automation Trunk (Native VLAN 301) SW042, SW043

Gi1/3…Gi1/4 — — —

Gi1/5…Gi1/9 Automation Device 505 (I/O Network) —

Gi1/10…Gi1/20 — — —
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2. Select the desired ports and click Edit.

3. Select Switch for Automation from the Role pull-down.

4. Select a Native Vlan and click OK.

5. Use the information in Table 18 to configure switch ports.

Configure MCC Switches

This section describes how to configure MCC-level switches for a Redundant 
Star (PRP) topology.

1. From the main menu of the Device Manager, click Configure and
choose Smartports.

2. Select the desired ports and click Edit.

3. Select Switch for Automation from the Role pull-down.

4. Select a Native Vlan and click OK.

5. Use the information in Table 19 to configure switch ports.

Table 19 - I/O Network - MCC PRP

Port Role VLAN SW045

Gi1/1…Gi1/19 Switch for Automation Trunk (Native VLAN 301) Switch tag

Gi1/20 Desktop for Automation 300 (Management) —

R = Redundant Box (PRP)Gi1/2Gi1/1
Gi1/3

SW045

LAN A
LAN B

MCC

Gi1/19

Gi1/1 Gi1/1 Gi1/1
1 2 10

SW046 SW047

For color legend, see page 52.
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Optimize Switches for 
Redundant Controllers

This section describes how to configure routing at the controller level to reduce 
multitasking. This functionality minimizes the Internet Group Management 
Protocol (IGMP) members on the control level.

Configure Switch Routing

Complete these steps to change the VLAN IP address to modify the gateway 
address. This example shows the VLAN IP address is changing from 
172.18.2.1 to 172.18.2.2. The same configurations are required for additional 
VLANS and subnets.

1. From the Device Manager, click Configure and choose
VLAN Management.

2. Select the VLAN that you are changing, and click Edit.

IMPORTANT This configuration can be executed only in one switch. Moving the default 
gateway to the controller level requires changes in the upper level (CLI).

SW030

Gi1/1

Gi1/15

Gi1/5
Gi1/7
Gi1/9

For color legend, see page 52.

SW001 Gi1/16

Gi1/2

Gi1/6
Gi1/8
Gi1/10

LGXC02A LGXC02B
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3. In the IP Address text box, type the new IP address.

4. Click OK.

Configure a Static IP Address

Complete these steps to configure a VLAN with a static IP address.

1. From the main menu of the Device Manager, click Configure and 
choose Routing.

2. Click Enable Routing.
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3. Return to the main menu of the Device Manager, click Configure and 
choose VLAN Management.

4. Click Edit and choose an I/O Network VLAN.

See page 18 for a list of VLAN descriptions.

5. Select Static and type an IP address followed by a network mask.

6. Click OK.
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Notes:
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Chapter 3

Configure System Servers

This chapter describes how to configure a Windows domain, which centralizes 
the administration of users, policies, and security. Use of a Windows domain 
also improves performance, especially for larger systems. We recommend that 
all PlantPAx® system servers and workstations be a member of a domain.

A domain is a collection of computers that share rules and procedures. These 
computers comprise a central directory database, which is the active directory. 
The sharing of network objects creates a unified base to manage users, groups, 
and security settings.

Procedures in this chapter explain how to build a Windows domain named 
System. The System domain is a child domain of parent domain PlantPAx. 
Hence, the following fully qualified domain namespace:

System.PlantPAx.local

This domain forms a domain tree that’s rooted at PlantPAx. Your Windows 
active directory implementation (for example forest), can include one tree or 
be composed of multiple trees. 

When a Windows secondary domain is created, the following
operations occur:

• Secondary domain is verified
• Domain controller in the primary domain is located (referenced) and 

the secondary domain time is synchronized
• Two-way transitive trust relationships between the secondary domain 

and the primary domain are established
• Existing Active Directory Schema and Configuration containers are 

replicated to the secondary domain controllers.

Rockwell Automation® does not support the installation of application 
software on a computer that is configured as a domain controller.

For additional server recommendations, see the PlantPAx Distributed Control 
System Reference Manual, publication PROCES-RM001.

IMPORTANT To perform tasks in this chapter, you must verify the naming conventions
of your computers or use the names as shown in the examples. You cannot 
change computer names in the middle of the procedures for any
domain controller.
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Considerations Consider the following suggestions before starting this chapter:
• We assume that your active directory (forest) exists and that a hosting 

primary domain, such as PlantPAx.local, exists as well. The domain 
names that are used herein are only arbitrary to denote a respective 
hierarchy that works for you.

• Our recommendation is to use domain controllers. But, if you want to 
create a workgroup, see the procedures in Appendix B.

• This chapter describes how to set up a dedicated domain for your 
PlantPAx system. If you are adding your PlantPAx system to an existing 
domain and DHCP server, skip to page 99 for details.

Figure 7 - PlantPAx System Server Workflow

Start

Configure the Primary Domain Controller

See page 79

 Configure a Secondary Domain Controller

See page 86

Enable the DHCP Server in the Primary 
and Secondary Controllers

See page 99

Join the Domain

See page 113

Create Groups and Users

See page 118

See Chapter 4 Configure Group Policy Management

• Add DHCP Server Role
• Configure DHCP Server
• Enable DHCP Scope (Control Network)
• Enable DHCP Scope (Supervisory Network)
• Configure Failover

• Confirm Computers in DNS Server
• Confirm Computers in DHCP Server

• Unit Groups
• Role Groups
• Area Groups
• Create Users
• Assign Users to a Group

Create a Reverse DNS Lookup Zone

See page 93
• Map Host Name to IP Address
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Configure the Primary 
Domain Controller

For high availability, primary and secondary domain controllers are required. 
Complete these steps to configure a primary domain controller.

1. Click the Windows  symbol.

2. Click Control Panel and choose Network and Sharing Center>Change 
adapter settings.

The Network Connections dialog box appears.

3. Right-click the network and choose Properties.

4. Double-click Internet Protocol Version 4 (TCP/IPv4).

The Internet Protocol Version 4 Properties dialog box appears.

5. Type an IP address, default gateway address, and a Preferred DNS 
(Domain Name System) server address.

Typically, the alternate DNS server is your secondary domain controller.

6. Click OK.

IMPORTANT Before you begin to configure a primary domain controller, you must assign 
a fixed IP address to the domain controller, such as 172.18.1.10. 

Use a domain controller with 
these procedures.

Primary Controller
(PADCA)

IMPORTANT You could receive Windows Event Log errors related to the Preferred 
DNS server (for example 172.18.1.11). However, these errors go 
away when you add the DNS server.
127.0.0.1 is a special purpose address that is reserved for use on 
each computer (computer loopback address).
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After defining the IP address, complete these steps to configure the primary 
domain controller.

1. From the Server Manager, click Manage and choose Add Roles and 
Features.

2. Click Next on each of the successive installation wizard dialog boxes for 
the following:
• Review Before You Begin
• Select Installation Type
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3. Click ‘Select a server from the server pool’ and select your primary 
domain (PADCA in the example).

4. Click Next. 

5. Choose Active Directory Domain Services, and then click Add Features. 
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6. Make sure 'Active Directory Domain Services' is checked and click Next.

7. Make sure the Features selections match as shown, and click Next. 

8. Make sure AD DS is highlighted and click Next. 

9. On Confirmation, make sure ‘Restart the destination server 
automatically if required’ is not checked.

10. Click Install.

The installation can take a few minutes. Do not close the Wizard.
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11. Click Promote this server to a domain controller.

12. On the Configuration wizard, select Add a new forest, and type a root 
domain name. 

13. Click Next.
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14. Type the Directory Services Restore Mode (DSRM) password, confirm 
the password, and click Next. 

15. Do not specify DNS Delegation options and click Next.

16. In the NetBIOS™ Domain Name text box, make sure the domain name
is ‘System’ and click Next.

17. Click Next on the successive two windows to do the following:
• Accept the location of the AD DS database, log files, and SYSVOL
• Review selections

IMPORTANT We recommend that you document these credentials and store 
them in a secure location. For security, the domain controller verifies 
passwords for all users and computers in the PlantPAx network. The 
domain controller also authenticates the installation and upgrade 
of network software.
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18. Click Install.

The installation can take a few minutes before the computer
automatically restarts.
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Configure a Secondary 
Domain Controller

The secondary domain controller is a replication of the Active Directory (AD) 
and runs the alternate DNS server. We recommend that you configure a second 
domain controller as a backup to the primary domain for high availability.

You must assign a fixed IP address to the secondary domain controller. 

Complete the following steps.

1. Click the Windows  symbol.

2. Click Control Panel and choose Network and Sharing Center>Change 
adapter settings.

The Network Connections dialog box appears.

3. Right-click the network and choose Properties.

4. Double-click Internet Protocol Version 4 (TCP/IPv4).

The Internet Protocol Version 4 Properties dialog box appears.

5. Type an IP address that matches the primary domain controller IP 
address as the preferred DNS server.

This secondary domain server is the alternate DNS server for the 
system infrastructure.

6. Click OK.

Use a domain controller with 
these procedures.

Secondary Controller
(PADCB)
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After defining the IP address, complete these steps to create the
secondary domain.

1. From the Server Manager, click Manage and choose Add Roles 
and Features.

2. Click Next on each of the successive dialog boxes to do the following.
• Verify that certain tasks have been completed
• Select an installation type

3. Click Select a server from the server pool, and select your secondary 
domain (PADCB in the example).

4. Click Next. 
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5. Click Active Directory Domain Services, and then click Add Features.

6. Click Next on each of the successive dialog boxes to do the following.
• Verify selected server role
• Confirm installation selections
• Verify ‘Things to note' concerning AD DS

7. Confirm your installation selections and click Install.
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8. Click Promote this server to a domain controller. 

9. Click Add a domain controller to an existing domain and click Select. 

10. Type a user name under the domain.

For example, System.PlantPAx.local\Administrator

11. Type a password and click OK.
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12. Select the domain and click OK.

13. On the Configuration wizard, click Next. 
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14. Type the Directory Services Restore Mode (DSRM) password, confirm, 
and click Next. 

15. Click Next on the DNS Options window.

Ignore the warning message.

16. From the Replicate from pull-down menu, select 
PADCA.System.PlantPAx.local.

17. Click Next on each of the successive windows for the following:
• Accept the location of the AD DS database, log files, and SYSVOL
• Review selections
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18. Click Install.

The computer automatically restarts.
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Create a Reverse DNS Lookup 
Zone

A reverse lookup zone provides the ability to search a database for a computer 
name based on its IP address. This process is contrary to how a Domain Name 
System (DNS) was originally designed. Ordinarily, DNS lookups are forward 
lookups, which are searches via a DNS of another computer that is stored in the 
host record. The IP address is usually the resource for a response.

To define how a DNS name is indexed with an assigned IP address for a reverse 
lookup, you must program a special domain (in-addr.arpa). Subdomains within 
the in-addr.arpa domain reverse the address order by using a pointer (PTR) 
record that is mapped to the IP address. Thus, the domain name is found in the 
query.

Complete these steps to add a reverse lookup zone.

1. From the Server Manager, click Tools and choose DNS. 

The DNS Manager dialog box appears. 

IMPORTANT The Active Directory installation wizard does not automatically add a
reverse lookup zone to the server. The PTR records are not necessary to 
operate an Active Directory, but these records must be mapped to
IP addresses for a reverse lookup zone. See page 96 for the procedure.

Use a domain controller with 
these procedures.

PADCA
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2. Open the primary server (PADCA), right-click Lookup Zones and 
choose New Zone.

Wizard installation screens appear to create a zone for your
DNS server.

3. Click Next twice to use defaults
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4. Click Next twice to use defaults.

5. Type the network ID of an IP address or the zone name.

The zone translates the IP address into DNS names.

6. Click Next.

IMPORTANT Type the network ID portion of the IP address in the normal
(not reversed) order.
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7. Click Next and Finish to complete the zone installation.

Map Host Name to IP Address

Complete these steps to create a pointer (PTR) record that associated the DNS 
name to the IP address. During a search, the IP address is reversed to find the 
associated DNS name.

1. From the Server Manager, click Tools and choose DNS.

The DNS Manager dialog box appears.

2. Open the primary server (PADCA) and Reverse Lookup Zones folders 
and right-click the subdomain.
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3. Choose New Pointer (PTR) from the pull-down menu.

The New Resource Record dialog box appears.

4. Type an IP address in the normal (not reversed) order.

5. Click Browse and select the host name on the primary server.

6. Click OK.
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7. Repeat step 1…step 6 for ‘secondary’ servers.

The example shows results for a DNS Lookup forward search and a 
DNS Lookup reverse search.

Forward DNS Lookup

Reverse DNS Lookup 
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Enable DHCP in the Primary 
and Secondary Controllers

There are two ways of configuring IP addresses: static (manually) or dynamic 
(via server). Both options are supported within a PlantPAx system. By using the 
Dynamic Host Configuration Protocol (DHCP) server, you do not need fixed 
IP addresses for application servers and workstations. But, you must define a 
range and the system manages the IP addresses and names. We are applying 
DHCP in PlantPAx computers only.

Add DHCP Server Role

If adding DHCP server roles for the domain controllers, you must do this 
procedure for the primary and secondary servers. 

In the primary domain, complete the following steps. 

1. From the Server Manager, click Manage and choose Add Roles 
and Features.

2. Click Next on each of the successive windows to do the following:
• Verify that certain tasks have been completed
• Select an installation type

3. Click Select a server from the server pool, select the desired server 
(PADCA and PADCB), and click Next. 

Use a primary and a secondary domain 
controller with these procedures.

PADCA PADCB
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4. Select DHCP Server and click Add Features.

5. Click Next on each of the successive dialog boxes to do the following:
• Verify selected server role
• Confirm installation selections
• Verify 'Things to note' concerning DHCP server

6. To confirm installation selections, click Install. 
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7. Click Complete DHCP configuration. The DHCP PostInstall 
configuration wizard window appears.

8. Click Next.

9. Click Commit to authorize the configuration and then click Close.

The DHCP Post-Install configuration wizard window closes.

IMPORTANT Authorize DHCP servers to help avoid damage that is caused by 
running incorrect configurations or by using the wrong network 
with DHCP servers.
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10. In the Add roles and Features Wizard window, click Close. 

11. Repeat step 1 through step 10 to add the secondary server (PADCB).

Configure DHCP Server

Complete the following steps to configure the DHCP server.

1. From the Server Manager, click Tools and choose DHCP. 

PADCA

Use a primary domain controller 
with these procedures.
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2. Right-click DHCP and choose Add Server.

3. To find the primary domain controller, click Browse.

The Add Server dialog box appears.

4. Click Advanced and then Find Now for the secondary
domain controller.

The domain controller servers appear in the Search results.

5. Select the PADCB server and click OK.
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6. To add the secondary domain controller, click OK on the following
dialog boxes.

Enable DHCP Scope (Control Network)

Complete these steps to define the IP address range for the domain controllers. 
A scope distributes the IP addresses to the computers on your network.

1. From the Server Manager, click Tools and choose DHCP. 

2. In the Primary Domain, right-click on IPv4 and choose New Scope. 
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3. Click Next, type Control Network.

A description is optional.

4. Click Next.

5. Type the Start and End IP address range. 

6. Select a CIDR value from the Length pull-down arrows, and click Next.

The number, such as 24 in the example, represents 24 bits on the 
network mask. The last 8 bits on the address are used to identify the 
device on the network.

7. Click Next on each of the successive dialog boxes to accept the defaults:
• Add Exclusions and Delay
• Lease Duration
• Confirm 'Configure DHCP Options now'
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8. Type the gateway IP address that is used in this VLAN and click Add. 
The gateway address is added to the list.

9. Click Next.

10. To select the alternate DNS server, type the secondary domain 
controller IP address and click Add. The IP address is added to the list.

11. Click Next.

TIP The primary IP address is already in the list (172.18.1.10 in the example).
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The WINS Servers dialog box appears.

12. (Optional) To enable WINS servers, type an IP address for a server and 
click Add. The IP address is added to the list.

13. Click Next.

The Activate Scope dialog box appears.

14. To activate the Scope, click Next and then Finish.

Enable DHCP Scope (Supervisory Network)

Complete these steps to define the IP address range for the
Supervisory Network.

1. From the Server Manager, click Tools and choose DHCP. 

2. In the Primary Domain, right-click on IPv4 and choose New Scope. 
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3. Click Next, type Supervisory Network.

A description is optional.

4. Click Next.

5. Type the Start and End IP address range.

6. Select a CIDR value from the Length pull-down arrows, and click Next.

The number, such as 24 in the example, represents 24 bits on the 
network mask. The last 8 bits on the address are used to identify the 
device on the network.

7. Click Next on each of the successive dialog boxes to accept the defaults:
• Add Exclusions and Delay
• Lease Duration
• Confirm 'Configure DHCP Options now'
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8. Type the gateway IP address that is used in this VLAN and click Add. 
The gateway address is added to the list.

9. Click Next.

10. To select the alternate DNS server, type the secondary domain 
controller IP address and click Add. The IP address is added to the list.

11. Click Next.

TIP The primary IP address is already in the list (172.18.1.10 in the example).
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The WINS Servers dialog box appears.

12. (Optional) To enable WINS servers, type an IP address for a server and 
click Add. The IP address is added to the list.

13. Click Next.

The Activate Scope dialog box appears.

14. To activate the Scope, click Next and then Finish.

Configure Failover

Complete these steps to configure high availability for your domain 
controllers.

1. From the Server Manager, click Tools and choose DHCP.

2. In the Primary Domain, right-click on IPv4 and choose Configure 
Failover. 
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3. Click Next and then Add Server.

4. Select the backup server, select 'padcb', click OK, and then Next.
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5. Select Hot standby from the Mode pull-down, and type a shared secret.

6. Click Next.

7. Click Finish and Close.

Proceed to page 113 to group the settings for the workstations and servers 
under one authority.
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Join the Domain When you join the system elements into a single domain, the control and 
communication of the infrastructure is seamless. The domain centralizes all 
administrative settings for the workstations and servers in your application. 

1. Click the Windows  symbol.

2. Click Control Panel and choose System>Change Settings.

3. Click Change, select Domain, and then type the domain name and 
click OK.

Use all servers and workstations
with these procedures.
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4. Type a user name and password to add this computer to the domain and 
click OK on the dialog boxes.

If you have the correct access, the computer is accepted into 
the domain.

5. To accept the changes and restart the computer, do the following:
• Click OK in the first warning dialog box
• Click close in the Systems Properties dialog box
• Click Restart Now in the second warning dialog box

6. After restarting the computer, press Ctrl+Alt+Delete to log in.
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7. Click Switch User, choose Other User, and type [Domain Name]\user, 
such as System\Administrator, followed by the password.

8. Repeat step 1 through step 7 for all system computers.
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Confirm Computers in DNS Server

When all system computers are in the domain, you can confirm the addresses 
on the Domain Controller DNS server.

Complete the following steps.

1. From the Server Manager, click Tools and choose DNS. 

The DNS Manager dialog box appears. 

2. Select DNS><primary domain>>Forward Lookup Zone><primary 
domain name> (System.PlantPAx.local in our example). 

The Data column displays the IP addresses.

Use the primary server with 
these procedures.

PADCA

IMPORTANT The same IP address is not expected for more than one server or 
workstation.
116 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure System Servers Chapter 3
Confirm Computers in DHCP Server

You can confirm all computers in the DHCP server by accessing the Address 
Leases folder.

Complete the following steps.

1. From the Server Manager, click Tools and choose DHCP. 

The DHCP dialog box appears.

2. Select DHCP><domain controller>>IPv4>Scope>Address Leases. 

The Name column lists the computers.

Proceed to page 118 to place the users and groups into the 
Active Directory.

IMPORTANT The IP address that is assigned to all system computers needs to 
match the IP addresses in the DNS list.
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Create Groups and Users From operators and maintenance personnel to engineers, the domain 
controller manages groups in the active directory. The procedures describe how 
to create groups for units, roles, and areas per your application requirements.

Unit Groups

Complete these steps.

1. From the Server Manager, click Tools and choose Active Directory Users 
and Computers. 

2. On the Active Directory Users and Computers dialog box, expand the 
domain folder (System.PlantPAx.local).

3. Right-click the domain and choose New>Organizational Unit.

Use a domain controller 
with these procedures.

PADCA
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4. Type the group name and click OK.

Role Groups

1. To define the roles for the group, right-click the group name and choose 
New>Organizational Unit.

2. Under the PlantPAx Organizational Unit, create these three units:
• Users
• Areas
• Roles
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3. Right-click Roles and choose New>Group.

4. Type the group name and click OK.

5. Repeat step 4 for all application groups, including the following:
• PlantPAx Operating Supervisor
• PlantPAx Maintenance
• PlantPAx Maintenance Supervisor
• PlantPAx Manager
• PlantPAx Engineering
• PlantPAx Administrator
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6. Create the roles for all group application, including as shown:

Area Groups

Complete these steps to define specific areas based on the group.

1. On the Active Directory Users and Computers dialog box (with the 
Users folder still selected), right-click New and choose Group.
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The New Object Group dialog box appears.

2. Type an object name for the group and use the defaults for scope
and type.

3. Click OK.

4. Repeat step 2 but for the group name type Area01_Advanced.

5. Click OK.

6. Repeat step 2 for each area of the plant.

IMPORTANT We do not recommend using generic area names like Area01. Be 
specific (‘Packaging’, ‘Molding’, and so on), but create two types—
Basic and Advanced—for each area.
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Create Users

Complete these steps to enter personnel names into the domain controller.

1. On the Active Directory Users and Computers dialog box, click the 
domain and expand the group (PlantPAx).

2. Right-click Users and choose New>User.

The New Object User dialog box appears.

3. Type the name of a user and initials.

Our example shows ‘Jorge’ for instructional purposes only.
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4. Type a user login name and click Next.

5. Type the initial user password and repeat to confirm the entry.

6. Click ‘User must change password at next logon’ and click Next.

This procedure gives a user a unique password that, for security 
purposes, a user can change any time.

7. Click Finish.

IMPORTANT We do not recommend using ‘generic users’ such as ‘Operator’ or “Admin’ to 
share on the system.

TIP You can consider checking the ‘Password never expires’ checkbox to 
help prevent from being locked out if the password expires.
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Assign Users to a Group

The created users are not yet members of any group. Complete the following 
steps to assign the users to a group.

Assign a User to the PlantPAx Operators Group

In this section, individual users are assigned to the PlantPAx Operators group. 
The same procedures apply to assign users to other groups.

1. In the Active Directory Users and Computers window, open the group 
folder. (PlantPAx is our example).

2. Click Roles, right-click a group, and choose Properties.
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3. In the PlantPAx Operators Properties dialog box, click the Members tab.

This tab shows the members of the PlantPAx Operators group. (Our 
example shows no members.)

4. Click Add.

5. Type the user name ( Jorge in our example) in the text box and click OK.

6. Repeat step 4 and step 5 to add users.

The PlantPAx Operators Properties dialog box shows all users that you 
added in the previous steps. ( Jorge in our example.) 

TIP: To search for a user name, type a few letters 
of the name into the text box and click 
Check Names.

IMPORTANT Do not use more than one PlantPAx group for a single user to help 
prevent being denied access. The following dialog boxes show how 
to identify members that are assigned to groups.
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7. Click OK to close the group Properties dialog box.

The following steps assign a user to a group by using the group 
properties.

8. In the Active Directory Users and Computers window, click the Users 
folder, right-click on an individual user name ( Jorge in our example) and 
choose Properties.

The Properties dialog box for the selected user appears.

9. Click Add to add users to areas of the application.
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10. From the Select Groups dialog box, type an object name.

‘Area’ is our example as entered on page 122.

11. Click Check Names.

12. Select an object from the list and click OK.

13. Click OK.
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A Properties dialog box appears for the personnel name (for example, 
Jorge) that is being added as a ‘member of’ a group.

14. Click OK.

Assign a User to the PlantPAx Administrator Group 

1. In the Active Directory Users and Computers dialog box, choose the 
Users folder, right-click on a user (Harry in our example) and choose 
Properties. 

The Properties dialog box appears and 'Harry' is not a member of
any groups.

2. Click Add.

3. Type the group name in the text box and click OK.

IMPORTANT In the previous procedure, a user was added to a group by using the group 
properties. In this procedure, a user is added to a group by using the 
individual user properties. Our example is ‘Harry’.
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'Harry' is now a member of the PlantPAx Administrator group. Harry is 
an Advanced user to all areas.

4. Click OK.

TIP: To search for a user name, type a few letters 
of the name into the text box and click 
Check Names.

IMPORTANT We recommend for a production environment to disable the 
Windows Administrator account and use a new PlantPAx 
Administrators Users Group. Do not use default passwords.
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Configure Group Policy Management

We recommend group policy management as a part of the infrastructure 
design. Policies help reduce the maintenance and complexity when you add 
new users and computers into the PlantPAx® system. Once that you have 
configured specific policies on a domain controller, you do not have to 
configure the same policies on the domain computers.

The policies determine what users can and cannot do, such as password 
maintenance or to restrict folder access. The same approach applies for how to 
define server maintenance.

By carefully planning the control of multiple policies in the Active Directory 
environment, you can reduce the cost of system ownership. Group Policy 
Objects (GPOs) administer the set of policies that centralize all settings.

This chapter describes procedures to manage configurations for your domain 
controller. The optional techniques include the following:

• Windows Time Service with an NTP server
• Password strength configuration
• Lockout policy configuration
• Interactive logon configuration
• Group access level definition
• USB drive protection

The settings that are outlined are recommendations; your business, IT, and 
security requirements could require additional policies.

Figure 8 on page 132 shows the topics that are described in this chapter.

Considerations Consider the following suggestions before starting this chapter:
• Although this chapter offers optional configurations for domain 

controllers, we strongly encourage the use of the techniques for a 
centralized administration.

• This layer of protection does not supersede any anti-virus protection or 
other protection methods. It is best practice to have antivirus software 
that is installed on your PlantPAx servers and workstations. 

See Knowledgebase Answer ID 35330 at
http://www.rockwellautomation.custhelp.com for more information on 
compatibility and considerations when you install antivirus software. 
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Figure 8 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 8 - Group Policy Management Workflow

• Configuring the NTP Server
• Configuring Windows Time Service
• Enforcing the Domain Controller Policy

• Configuring an NTP Client
• Configuring Windows Time Service
• Configuring Password Strength
• Configuring Account Lockout Policy
• Configuring an Interactive Logon
• Enforcing the Domain Policy

• Define Group Access Level
• USB Drive Protection
• Configure Portable Device Enumerator Service
• Software Access Restriction

Start

Default Domain Controller Policy

See page 133

Default Domain Policy

See page 143

PlantPAx Users Policy Object

See page 160

See Chapter 5 Configure FactoryTalk® Components
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Default Domain Controller 
Policy

This section describes how to configure Windows Time Service as a Network 
Time Protocol (NTP) server and client. The domain is responsible to 
propagate and enforce the clock time to the domain computers. This policy 
functionality helps verify that all computers are synchronized with the
NTP server.

For your convenience, the procedures are presented in these subsections:
• Configuring the NTP Server
• Configuring Windows Time Service
• Enforcing the Domain Controller Policy

Configuring the NTP Server

Complete these steps to edit the default domain policy to define the
NTP server.

1. Click  to open the Server Manager.

2. Click Tools and choose Group Policy Management.

The Group Policy Management dialog box appears with the
system domain.

Use a domain controller 
with these procedures.

PADCA
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 133



Chapter 4 Configure Group Policy Management
3. Right-click Default Domain Controllers Policy and choose Edit.

The Group Policy Management Editor dialog box appears.

4. Click to expand the Computer Configuration folder and choose 
Policies>Administrative Templates.

5. In the System folder, click Windows Time Service.

6. Click to expand Windows Time Service and click Time Providers.
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7. In the Time Providers folder, double-click Configure Windows
NTP Client.

The Configure Windows NTP Client dialog box appears with default 
information for the NTP server.

8. Click Enabled and type information as shown in the sample box.
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The configuration data propagates the GPS signal through the NTP 
server to the domain computer.

9. Click OK.

Default information
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10. In the Time Providers folder, double-click Enable Windows
NTP Client.

11. Click Enabled and then click OK.
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12. Double-click Enable Windows NTP Server.

13. Click Enabled and then click OK.
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The Group Policy Management Editor reappears with the NTP server 
states ‘enabled’

Do not close the Group Policy Manager Editor dialog box.

Proceed to Configuring Windows Time Service to enable the service to 
automatically commence on start up.

Configuring Windows Time Service

Complete these steps to enable the NTP server policy upon start up.

1. In the tree configuration of the Group Policy Manager Editor dialog 
box, click to expand the Computer Configuration folder and choose 
Policies>Windows Settings>Security Settings.

2. In the System Services folder, double-click Windows Time.
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The Windows Time Properties dialog box appears.

3. Check the ‘Define this policy setting’ box and select ‘Automatic’.

4. Click OK.

5. Close the Group Policy Management Editor dialog box.

Enforcing the Domain Controller Policy

This section describes how to enforce the domain computers to use the NTP 
server settings (see page 135).

Complete these steps.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

Use a domain controller 
with these procedures.

PADCA
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2. Expand the Domain Controllers folder and click Default Domain 
Controllers Policy.

3. Choose Authenticated Users in the Security Filtering box and
click Remove.

A warning popup box could appear.

4. Click OK.
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5. Click Add, Domain Controllers, and then OK.

6. Under ‘Links’, right-click Domain Controllers and choose Enforced.

A popup window appears.

7. Click OK.
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Default Domain Policy This section describes how to configure and enforce all servers and 
workstations to be connected to the domain controller as an NTP client server. 
The clock time is synchronized with the domain controller.

Configuring an NTP Client

Complete these steps to associate the domain controller with the NTP
client server.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. Right-click Default Domain Policy and choose Edit.

The Group Policy Management Editor dialog box appears.

3. In the tree configuration, click to expand the Computer Configuration 
folder and choose Policies>Administrative Templates.

Use a domain controller 
with these procedures.

PADCA
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4. In the System folder, click Windows Time Service.

5. Click to expand Windows Time Service and click Time Providers.

6. In the Time Providers folder, double-click Configure Windows
NTP Client.
144 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure Group Policy Management Chapter 4
7. Click Enabled and use the defaults for the NtpServer popup window.

For example, PADCA.System.PlantPAx.local,(0x1 PADCA). 

Defaults are based upon your initial setup of the NTP server. See 
page 133.

8. Verify the information as shown in the sample box.

The configuration data associates the domain controllers with the
NTP client server.

9. Click OK.
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10. Click Time Providers (in the Windows Time Service folder) and click 
Enable Windows NTP Client.

The Enable Windows NTP Client dialog box appears.

11. Click Enabled and then click OK.
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The Group Policy Management Editor reappears with the NTP
Client-server states ‘enabled.’

Do not close the Group Policy Manager Editor dialog box.

Proceed to Configuring Windows Time Service to enable the service to 
automatically commence on start up.

Configuring Windows Time Service

Complete these steps to enable the NTP server policy upon start up.

1. In the tree configuration of the Group Policy Management Editor dialog 
box, click to expand the Computer Configuration folder and choose 
Policies>Windows Settings>Security Settings.

2. In the System Services folder, double-click Windows Time.
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The Windows Time Properties dialog box appears.

3. Check the ‘Define this policy setting’ box and select ‘Automatic’.

4. Click OK.

5. Close the Group Policy Management Editor dialog box.

Configuring Password Strength

The password policy makes sure that security settings are enforced to help 
protect the system from unauthorized users upon entering the system.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. Right-click Default Domain Policy and choose Edit.

Use a domain controller 
with these procedures.

PADCA
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3. In the tree configuration of the Group Policy Management Editor dialog 
box, click to expand the Computer Configuration folder and choose 
Policies>Windows Settings>Security Settings>Account Policies.

4. Click the Password Policy folder and configure the policy options that 
are explained in Table 20 per your requirements.

5. Save your work.

Table 20 - Password Policy Description

Policy Description

Enforce password history Complexity requirements are enforced when passwords are changed or created. These requirements include that the 
password cannot contain the user's account name, parts of the user's full name that exceed two consecutive characters, or a 
certain length of time that is exceeded before a similar password can be used.

Maximum password age Security setting that determines the length of time before a password needs to be changed. Best practice is for password to 
expire 30…90 days to help prevent attacks.

Minimum password age Minimum password age must be less than the maximum password age. For example, if the maximum password age is 
1…999 the minimum password age can be up to 998 days.

Minimum password length Security setting that determines the least number of characters for a password. Typically, the value of characters is set 
between 1…14. Zero characters if no password is required.

Password must meet complexity requirements Security setting determines the minimum requirements to meet complexity requirements. For example, some uppercase or 
lowercase characters, base 10 digits (0…9), or non-alphabetical characters.

Store passwords using reversible encryption Reversible encryption is used for password authentication. Microsoft recommends that this protocol be disabled because it’s 
the same as storing plain text versions of the passwords. Microsoft states to use this policy only if ‘application requirements 
outweigh the need to protect password information’.
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Configuring Account Lockout Policy

This policy provides the ability to configure the number of password attempts 
and how an administrator resolves a user lockout situation.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. Right-click Default Domain Policy and choose Edit.

3. In the tree configuration of the Group Policy Management Editor dialog 
box, click to expand the Computer Configuration folder and choose 
Policies>Windows Settings>Security Settings>Account Policies.

4. Click the Account Lockout Policy folder and configure the policy 
options that are explained in Table 21 per your requirements.

Use a domain controller 
with these procedures.

PADCA
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5. To set the number of lockout attempts before a lockout, double-click 
Account lockout threshold.

6. On the Account lockout threshold Properties dialog box, click the 
arrows Up or Down to set the number of invalid logon attempts.

7. Click OK.

The Suggested Value Changes popup window appears with default time 
settings based on your number of lockout attempts.

8. Click OK.

Table 21 - Lockout Policy Descriptions

Policy Description

Account lockout duration A locked out account cannot be activated until reset by an administrator or the duration period for the lockout has elapsed.

Account lockout threshold This setting determines the number of failed logon attempts to cause a user account to be locked out. You can set a value 
between 0…999 failed logon attempts. If you set the value to 0, an account is prevented from being locked out.

Reset account lockout counter after Setting specifies an amount of time that must expire before a lockout reactivates.
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The lockout configurations can be monitored on the Group Policy 
Management Editor dialog box.

The example shows what a user receives when the configured number of 
failed logon attempts occurs.
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Administrator Security Audit

This section describes how administrators can audit lockout situations and 
unlock personnel accounts. Complete these steps.

1. On the Event Viewer dialog box, right-click Security and choose
an account.

The user account information appears.

In the Domain controller, the lockout information appears in the 
Account tab of a user’s Properties dialog box.
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Configuring Kerberos Policy

Complete these steps to administer network authentication.

1. In the tree configuration of the Group Policy Management Editor dialog 
box, click to expand the Computer Configuration folder and choose 
Policies>Windows Settings>Security Settings>Account Policies.

2. Click the Kerberos Policy folder and configure the policy options that 
are described in Table 22 per your requirements.

Use a domain controller 
with these procedures.

PADCA

Table 22 - Kerberos Policy Descriptions

Policy Description

Enforce user logon restrictions Security setting determines if the Kerberos V5 Key Distribution Center (KDC) validates every request for a session ticket 
against the user rights policy of the user account. Validation of each request for a session ticket is optional; the extra step 
takes time and could slow network access to services.
The default is Enabled.

Maximum lifetime for service ticket Security setting determines the maximum amount of time (in minutes) that a granted session ticket is used to access a 
particular service. The setting must be greater than 10 minutes and less than or equal to the setting for Maximum lifetime 
for user ticket.
If a client presents an expired session ticket when it requests a connection to a server, the server returns an error message. 
The client must request a new session ticket from the Kerberos V5 Key Distribution Center (KDC). Once a connection is 
authenticated, it no longer matters whether the session ticket remains valid. Session tickets are used only to authenticate 
new connections with servers. Ongoing operations are not interrupted if the session ticket that is used to authenticate the 
connection expires during the connection.
The default amount of time is 600 minutes (10 hours).
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3. Save your work.

Configuring an Interactive Logon

This policy configures a warning message to users of the consequences for 
misusing company information. The policy is typically used for legal purposes.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. Right-click Default Domain Policy and choose Edit.

Maximum lifetime for user ticket Security setting determines the maximum amount of time (in hours) that a user's ticket-granting ticket (TGT) can be used.
The default amount of time is 10 hours.

Maximum lifetime for user ticket renewal Security setting determines the time (in days) during which a user's ticket-granting ticket (TGT) can be renewed.
The default is 7 days.

Maximum tolerance for computer
clock synchronization

Security setting determines the maximum time difference (in minutes) that Kerberos V5 tolerates between the time on the 
client clock and the time on the domain controller running Windows Server 2003 that provides Kerberos authentication.
To prevent ‘replay attacks’, Kerberos V5 uses time stamps as part of its protocol definition. For time stamps to work properly, 
the clocks of the client and the domain controller need to be in sync as much as possible. Both computers must be set to the 
same time and date. Because the clocks of two computers are often out of sync, administrators can use this policy to 
establish the maximum acceptable difference to Kerberos V5 between a client clock and domain controller clock. If the 
difference between a client clock and the domain controller clock is less than the maximum time difference that is specified 
in this policy, any time stamp that is used in a session between the two computers is considered to be authentic.
IMPORTANT: This setting is not persistent on pre-Vista platforms. If you configure this setting and then restart the 
computer, this setting reverts to the default value.
The default is 5 minutes.

Table 22 - Kerberos Policy Descriptions

Policy Description

Use a domain controller 
with these procedures.

PADCA
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3. In the tree configuration of the Group Policy Management Editor dialog 
box, click to expand the Computer Configuration folder and choose 
Policies>Windows Settings>Security Settings>Local Policies.

4. Click the Security Options folder and double-click the Interactive 
logon: Message Title option.

5. Type the name of the group that receives the interactive message and 
click OK.
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6. Double-click the Interactive Logon: message text option..

A message text dialog box appears to let you write and edit the template.

7. Click OK.

The example shows the interactive message that appears to users
during logon.
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Enforcing the Domain Policy

This section describes how to enforce the servers and workstations that are 
associated with the domain controller to use the NTP client settings (see 
page 145).

Complete these steps.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. Expand the domain folder and click Default Domain Policy.

3. Choose Authenticated Users in the Security Filtering box and
click Remove.

A warning popup box could appear.

4. Click OK.

Use a domain controller 
with these procedures.

PADCA
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5. Click Add, type an object, and then click OK.

6. Right-click the domain and choose Enforced.

A popup window could appear.

7. Click OK.
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PlantPAx Users Policy Object You can create policies for a group of users that restricts privileges and site 
access. This section describes how to select a group and enforce a policy. For 
example, a selected group of users cannot use USB drives for system security.

Define Group Access Level

Complete these steps to select a specific group of users to link to a policy.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. In the system domain folder, right-click a domain name and choose 
Create a GPO in this domain, and Link it here.

3. Type a name for the Group Policy Object.

4. Click OK.

Use a domain controller 
with these procedures.

PADCA
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USB Drive Protection

Complete these steps to restrict a group of users from using a USB drive.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. In the system domain folder, click Group Policy Objects, right-click 
PlantPAx Users Policy Objects and choose Edit.

The Group Policy Management Editor dialog box appears.

3. Click to expand the Computer Configuration folder and choose User 
Configuration>Policies>Administrative Templates>System.

4. Click Removable Storage Access and choose All Removable Storage 
classes: Deny all access.

Use a domain controller 
with these procedures.

PADCA
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5. Click Enabled and OK.
162 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure Group Policy Management Chapter 4
Configure Portable Device Enumerator Service

Complete these steps to enable a service that enforces Group Policy Objects for 
connected mass storage devices.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. In the system domain folder, click Group Policy Objects, right-click 
Default Domain Policy and choose Edit.

Use a domain controller 
with these procedures.

PADCA
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3. On the Group Policy Management Editor dialog box, open Computer 
Configuration>Policies>Window Settings>Security Settings folders.

4. In the System Services folder, double-click Portable Device Enumerator.

5. Check the ‘Define this policy setting’ box and select ‘Automatic’.

6. Click OK.

7. Close the Group Policy Management Editor dialog box.
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Software Access Restriction

Complete these steps to restrict a group of users from using
non-approved software.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy 
Management dialog box.

2. In the system domain folder, click Group Policy Objects, right-click 
PlantPAx Users Policy Objects and choose Edit.

The Group Policy Management Editor dialog box appears.

3. Click to expand the Computer Configuration folder and choose User 
Configuration>Policies>Administrative Templates.

4. In the System folder, double-click Don’t run specified
Windows applications.
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5. Click Enabled, Show, and then type any application software to create 
an access restriction.

6. Click OK.

The Don’t run specified Windows application dialog box confirms
the policy setting.

7. Click OK.
166 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Chapter 5

Configure FactoryTalk Components

In the FactoryTalk® architecture, there are two separate directory types: Local 
and Network. The Network Directory coordinates the communication 
between the system elements on multiple clients and servers, such as data 
servers, HMI servers, and alarm and event servers. If all of your products reside 
on one computer, you can use the Local Directory.(1)

In a PlantPAx® system, the FactoryTalk Directory (FTD) centralizes and shares 
information across multiple computer systems. The FTD makes this 
information available through a lookup service to all software products that 
participate in an application.

See Figure 9 on page 168 for the topics that are described in this chapter.

Considerations Consider the following suggestions before starting this chapter:
• The FTD server does not require redundancy to maintain availability of 

the system if the FTD server fails. The FTD information is cached on 
each computer that is participating in a distributed application as long as 
the computer had previously accessed the FTD server.

• For compatibility purposes, you must install software components, such 
as FactoryTalk Services Platform. You also can use the Product 
Compatibility and Download Center (PCDC) at
http://www.rockwellautomation.com/global/support/pcdc.page.

(1) Some FactoryTalk products, such as FactoryTalk® VantagePoint®, can address multiple FactoryTalk Directories.

Windows Domain

FactoryTalk 
Directory

IMPORTANT It is required to have a user name and password with administrator 
privileges to install FactoryTalk software and to specify an FTD location.
Use the same user name and password for all FactoryTalk installations
on the PlantPAx system.
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Figure 9 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 9 - FactoryTalk Components Workflow

Start

Virtual Image Templates 
User Manual,

publication 9528-UM001

Configure the FactoryTalk Directory

See page 169

Virtual
Environment

License FactoryTalk Activation

See page 175

Use FactoryTalk Patches From the PCDC

See page 177

Patches

See Chapter 6 Configure FactoryTalk Security

Yes

No

Yes

No

• Enable Windows Firewall
• Define Network Directory

• Open Activation Manager
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Configure the FactoryTalk 
Directory

The PlantPAx system is integrated as a directory to all system computers as 
defined by the FTD. The following procedures must be completed for all 
computers in the PlantPAx system.

1. Click the Programs  symbol and choose Rockwell 
Software®>FactoryTalk Tools>FactoryTalk Directory
Configuration Wizard.

2. Select ‘Configure the FactoryTalk Network Directory’ and click Next.

Use servers and workstations 
with these procedures.

All Servers and Workstations

IMPORTANT The FactoryTalk Local Directory is optional. But, you must use 
FactoryTalk View Machine Edition (ME) software with the
Local directory.
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3. Type any Windows administrator user name and password for the 
Network Directory, and click Next.

Use the same user name and password for Network and Local 
directories.

4. Click Close.
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Enable Windows Firewall

Although an option, we suggest that you configure the Windows Firewall 
utility. This utility creates necessary firewall rules to provide communication 
between system elements. Complete these steps.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Tools>Windows Firewall Configuration Utility.

2. Click Accept and select ‘On with Exceptions’ for the new Firewall state.

3. Click OK.
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Define Network Directory

The Network Directory must be the same for all system computers. Any PASS 
server can be used as the FTD server.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Tools>Specify FactoryTalk Directory Location.

2. Click Browse (ellipsis ‘…’) on the FactoryTalk Directory Server Location 
Utility dialog box.

3. Type the same user name and password (with Administrator privileges) 
that you used to configure the Network and Windows Directory.

4. Click OK.
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5. Select Remote computer and type the FactoryTalk Directory server.

For example, PASS01. You also can browse for a network name.

6. Verify the desired FactoryTalk server appears in the computer hosting 
text box, and click OK.

7. Click OK on the message box. 

This message is a reminder to restart the computer after you finish 
adding all servers and workstations to the FactoryTalk Directory.

8. Log on by using the server user name and password as shown in step 3.

9. Restart the computer.

10. Repeat step 5 through step 8 for all servers and workstations in the 
PlantPAx application.

11. Shut down and restart the computer.
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When complete, the FTD computers appear in the FactoryTalk 
Administration Console.

Proceed to page 175 to activate software licenses.
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Use FactoryTalk Activation to 
Apply Licenses

FactoryTalk Activation software provides a secure, software-based system to 
apply Rockwell Automation® licenses for continuous use of FactoryTalk 
software and other Rockwell Automation software products.

With FactoryTalk Activation software, there is no need for a physical
master disk or any physical media. Instead, activation files are generated and 
distributed electronically.

Open Activation Manager

On the selected Activation Manager computer, start the activation process by 
opening the FactoryTalk Activation Manager.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Activation>FactoryTalk Activation Manager.

The FactoryTalk Activation Manager window appears.

2. Click Help to use the instructions to complete the activations.

For additional instructions and information on activation types, host 
IDs, and how to use a plug and play dongle, see Activate Rockwell 
Software Products, publication FTA-QS002.

You also can use the website at https://
activate.rockwellautomation.com.

Use the PASS with 
these procedures.

PASS01
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Table 23 provides some guidelines after you activate the software.

Proceed to page 177 to learn how to access and configure software patches.

Table 23 - Activation Considerations

Consideration Details

Software that is not activated If the components you have installed cannot be activated, for example, because the activation server is unavailable, 
then the software continues to run for up to 7 days. The seven-day grace period provides time to correct the problem 
with acquiring activations, without disrupting critical applications. If activation is restored within 7 days, normal 
operations resume. If activation is not restored, the grace period expires. After the grace period expires, if you restart 
the components and activation remains unavailable, the software runs for 2 hours in Demo mode.

Location of activation server The PASS is the primary choice for activation management and is recommended to be the location of the activation 
server. In the instance that the PASS is not an acceptable location, for example, when you use a redundant PASS 
solution, the EWS is the secondary choice. In this instance, the EWS can be a dedicated station with a permanent 
Ethernet connection to the system. The FactoryTalk Activation software can be configured to run as both a server and
client utility.

Options for adding activation files to the PASS To make concurrent floating activations available to activation clients, first you must download the activation files to 
the activation server computer, from the Rockwell Automation® Activation window.
If the PASS has internet access, see Open Activation Manager on page 175.
If the PASS does not have internet access, the activations can be downloaded on another computer with internet 
connectivity and then transferred to the PASS.

Protect activation files Activation files are simple text files that must have a .lic extension. 
As long as the .lic extension is retained, you can copy or rename an activation file without harming it. However, 
tampering with text inside the activation file can disable your Rockwell Software® products. 
If an activation file is damaged or deleted, contact Rockwell Automation Technical Support.
For safekeeping, keep an original set of your activation files on back-up media. Use descriptive names for the files, so 
that you can identify them later, and copy them back to the appropriate computers.
Activation files are locked to the Host IDs of the computers (or dongles) that need them. Activation fails for Rockwell 
Software products on a computer where the specified Host ID is not recognized by the activation file.
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Use FactoryTalk Patches
From the PCDC

We recommend that you periodically review and update the available software 
patches and firmware updates for the Rockwell Automation components on 
your PlantPAx system. Before implementing Rockwell Automation updates, 
we recommend that you verify them on a non-production system, or when the 
facility is non-active. Verification helps to make sure that there are no 
unexpected results or side effects.

You must restart a computer after installing each patch.

1. Click http://www.rockwellautomation.com/rockwellautomation/
support/downloads.page to open the Product Compatibility and 
Download Center (PCDC).

You also can access the PCDC link from the ab.com website.

2. Under Download, click Find Downloads.

IMPORTANT If you are installing a new PlantPAx system, we recommend that you use the 
specifications in the PlantPAx Selection Guide, publication PROCES-SG001.

Use a workstation with 
these procedures.

All Computers
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3. In the Product Search text box, type Patches.

The search results appear under the Search text boxes.

4. Double-click the search results.

Our example is Patch Roll-up CPR9 SRx.
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5. Do one of the following items:
• To select a version, click the search results to access a list. Select a 

desired category and click Downloads.
• To use the current version, click Downloads.

6. Click the Show Downloads button.

7. In the Downloads list, click each box to add the item to the
Download Cart.

The number of items in the cart increase proportionally to the number 
of boxes that you click. To remove an item from the cart, click a box to 
remove a check mark.
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8. Click the Download Cart and then click Download Now.

You need a user name and password to download files.

9. Read the software license agreement and click Accept.

There are two ways to download the patches: managed or direct (browser).

10. We recommend that you click Managed Download.
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11. Click Save File and then click Run.

The Download Manager opens.

A progress bar shows the installer path to the download folder.

12. Click Open underneath the progress bar (next to the download
folder path). 

Copy the downloaded patch folder to all PlantPAx servers and 
workstations for which the patch applies.

13. Click Local Disk (C:) and choose Setup.exe.
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14. Click Yes to install the patches.

15. Click Finish and Restart Now.
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Configure FactoryTalk Security

FactoryTalk® Security provides access restriction to only those individuals who 
legitimately need access to specific automation assets. FactoryTalk Services 
Platform (FTSP) includes the FactoryTalk Administration Console that 
provides the interface for configuring your system.

This chapter describes how to administer privileges to users and groups to 
define who can access hardware devices and software products. Permissions 
authenticate an identity and authorize that person to access that resource and 
perform only allowed actions. The centralized security system with a modern 
DCS, such as the PlantPAx® system, helps to make sure the data that is being 
received and processed is from a trusted source.

The Users and Groups in the FactoryTalk View console let you control who 
accesses the FactoryTalk system and from which computer. Access can be 
restricted to a single user or group of users to help simplify the administration 
of permissions.

When setting up security, create groups first and grant the appropriate 
permissions to the group. With groups, you create a security structure without 
needing to know exactly the users that comprise the groups. When users are 
added to the group, they inherit the permissions that are granted to the group.

Considerations As shown in Figure 10, there are groups that require separate configuration:
• External – Involves Windows-linked user groups in a domain controller
• Internal – Includes users not in a domain but grouped in the

FactoryTalk Directory (FTD). 

The overlap between these two groups creates a hybrid group.

Figure 10 - Users and Groups Example
Hybrid

External Internal

IMPORTANT Even if your application has a domain, we highly recommend that you 
configure a hybrid group. The internal connections, via the hybrid, permit 
operations to continue if there is loss of a domain connection.
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Figure 11 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 11 - FactoryTalk Security Workflow

Start

Configure FactoryTalk Users and Groups

See page 185

Define FactoryTalk System Policies

See page 193

Define FactoryTalk Product Policies

See page 199

See Chapter 7
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See page 197

Configure Controller Security

• Assign User Domain to FactoryTalk Directory
• Create Internal Users and Groups

• Use Default Terminal Client
• Use the Same FactoryTalk Log On
• Use Default Terminal Client
• Restrict Application Authorization
• Audit Security Actions

Create Permission Sets

See page 200
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Configure FactoryTalk Users 
and Groups

The FTD stores information about which users have access to the parts of a 
control system. During the logon, FactoryTalk security uses this information to 
verify an identity and then permissions that are assigned to the user. 
Authorized users can then access secured parts of the application.

Assign User Domain to FactoryTalk Directory

The following subsections walk you through how to link user accounts in a 
Windows domain into FactoryTalk security. These procedures, including 
assigning groups, roles, and areas, must be completed for domain credentials to 
be recognized in the FTD.

Linking External Users and Groups

Windows-linked user accounts must be assigned access rights to validate that 
the users are authorized for the work that is approved for the group. (Domains 
are explained in Chapter 3.)

1. Click the Programs  symbol and choose Rockwell Software® 
>FactoryTalk Administration Console.

2. Select the network directory and click OK.

3. Under the Network Directory, click System and then Users and Groups 
to expand both folders.

4. Right-click User Groups and choose New>Windows-Linked User 
Group.

Use an Engineering Workstation 
with these procedures.

EWS
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5. Click Add.

6. On the Select Groups dialog box, click Locations.

7. To search for the PlantPAx groups in the domain, open Entire Directory 
and select a domain name (System.PlantPAx.local is
an example).

8. Click OK.
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Importing Active Directory Roles

Complete these steps to import specific roles, such as supervisor, operator, 
maintenance, into groups.

1. On the Select Groups dialog box, click Advanced.

To access this dialog box, repeat step 1 through step 5 on pages 185-186.

2. Type PlantPAx.

3. Click Find Now to display a list of roles that you grouped in Chapter 3.

4. Select all desired windows-linked groups and click OK.
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5. To accept the selections, click OK on the following dialog boxes.

All of the domain groups and roles are listed under the FTD
User Groups.
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Importing Active Directory Areas

Complete these steps to assign groups with engineering or non-engineering 
access rights. Engineering access allows modifications to Library faceplates.

1. From the New Windows-Linked User Group dialog box, click Add.

To access this dialog box, repeat step 1 through step 4 on page 185.

2. From the Select Groups dialog box, type an object name.

For example, Area.

3. Click Find Now.

4. Select an object from the list and click OK.

5. The object groups appear in the text box of the Selection Groups
dialog box.

6. Click OK.

Observe with area descriptions the terms 
‘Advanced’ and ‘Basic’.
• Advanced provides access to engineering 

modifications on Process Library faceplates.
• Basic allows access to non-engineer functions, 

such as Maintenance, Operator, on Process 
Library faceplates.

See Area Groups on page 121 to configure security 
for different areas of your application.
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7. Click OK again, and the assigned areas appear in the Network Directory 
under User Groups.
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Create Internal Users and Groups

This section describes how to create an internal and a hybrid users group for 
smaller systems that don’t have a domain infrastructure. A hybrid group, which 
is composed of external (domain) and internal (FTD) users, is recommended 
for continued operation if the domain connection is lost.

Complete these steps.

1. Click the Programs  symbol and choose Rockwell Software® 
>FactoryTalk Administration Console.

2. Select the network directory and click OK.

3. Under the Network Directory, click System and then Users and Groups 
to expand both folders.

4. Right-click User Groups and choose New>User Group.

5. Type a new user group name and click OK.

EWS

Use an Engineering workstation 
with these procedures.
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6. Right-click the Users folder, and choose New>FactoryTalk User.

7. Type a user name and description.

8. Enter a password and then type the same password as confirmation.

9. In the Group Membership tab, choose Add, and then select a group to 
be linked to the new user.

10. Click OK.
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11. Repeat step 4 through step 10 to add a new local group and users to
the system.

For a list of HMI security codes, see the Rockwell Automation Library 
of Process Objects, publication PROCES-RM002.

Define FactoryTalk System 
Policies

This optional section describes how to use Remote Desktop Services (RDS) to 
access FactoryTalk applications, such as thin clients.

Use Default Terminal Client

You have two server options: terminal client or server computer; terminal 
being the default.

1. On the network directory (see steps 1…2 on page 191) under System> 
Policies>System Policies, double-click Security Policy.

2. On the Policy Settings dialog box under Computer Policy Settings, leave 
terminal client as the default for remote desktop services to be available.

3. Click OK.

TIP You can also create guest users with known passwords to control this type of 
access in the system.

TIP Select Server computer from the pull-down menu and click OK if 
you want external client computers to be able to log in to the FTD 
without any pre-configuration. This option, however, does not let 
you track specific actions from the terminal client.

EWS

Use an Engineering Workstation 
with these procedures.
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Use the Same FactoryTalk Log On

You have options to enable/disable access to multiple FactoryTalk products 
with the same FTD logon.

1. On the network directory (see steps 1…2 on page 191) under 
System>Policies>System Policies, double-click Security Policy.

2. Scroll down to Single Sign-On Policy Settings and leave Enabled as
the default.

This setting lets you use the same FactoryTalk log in for multiple 
products.

3. Click OK.

TIP Select Disabled from the pull-down menu if you want separate 
logins to be used for each FactoryTalk product.
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Restrict Application Authorization

You can verify and configure FactoryTalk Services application authorization.

1. On the network directory (see steps 1…2 on page 191) under 
System>Policies>System Policies, double-click Application 
Authorization.

2. In the (lower) Settings section of the dialog box, use the ‘Enable Default 
Access’ default.

This setting automatically authorizes application access.

3. If you want to require application verification, click ‘Verify Publisher 
Info’ and click OK.
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Audit Security Actions

You can enable an audit to track configurations and security.

1. On the network directory (see steps 1…2 on page 191) under 
System>Policies>System Policies, double-click Audit Policy.

2. Under Audit Policy Settings, select Enabled from the Audit security 
access failures pull-down menu.

3. Click OK.

Proceed to page 197 to determine security permissions for groups
and users.
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Define the Security System 
Policy

This section describes how to configure permissions for groups and users to 
perform actions that are based on their security levels. The access level can be 
based in the domain or local groups, however, the user needs to be a member of 
only one single group. For example, if you are a member of the Administrators 
and the Operators groups and you are denied access, you lose Administrator 
permissions. You have the lowest security access in both groups.

Complete these steps.

1. On the network directory (see steps 1…2 on page 191) under 
System>Policies, right-click System Policies and choose Security.

2. On the Permissions tab of the Security Settings for Systems Policies 
dialog box, click Add.

The Select User and Computer dialog box appears.

3. Select a PlantPAx group and click OK.

4. Repeat step 3 to add each group.

5. When all groups are added, select one group at a time in the top half of 
the Security Settings for System Policies dialog box.

EWS

Use an Engineering Workstation 
with these procedures.
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6. In the lower half of the dialog box, do one of the following actions:
• Click the ‘Allow’ or ‘Deny’ box for a bold-faced category to select

all boxes.
• Click ‘+’ in front of a bold-faced category to display a list of 

subcategories. Click each ‘Allow or ‘Deny’ box.

If Deny is selected, a warning message appears.

7. Click ‘Yes’ to verify a permission that is being denied, if applicable.

8. Click OK when finished.

Table 24 is an example of security permissions per group classification.

See Appendix A for how to access an attachment that has suggested security 
permissions on a Microsoft Excel spreadsheet. The tabs include permissions for 
System Policies, Product Policies, Computer and Groups, Network and 
Devices, Users and Groups and Connections.

Table 24 - Group Security Levels

System Policies Operator Operator 
Supervisor

Maintenance Maintenance 
Supervisor

Manger Engineer Administrator

Configure Security Deny Deny Deny Deny Deny Allow Allow

Create Children

Delete

Execute

List Children

Read

Write
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Define FactoryTalk Product 
Policies

This section describes how to define users and groups with controller security 
in FactoryTalk software. Complete these steps.

1. On the network directory, click System>Policies>Product 
Policies>RSLogix 5000®>Feature Security.

You also can configure feature security by clicking System>Policies,
right-click Product Policies and choose Feature Security.

2. On the Policy Settings tabs, click Controller Secure.

3. Click Browse (…).

4. Click Add, select a PlantPAx group, and then click OK.

5. Repeat step 4 to add all desired groups.

6. Click the ‘Allow’ or ‘Deny’ box.

7. Click OK.

EWS

Use an Engineering Workstation 
with these procedures.
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Create Permission Sets Permission sets are an option to identify a set of actions that are allowed or 
denied for one or more user groups or computer groups in a FactoryTalk 
network directory. The permissions are used with the controller security 
settings, and the same permissions can be used with multiple controllers.

When a user opens a project that has been secured with a permission set,
the Logix Designer application verifies that the ID of the FactoryTalk 
Directory matches the ID stored in the project. Guest Users also can be 
assigned permissions.

For more information, see the FactoryTalk Security System Configuration 
Guide, publication FTSEC-QS001.

Complete these steps.

1. On the FactoryTalk Administration Console, right-click Permission Sets 
and choose New Permission Set.

2. Type a name for the permission set and click OK.
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3. In the left column under Permission Sets, right-click the permission set 
name and choose Security.

The Security Settings for PlantPAx Controllers appears.

4. Set the allowable actions by clicking the respective Allow
or Deny checkboxes.
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Notes:
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Configure the Controller

This chapter describes how to enable system communication and security 
enhancements for PlantPAx® system controllers. We assume that you have a 
basic understanding of the operation of Rockwell Automation® controllers. We 
do recommend that you review the sizing guidelines in the PlantPAx 
Distributed Control System Selection Guide, publication PROCES-SG001, 
to use the controller that fits your system requirements

To help mitigate the risk of data intrusion, controllers have enhanced 
protection with the Studio 5000 Logix Designer® application. The layer of 
device protection is independent of FactoryTalk® software security.

The security enhancements include the following (with the last three being 
independent of FactoryTalk):

• Security Server Validation—To access a secured controller or project 
file, the application verifies via the FactoryTalk Directory that you are 
authorized for such use.

• Restricted Communication—ControlLogix® controllers accept 
communication only through selected slots.

• Restricted External Data Access—External Access and Constant tag 
attributes control access to tags and safeguard against changes to
their values.

• Source Protection—A source key can be applied to routines and
Add-On Instructions to guard against code from being edited inside the 
Logix Designer environment.

Consideration Before starting this chapter, prioritize your system security level to match the 
authorized users in FactoryTalk Security.
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Figure 12 shows the topics that are described in this section. Click or see the 
page number for quick access to a section.

Figure 12 - Controller Security Workflow

See Chapter 8

Start

Use Architect for Controller Initiation

See page 205

Configure Network Adapters

See page 210

Synchronize the Project

See page 212

Configure RSLinx® Classic Software

See page 213

Enable Controller Security

See page 217

Configure Time Synchronization

Change Controller Properties

See page 207

Download the Controller

See page 216

• Create a Controller Logical Name
• Configure Authority Identifier
• Configure Communication Restrictions
• Configure Data Restrictions
• Configure Code Restrictions
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Use Architect for Controller 
Initiation

The Studio 5000 Architect™ application provides a controller with pre-defined 
functionality that is based on the selected system template. Once you select a 
template and create a project, you must configure RSLinx software to 
communicate the software data to the controller.

There are three templates available depending on the size and scope of
your project:

• Distributed Architecture– Multiple Process Servers: Contains two 
PASS servers; multiple Operator Workstations (OWSs), and an 
Engineering Workstation (EWS).

• Distributed Architecture – Single Process Server: Contains one 
PASS server; multiple Operator Workstations (OWSs), and an 
Engineering Workstation (EWS).

• Process Skid with Logix Batch Sequence Manager: Skid-based 
equipment that includes three CompactLogix™ controllers and one 
PanelView™ terminal to be integrated into overall system.

Complete these steps to select a template.

1. Click the Programs  symbol and choose Rockwell Software®>
Studio 5000®.

The Studio 5000 Common Launcher appears.

Use an Engineering Workstation 
with these procedures.

EWS
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The New Project dialog box appears.

2. Under Project Types, click to select Architect and then click the
second template (Distributed Architect - Single Process Server) for
this example.

3. Type a program name and click Finish.

The Architect canvas can take a couple minutes to open. The canvas 
appears with a layout of the architecture and a pre-defined controller
for the selected template.

TIP The Common Launcher dialog box is used for all products in Studio 
5000 environments. The product types that appear in the left pane 
depend on the products that are installed for your workstation.
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For a detailed description of the Architect application, see the
PlantPAx Distributed Control System Application User Manual, 
publication PROCES-UM003.

Change Controller Properties This section shows how to use the Studio 5000 Logix Designer application 
inside the Architect project to modify a controller. Changes include how to 
select another controller type, assign a name, and to enable redundancy, if 
applicable. Complete the following steps.

1. In the top, left pane of the Architect project, right-click a controller 
(LGXC01 in our example) and choose Open Project in Designer.

Wait a short time while the Logix Designer application opens.

2. Right-click the controller icon  and choose Controller Properties.

Use an Engineering Workstation 
with these procedures.

EWS
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 207

http://literature.rockwellautomation.com/idc/groups/literature/documents/um/proces-um003_-en-p.pdf


Chapter 7 Configure the Controller
The Controller Properties dialog box appears.

You can modify the controller name in the Name field. The template 
default is ‘LGXC01’.

If you change the name to a specific area, for example ‘Boiler’, that is the 
controller name after the application is synchronized.

3. To select another controller type, click Change Controller.

4. Click the pull-down menu, select another controller from the list, and 
click OK.
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5. If you are using a redundant controller, click the Redundancy tab.

6. Check the Redundancy Enabled box (only if you are configuring this 
controller for redundancy) and click OK.

7. Click the Save icon  at the top of the Logix Designer window.
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Configure Network Adapters A local communication adapter added to a Logix controller provides for 
communicate with PASS servers and workstations at the Supervisory level. 
Complete these steps.

1. Open a Logix Designer project.

2. In the Controller Organizer, right-click the controller backplane and 
choose New Module.

The Select Module Type dialog box appears.

3. Select a communication adapter for your application (Ethernet module 
in our example) and click Create.

Use an Engineering Workstation 
with these procedures.

EWS
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The New Module dialog box appears.

4. Type an adapter name and IP address.

See Table 25 for details.

5. Click Change.

6. On the Module Definition dialog box, select Time Sync and Motion 
from the Time Sync Connection pull-down.

7. Click OK.

8. Repeat step 2 through step 7 for each slot in the local chassis of the
target controller.

IMPORTANT You must synchronize your project to update the changes with the existing 
controller information. This option sends the modified project from Logix 
Designer back to the Architect application. See page 212.

Table 25 - Network Adapter Information

Name IP Address Architecture Cat. No.

LGXC01EN01A 172.18.1.100 Star 1756-EN2T

LGXC01EN01B 172.18.1.101 Star 1756-EN2T

LGXC01EN02 172.18.2.10 Device Level Ring/Star 1756-EN2TR
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Synchronize the Project Complete these steps to update controller information in the
Architect application.

1. In the Architect application, right-click the controller and choose 
Update Project Changes.

The Update Summary dialog box appears.

2. To see a preview of the synchronized changes, click to expand
the project.

The changes appear in the Message box.

3. Click Update.

The Ethernet Configuration dialog box appears.

4. Leave the devices and their port configuration as is, and click OK.

A wait message appears while the project is being synchronized.

Use an Engineering Workstation 
with these procedures.

EWS
212 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure the Controller Chapter 7
Configure RSLinx Classic 
Software

Complete these steps to configure RSLinx Classic software, which is a 
communication interface between the controller and FactoryTalk View
software products. Examples show how to configure two drivers: EtherNet/IP 
and Ethernet.

1. Click the Programs  symbol and choose Rockwell 
Software>RSLinx>RSLinx Classic.

The RSLinx Classic dialog box appears.

2. Click the Communications tab and choose Configure Drivers.

The Configure Drivers dialog box appears.

3. From the Available Driver Types pull-down menu, select the EtherNet/
IP Driver and click Add New.

Use an Engineering Workstation 
with these procedures.

EWS
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4. To complete the driver selection, click OK and then Close on the 
following dialog boxes.

The EtherNet/IP devices in the network appear under the
network communication driver.
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5. To add an Ethernet driver for routing in another network, repeat step 1 
and step 2.

6. Select Ethernet devices and click Add New.

7. Click OK and type IP addresses.

8. Click OK.

The Ethernet devices in the network appear under the
network communication driver.
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 215



Chapter 7 Configure the Controller
Download the Controller Complete these steps to download the controller.

1. In the Architect project, right-click a controller (LGXC01 in our 
example) and choose Open Project in Designer.

2. Click the Who Active button.

3. Browse the controller through the communication path (this action 
updates the path).

4. Click the controller path, Download, and then Set Project Path.

5. Click Download again.
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The Download Project Documentation and Extended Properties box 
enables multiple parties to share information.

6. Click the controller  symbol and select Run mode.

7. Click Yes.

Enable Controller Security You must be an authorized user to administer controller security.

Complete these steps.

1. In the Controller Organizer of the Logix Designer application,
double-click the controller icon to open the properties.

2. Click the Security tab.

IMPORTANT This procedure requires that you have defined FactoryTalk product policies. 
See page 199.

Use an Engineering Workstation 
with these procedures.

EWS
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3. From the Tools menu, right-click Security and choose Log On.

4. Type an authorized user name and password and click OK.

See page 217 to configure users with controller security.

5. Click Yes on successive dialog boxes to confirm the project.

6. In the Controller Organizer, double-click the controller to open the 
properties dialog box; click the Security tab.

7. Select FactoryTalk Security Directory from the Security Authority
pull-down menu.
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8. Click Use only the selected Security Authority for Authentication and 
Authorization and click Apply.

A warning message appears.

9. Click Yes.

Create a Controller Logical Name

Complete these steps to create a name for the controller in the
FactoryTalk Directory.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Administration Console.

2. Browse to the controller and then browse to the communication driver.

3. Right-click the communication driver and choose Properties.
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4. On the Device Properties dialog box, click the pull-down and select the 
controller name.

.

5. Click OK.

Configure Authority Identifier

This optional procedure is necessary only if you want to access a controller 
project from outside the system and still use FactoryTalk security. Projects that 
are secured to a specific Security Authority cannot be recovered if the identifier 
of the FTD that is used to secure the project no longer exists.

Complete these steps.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Administration Console.

2. Click the Tools menu and choose FactoryTalk Security
Authority Identifier.

TIP If the name does not appear in the Networks and Devices tree, open 
RSLinx Classic and go to the controller resource with RSWho. When 
you navigate to the resource in RSLinx Classic the controller path 
information updates in RSLinx Classic.

IMPORTANT We recommend that you back up the FTD and save unsecured versions of the 
project file to a secure location.
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3. Click Backup on the message window.

We recommend that you encrypt the file and enter a passphrase that you 
use during the restore process.

4. On the Backup dialog box, click ‘Encrypt file contents’ and type a 
passphrase; click OK.

Complete these steps to restore a project on another computer.

1. Repeat step 1 and step 2 on page 220.

2. Click Restore on the message window.

3. Select a file and click Next.

4. Type the Restore passphrase and click OK.

5. Select ‘Restore Security Authority in Identifier Only’.

6. Click Finish.
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The Logix Designer application can be opened now in another system 
directory. Observe the check in the box for ‘Use only the selected 
Security Authority for Authentication and Authorization.’

The following steps are required if the file is returned and the authority 
identifier does not work.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Administrative Console.

2. Click the Tools menu and choose FactoryTalk Security
Authority Identifier

3. Click Generate ID.

4. Click Close.
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Configure Communication Restrictions

This section describes how to restrict non-authorized communication modules 
from being added to a ControlLogix backplane.

1. In an Architect project, right-click a controller and choose Open Project 
in Designer.

2. Under the I/O Configuration folder in the Controller Organizer,
double-click the controller.

The Controller Properties dialog box appears.

3. Click the Security tab.

4. Click the Restrict Communications Except Through Selected Slots box.

5. Select each number that represents an authorized communication 
module slot in the controller.

Slot positions appear dimmed when selected.

6. Click Apply.

New data communication modules must have authorized access to be 
installed in the selected slots.
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Configure Data Restrictions

This section describes how to program Logix data tags to control external 
application access, such as HMI applications. The three external access tags are 
the following:

• Read/Write
• Read Only
• None

1. In an Architect project, right-click a controller and choose Open Project 
in Designer.

2. Double-click Controller Tags.

The tags appear in the right pane of the project.

3. To create a write restriction, click Constant to create a Read Only tag.

A Constant tag cannot have its values changed programmatically.

A Constant tag symbol  appears in the Value column for the
selected tag
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The Logix Designer compiler helps prevent write data in the
reserved data.

Configure Code Restrictions

Source Protection is applied to routines and Add-On Instructions to help 
prevent third-party access to components. This section shows how to apply 
Source keys, which are user-generated, case-sensitive passwords.

Complete these steps in Offline mode to enable a source key.

1. In an Architect project, right-click a controller and choose Open Project 
in Designer.

2. Click the Tools menu and choose Security>Configure
Source Protection.
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3. Select any desired routine or Add-On Instruction to be protected, and 
then click Protect.

4. Choose Source Key from the Protection Type pull-down menu and
click Specify.
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5. To specify a source key location, click Browse (ellipsis ‘…’) to the path 
and click OK.

6. Click Yes to confirm the source key file creation (sk.dat).

7. Type a source key (and jot down) to be applied and then type the name 
as shown in the example graphic, ‘PlantPAxKeyName.’

8. Click OK.
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The source key name appears in the Source Protection column.

The source key file (sk.dat) is recorded in the path that you designated
in step 3.
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If the source key file is moved from the designated file location, the 
component cannot be viewed.

9. To view the component, right-click the source key and choose
Make Viewable.

10. Click Close.
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Configure Time Synchronization

In a PlantPAx® system, time synchronization is essential for controllers, 
workstations, and servers to reference the same time for any event or alarm that 
occurs. To provide accuracy for sequence of events and historical data, several 
protocols are available to control and monitor the clocks. The internal clock 
deemed the reference is called the Grandmaster clock.

This chapter describes procedures for configuring time-sync applications by 
using two common protocols:

• Network Time Protocol (NTP)
• Precision Time Protocol (PTP)

NTP synchronizes time over the plant floor on an Ethernet network as shown 
in Figure 13 and Figure 14. NTP sources Coordinated Universal Time (UTC) 
as the universal standard for current time. Typically for Windows, a domain 
controller sources UTC time and becomes the Reliable Time Server for
the domain.

Figure 13 - System Time Synchronization Example Using an External NTP Server
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Two methods are described to use UTC time in your domain:
• Via your local network (intranet) or the Internet (Figure 13)
• Via GPS (Figure 14)

The Internet can introduce more propagation delays than GPS that can
cause inaccuracies in your system. Although the NTP system affords 
algorithms to calculate accurate time for either method, the GPS method 
provides better accuracy.

The Stratix switch is responsible for converting network time protocol (NTP) 
to precision time protocol (PTP). This functionality is available only in the 
Stratix 54x0 family.

GPS uses a global positioning system for high precision time accuracy. All 
components, as shown in Figure 14, with real-time clocks follow the same 
reference. However, a 1756HP-TIME module propagates directly to 
computers, controllers, and other devices via Ethernet switches.

For more information on time synchronization and CIP Sync, see the 
Integrated Architecture® and CIP Sync Configuration manual,
publication IA-AT003.

Figure 14 - 1756 Time Example (GPS Reference)
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Considerations Consider the following suggestions before starting this chapter:
• Decide which network time source — external NTP or GPS reference 

— that you are going to use. For additional information, see Chapter 1 
and Chapter 3 for switch address configuration and domain controller 
connections with an NTP server, respectively.

• To enable CIP Sync functionality in a ControlLogix® controller, select 
Time Synchronization in Ethernet adapters by using Studio 5000® Logix 
Designer software.

Figure 15 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 15 - Time Synchronization Workflow 
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Configure UTC Time Source UTC is independent of time zones and enables NTP to be used anywhere in 
the world regardless of time zone settings.

Configure Internet Time Synchronization

This section describes how to configure the Windows Time Service 
(w32Time) to use the Internet as a medium for sourcing a UTC time. Use the 
Windows time utility from an elevated command prompt.

Complete these steps by using the domain controller that is hosting the
PDC emulator role (PADCA).

1. Open an elevated Command session and click the Windows Key.
The Start Menu appears.

2. Choose Command Prompt (admin).

3. From within this Command session, type the following while 
substituting for the <pool> argument per your requirements:
w32tm /Config /ManualPeerList:<pool> /SyncFromFlags:Manual /
Reliable:yes /Update

There are (at least) four server pools of pool.ntp.org. But, the preferred 
assignment for <pool> is the first one (us.pool.ntp.org,0x8). Windows 
Event Viewer can log errors for URLs that to not respond. 

The 0x8 qualifier specifies Client Mode packets for server 
communication. For more information, Microsoft
Knowledgebase 875424.

You can specify a list of URLs that are <space> separated and enclosed 
in quotes. Make sure to append a type identifier for the URLs identifier 
as shown in Table 26. For example, 0x8 (client mode).

IMPORTANT <pool> is a place holder for the URL or URLs of multiple time 
servers (for example, atomic clocks). If you cannot access the 
Internet, those URLs could be of your parent domain controller. You 
can research UTC sources for your proximity, but Table 26 has 
examples that work for the U.S.

Table 26 - Internet <pool> Examples

Example Purpose

us.pool.ntp.org,0x8 URL specifies a single server

0.us.pool.ntp.org,0x8 1.us.pool.ntp.org,0x8
1.us.pool.ntp.org,0x8 2.us.pool.ntp.org,0x8

URLs specify the use of 4 unique servers

Use a domain controller 
with these procedures.

PADCA
234 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure Time Synchronization Chapter 8
The illustration shows an example that sources the U.S. pool.

If your system cannot access the Internet, <pool> can be a single target 
such as your parent or local Domain controller. Your domain time might 
not be within tolerable differences of other domains in your enterprise.

4. After you have commanded the w32tm utility by using the new 
configuration in step 3, use the Net utility to stop and then start the 
Windows Time Service from the same command session.

Table 27 - Local (non-internet) <pool> Example

Example Purpose

. Uses the current computer (PADCA) as the time 
source

PADCA Specifies a network time server on your local 
network
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NTP to PTP Clock Conversion

This section illustrates how to configure a Stratix 5400 to convert Network 
Time Protocol (NTP) to Precision Time Protocol (PTP),

1. From the Device Manager of the switch, click Configure and
choose PTP.

2. From the Mode pull-down, select NTP-PTP Clock.

3. Type a priority value for Priority1 and Priority2.

4. Click Submit.

Configure GPS Time Synchronization

If you do not implement an Internet or intranet-based time source, this section 
helps you configure a Global Positioning System (GPS) time source.

The 1756HP-TIME Module is used in the examples for this section. The 
module receives the GPS time reference and propagates the time to the 
computers by using NTP to the automation devices through PTP (CIP Sync).

The 1756HP-TIME module obtains time from various sources and provides 
time synchronization on other devices, thus acts as a gateway between different 
time synchronization methods.

1. Using the Logix Designer application, add the 1756HP-TIME module
to your project.

2. Right-click the module to access the Module Properties dialog box.

EWS

Use an Engineering Workstation
with these procedures
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3. Click the Configuration tab.

4. From the Source pull-down menu, select Internal GPS (Receiver).

5. In the Time Output area, select the desired Time Sync method.

The CIP Sync priority can be changed for the desired Time Sync 
method.
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6. Click the Advanced tab.

You can follow the Master status in the Advanced tab.

7. Click the Time Sync tab.

This tab lets you confirm the Grandmaster Clock and the actual
time status.
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Configure PTP Time 
Synchronization for Ethernet 
Bridges

Precision Time Protocol (PTP) enables precise synchronization of clocks in 
measurement and control systems. PTP generates a Master-Slave relationship 
among the clocks in the system. Clocks, which are synchronized over the 
EtherNet/IP network, derive their time from a clock that is selected as the 
Grandmaster clock. The Time Sync and Motion option must be enabled for 
Ethernet bridge modules to propagate time through the network via switches.

1. In the Architect application, right-click a controller and choose Open 
Project in Designer.

2. On the General tab of the Module Properties dialog box, make sure that 
‘Time Sync and Motion’ is selected for the connection. 

See page 211 for procedures on how to change a Module Definition.

Use an Engineering Workstation 
with these procedures.

EWS
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3. If online, click the Time Sync tab to confirm Grandmaster
clock settings.

Enable Switch Port Modes

By default, PTP is disabled on all Fast Ethernet and Gigabit Ethernet ports. 
The switch supports the following Synchronization Clock modes:

• End-to-End Transparent — In this mode, all switch ports are enabled by 
default. The switch transparently synchronizes all slave clocks with the 
master clock connected to the switch. This mode causes less jitter and 
error accumulation than Boundary mode.

• Boundary — Use this mode for networks with fewer than four layers of 
cascaded devices to avoid jitters and errors. The switch becomes the 
parent clock to which the other devices that are connected to the switch 
synchronize their internal clocks.

• Forward (default) — Traffic is forwarded through the switch (while 
being prioritized by QoS) but is not acted on by the switch.

CIP Sync time synchronization supports Boundary and End-to-End 
Transparent modes. End-to-End Transparent mode synchronizes all switch 
ports with the Grandmaster clock by using the IEEE 1588V 2 End-to-End 
Transparent clock mechanism, and is the preferred mode.

For more information, see the Stratix® Managed Switches User Manual, 
publication 1783-UM007.
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Configure PTP Time Synchronization for Controllers

A Logix controller that is CIP Sync enabled and designated the Grandmaster 
clock is the real-time source for the control system. The controller synchronizes 
with the PTP between the controllers and networks. Complete these steps.

1. Using the Logix Designer application, click the Open Controller™ 
Properties symbol. 

The Controller Properties dialog box appears.

2. On the Date/Time tab, click Enable Time Synchronization.

3. Click Advanced.

IMPORTANT Use your local time to configure the Time Zone and Adjust for
Daylight Saving.
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4. Click OK on the Controller Properties dialog box.

The status ‘Is a synchronized slave’ appears 
when the controller is synchronized.

The Grandmaster clock reference can be confirmed.
242 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Chapter 9

Configure the Process Automation System 
Server (PASS)

The Process Automation System Server (PASS) is a required system element 
for the PlantPAx® system. The PASS hosts essential software components that 
run the system, including the FactoryTalk® Directory (FTD). 

This chapter describes how to configure these components that comprise 
the PASS:

• HMI server – Stores HMI project components, such as graphic 
displays, and provides these components to Operator Workstations 
(OWS) upon request

• Data server – Accesses information from the process controllers and 
provides information to servers and workstations in the PlantPAx 
system

• Alarm and Event server – Provides alarm information from the 
controllers and servers to the OWSs upon request.

Considerations Consider the following suggestions before starting this chapter:
• The PASS server or servers must be deployed before doing the 

procedures in this section. 
– For templates based on your system requirements, see the PlantPAx 

Virtualization User Manual, publication 9528-UM001.
• Determine how many PASS servers are required for your architecture. 

– See ‘Determining the Number of PASS Servers’, in the PlantPAx 
Distributed Control System Selection Guide, 
publication PROCES-SG001.

• PASS servers can be configured as redundant for HMI servers, data 
servers, and/or alarm servers.
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Figure 16 shows the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 16 - PASS Workflow

Start

Configure Servers on PASS

See page 245

Commit Project

See page 256

Configure Redundancies

See page 257

See Chapter 10 Configure an Application Server Information 
Server (AppServ-Info)

Create Alarm and Event Database

See page 281

Define HMI Security

See page 284

Configure PanelView™ Plus

See page 293

• Configure the Application
• Configure the HMI Server
• Primary HMI Server
• Configure the Data Server
• Configure the Alarm and Event Server

• Enable HMI Redundancy
• Enable Data Server Redundancy
• Shortcut Configuration Paths
• Redundant ControlLogix Controller
• Enable Alarm and Event Redundancy

• Configure FactoryTalk SE Security

• Create a FactoryTalk View ME Project
• Configure FactoryTalk View ME Security
• Configure Time Synchronization for PanelView Terminals
• Download the Application
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Configure Servers on PASS In this section, you configure the human machine interface (HMI) server, data 
server, and the Alarms and Events server.

Configure the Application

In this section, you configure the application on an engineering
workstation (EWS).

Complete the following steps:

1. Click the Programs  symbol and choose Rockwell Software®>
Studio 5000®.

The Studio 5000 splash screen appears.

2. Select an existing project (PlantPAx in the example). 

Use an Engineering Workstation 
with these procedures

EWS01
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3. In the Logix tree, double-click PlantPAx>Projects>PlantPAx.

4. Click OK to accept the default application name 'PlantPAx'. 

5. In the Logix tree, double-click PlantPAx>Projects>PlantPAx>Area.

6. If desired, change the Area name and click OK; otherwise click OK to 
accept the default Area name 'Area'. 

IMPORTANT If you want to change the application and/or area name, complete 
step 3 through step 6. If you want to keep ‘PlantPAx’ as the 
application name and 'Area' as the area name, continue to Configure 
the HMI Server on page 247.
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Configure the HMI Server

The HMI server is configured within your Studio 5000 Architect® and 
FactoryTalk View Site Edition (SE) application. The HMI server stores HMI 
project components, such as graphic displays, and serves these components to 
OWSs upon request. The HMI server can also manage tag databases and log 
historical data. Multiple HMI servers can exist on the PlantPAx system.

Primary HMI Server

Complete the following steps.

1. Open the Architect application and a project.

2. In the Project Explorer area, click PlantPAx>Projects>Devices>
Process Area and choose PASS01.

The Computer Graphics Properties dialog box appears in the 
Process Area layout page of an Architect project.

TIP The following step does not change the name of the actual server, just the 
name of the graphical representation of the server.

Use an Engineering Workstation 
with these procedures

EWS01
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3. In the General tab, change the server name to the project name. 

4. In the Device tab, type the computer name that hosts the PASS.

For example, PASS02

5. Click OK.

It is also necessary to change, 
by hand, the name of the 
graphical representation to 
the name of the PASS host.
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6. If you need to change the name of the HMI server, click 
Projects>PlantPAx>Area and choose PlantPAx_HMI.

7. Type the new name and click OK.
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Configure the Data Server

In this section, we create shortcuts on data servers (FactoryTalk Linx) to 
connect controllers. The communication path to network devices is 
automatically updated in a Studio 5000 Architect or FactoryTalk View project. 

Complete the following steps.

1. If you need to change some configuration, right-click PlantPAx_DAT in 
the Project Explorer and choose Properties to specify the server in the 
graphical process display. Otherwise, continue with the next step.

Observe in the Communication pane (bottom example) that there is
no connection.

2. Drag the communication module from the LGXC01 chassis and drop it 
onto the PASS02A computer.

Use an Engineering Workstation 
with these procedures

EWS01

Communication Pane
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When the communication module is dropped onto the PASS server, the 
Configure Module dialog box appears.

3. (Optional) Type a Description.

4. Accept the rest of the defaults and click OK.

The communication shortcut is updated with the adapter name.
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5. Drag the controller from the LGXC01 chassis and drop it into the 
PASS02A computer. 

The Add New or Modify Existing Shortcut dialog box appears.

An Architect project uses the template controller name by default.
Our example is LGXC01.

We do not recommend that you change the shortcut name.
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6. Accept the defaults and click OK.

The shortcut is created for the controller.

7. Save your work.
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Configure the Alarm and Event Server

The Alarms and Events server is configured within the Studio 5000 Architect 
and FactoryTalk View SE application. This server publishes information from 
controllers and servers available to all subscribing OWSs. 

In this section, we describe how to configure alarm and event servers for 
tag-based alarms. We also show how to set the alarm severity.

1. If you want to change some Alarm and event configuration,
right-click Projects>PlantPAx>Area>Alarm>PlantPAx_AE in the 
Project Explorer.

The Tag Alarm and Event Server Properties dialog box appears. 

An Architect project defaults the alarm name and host computer.

2. (Optional) In the General tab, type a description and click OK.

Use an Engineering Workstation 
with these procedures

EWS01
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3. In the Priorities tab, accept the defaults and click OK.

For more information on alarm severity, see Appendix B in the Rockwell 
Automation® Library of Process Objects Reference Manual, publication 
PROCES-RM002.

4. Save your project.

Proceed to page 256 to commit your project.
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Commit Project When you commit a project, all data is sent from the Architect project to the 
FactoryTalk View application. The data is updated in the server for the 
respective servers: HMI, Data, and Alarms and Events.

Complete the following steps:

1. In the Project Explorer, right-click PlantPAx>Projects>PlantPAx and 
choose Commit Project Changes. 

2. In the Commit Summary dialog box, click Commit to perform the 
commit process.

3. Once a check mark appears next to your project in the Committing 
Projects dialog box, the configuration of the servers is complete.

4. To close the Committing Projects dialog box, click Close.
256 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure the Process Automation System Server (PASS) Chapter 9
Configure Redundancies This section describes for to configure redundancies for the HMI, Data, and 
Alarm and Event servers.

Enable HMI Redundancy

This section describes how to copy the primary HMI server application folder 
to the secondary HMI server. This procedure is performed only the first time 
the primary HMI server is copied. 

Copy the Primary HMI Server to the Secondary Server

To copy the primary HMI server to a location on the secondary server, 
complete these steps.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk View>Tools>HMI Server backup and Restore. 

The Select Operation dialog box appears. 

2. Click 'Backup HMI Server'.

Use a PASS with 
these procedures.

PASS02A
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The HMI server backup dialog box appears. 

3. Click Browse for the Source HMI server.

4. Navigate to the primary HMI server that was created earlier
and choose the .sed file. 

5. Click Open. 

6. Click Browse for the Destination backup path.

The destination is on the same physical machine as the Source HMI 
Server. 'Desktop' is a good choice because it’s convenient and easy
to access.
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7. Choose any destination path and click OK. 

‘Desktop’ is our example. 

8. Check 'Exclude the dialog filesets'.

9. Click Start Backup.

When the backup is complete, the 'HMI server backup complete' dialog 
box appears. 

10. Click OK.

The Select Operation dialog box reappears. 

11. Click Close.
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Copy Primary Folder to Secondary Server

The destination folder has to be cut from the primary physical machine and 
pasted on the secondary HMI server physical machine. 

1. In Windows Explorer, navigate to the destination folder you created 
(Desktop in our example), right-click the folder name, and choose Cut. 

2. Paste the HMI server folder into the secondary server folder 
(Site Edition (SE) HMI Projects folder). 

The default path is:

C:\Users\Public\Public Documents\RSView Enterprise\SE\
HMI projects.

Use a PASS with 
these procedures.

PASS02A
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Set Up HMI Redundancy

This section describes how to use HMI Properties to enable redundancy. 
Complete these steps.

1. Click the Programs  symbol and choose Rockwell Software>
Studio 5000.

2. From the Studio 5000 splash screen, select an existing project (PlantPAx 
in the example). 

3. In the Project Explorer, right-click PlantPAx>Projects>PlantPAx and 
choose Open Project in Designer.

4. In FactoryTalk View Studio, right-click the HMI server name and 
choose Properties.

The HMI Server Properties dialog box appears.

Use an Engineering Workstation 
with these procedures

EWS01
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5. On the General tab, click 'Load and run startup components when 
operating system initializes'.

6. Click Apply. 

7. Click the Redundancy tab. 

8. Check 'Provide redundancy using a secondary server'.

9. Click Browse (ellipses ‘…’) and select the Secondary server.

10. Click OK.
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A message window appears.

11. Click Yes.

Server Status

In this section, you verify the status of the Active (Primary) and
Standby (Secondary) servers.

1. In FactoryTalk View Studio, right-click the HMI server name and 
choose Server Status
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2. In the Server Status dialog Box, verify the following:
• The Primary server (for example, PASS02A) is correct and 'Active'
• The Secondary server (for example, PASS02B) is correct

and 'Standby'.

3. Click OK.

Replicate Active to Standby

In this section, you replicate the Primary properties from the Primary server to 
the Secondary server.

1. In FactoryTalk View Studio window, right-click the HMI server name 
and choose Properties.

IMPORTANT Every change that is made in the Primary server must be replicated.
The replication process is always from the Active to the Standby.
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The HMI server properties dialog box appears.

2. On the Redundancy tab, click 'Replicate Active to Standby'.

A replication warning appears.

3. Click Yes.

A progress bar shows the status of the copy process.

4. Click Close.

TIP The Secondary server no longer automatically restarts when the 
copy process completes.
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Enable Data Server Redundancy

This section describes how to configure a Secondary server and edit redundant 
controller paths.

Set Up Data Redundancy

Complete the following steps.

1. Open your project (PlantPAx in the example). See step 1 through step 3 
for more information.

2. In the Explorer, right-click PlantPAx>Area>Data>PlantPAx_DAT and 
choose Properties.

The FactoryTalk Linx Server Properties dialog box appears.

3. In the Redundancy tab, check ‘Provide redundancy using a secondary 
server’ box. 
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4. Click Browse and select the secondary server.

5. Click OK.

Shortcut Configuration Paths

The PlantPAx system provides several methods for enabling communication 
with controllers via shortcuts:

• Single Redundant Path (processor) — This ‘traditional’ redundant
path has a single IP address with a Simplex controller or redundant set
of controllers.

• Dual Redundant Path — Each of two adapter modules in a controller 
chassis have their own IP address. If one adapter has a break in 
communication, the other adapter is available as a redundant backup.

• Redundant ControlLogix® controller — This method also requires fixed 
IP addresses at the controller level. There is a primary IP address and a 
secondary IP address configured for a redundant pair of Ethernet 
adapters. A switchover from the primary controller uses the IP address 
of the adapter in the secondary controller.

Configure a Single Redundant Path

This section describes how to configure an IP address for a Simplex controller.

1. If necessary, expand the primary Data server (PlantPAx_DAT in
the example).

2. Double-click Communication Setup.

LGXC01

Path 1
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The Communication Setup window appears.

3. Click the shortcut (LGXC01 in the example).

4. Click the Primary tab and select the path to the controller 
(1756-L75, LGXC01 in the example).

If you are using data server redundancy, you must configure a patch from 
the secondary data server to the controller.

5. On the Communication Setup window, click the Secondary tab.

6. Click Verify (third button to the left of OK).

7. Click OK to close the verification dialog box.

8. Navigate to and select a path to the controller.

9. Click OK. 

10. Review the summary of changes and click Yes to apply.

11. Right-click the data server name (PlantPAx_DAT in the example) in the 
Explorer tree and choose Server Status.
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The Server Status dialog box appears. 

12. Click OK.

Configure a Dual Path for a Simplex Controller

Complete these steps to configure dual IP address paths for separate adapters in 
the same controller chassis.

1. Expand the primary Data server (PlantPAx_DAT in the example).

2. Double-click Communication Setup.

The Communication Setup window appears. 

3. Click the shortcut (LGXC01 in the example).

LGXC01

Path 1
Path 2
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4. Click Shortcut Type and choose Redundant Controller Path from the 
Processor pull-down.

5. Click Yes.

6. Click the shortcut (LGXC01 in the example).

7. Click the Secondary Tab and select (1756-L75, LGXC01
in the example).

8. Do not click OK. Remain on the Communication Setup window to 
finish configuring the adapter paths, starting on page 271.
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Select Path 1 for the Primary Data Server

Complete these steps to select the IP address for the path 1 adapter.

1. Select Path 1 for the shortcut.

2. From the Primary tab, select the IP address for the path 1 adapter
and the controller.
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3. Click Apply.

Select Path 2 for the Primary Data Server

Complete these steps to select a different IP address for a second adapter
for path 2.

1. Select Path 2 for the shortcut.

2. From the Primary tab, select the IP address for path 2 and the controller.

3. Click Apply.

4. Click Yes twice to assign both paths to the Primary server.
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5. Click the Secondary tab and select Path 1.

6. Select the IP address for the path 2 adapter and the controller.

7. Click Apply.

8. Click OK.

9. Click Yes on the message window.
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Redundant ControlLogix Controller

Complete these steps to assign a fixed IP address to a redundant pair of 
ControlLogix controllers.

1. From the Communication Setup window, click the second shortcut 
(LGXC02 in the example).

2. Select Redundant ControlLogix Controller from the Shortcut Type 
pull-down menu.

Primary Secondary

Path 1
Path 2
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3. Click Apply.

4. Click the Primary Controller shortcut.

5. From the Primary tab, select the IP address of the adapter and the 
primary controller.

Observe that our example shows the IP address of 172.18.1.105.

6. Click Apply.

A FactoryTalk Linx popup window appears with the message the target 
controller is being configured.

7. Click Yes.

IMPORTANT Make sure the HMI communication card is configured to disallow an 
IP address swap.Configure a different IP address than the first HMI 
communication card.
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Another FactoryTalk Linx popup window appears with a message
that changes are being made to the controller shortcut (LGXC02
for our example).

8. Click Yes.

9. From the Communication Setup dialog box, click the
Secondary Controller.

10. From the Primary tab, select a different IP address for the adapter and 
the primary controller.

Observe that our example shows the IP address of 172.18.1.106.

11. Click Apply.
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FactoryTalk Linx popup windows appear.

12. Click Yes for each message.

13. Click the Secondary tab, and then click Primary Controller shortcut.

14. Select the same IP address of the adapter and the controller that you did 
for the data server for the primary controller in step 5 on page 275.

Observe that our example shows the IP address of 172.18.1.105.

15. Click Apply.
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FactoryTalk Linx popup windows appear.

16. Click Yes for each message.

17. Click Secondary Controller.

18. Select the same IP address of the adapter and the controller that you did 
for the data server for the secondary controller in step 10 on page 276.

Observe that our example shows the IP address of 172.18.1.106.

19. Click OK.
278 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure the Process Automation System Server (PASS) Chapter 9
FactoryTalk Linx popup windows appear.

20. Click Yes for each message.

Enable Alarm and Event Redundancy

Complete these steps.

1. In FactoryTalk View Studio, right-click 
PlantPAx>Area>Alarm>PlantPAx_AE and choose Properties.

The Tag Alarm and Event Server Properties dialog box appears.
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2. On the Redundancy tab, check ‘Provide redundancy using a secondary 
alarm server.

3. From the pull-down menu, select the Secondary server.

4. On the Priorities and History tab, verify the alarm severity ranges
and click OK. 
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Create Alarm and Event 
Database

You must create a database to enable Alarm and Event history. 

Complete the following steps:

1. From FactoryTalk View Studio Explorer, right-click 
System>Connections>Databases and choose New Database.

The Alarm and Event Historian Database Properties dialog box appears. 

2. Configure the new database.
a. Type a definition name.

b. Click the type of SQL Server you want to use.
c. Type the Computer name or click Browse (ellipsis ‘…’) to navigate to 

the computer name.
d. Type a Database user name.
e. Type ‘SA’ for the user and the SA password, or use other

known credentials.

Use an Engineering Workstation 
with these procedures

EWS01
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f. Type a new Database name or click Browse (ellipsis ‘…’) to navigate to 
a database name.

3. Click OK.

A log on popup window could appear.

4. Type the user name ('sa' for the dedicated database).

5. Type the password and click OK.

A popup window appears and asks if you want to create the database.

6. Click Yes.

IMPORTANT The user name must match the SQL server user account.
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The SQL Server Log On dialog box appears. 

7. Right-click the Alarm and Event server.

The Server Properties dialog box appears. 

8. On the Priorities and History tab, check 'Enable history'.

9. From the pull-down menu, select the database definition.

10. Accept the default Cache file path.

11. From the pull-down menu, select the Log Language.

12. Click OK.
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Define HMI Security This section describes how to configure security for the FactoryTalk View
Site Edition (SE) software.

Configure FactoryTalk SE Security

Runtime security must be set up to provide each account or user group with the 
correct FactoryTalk View security codes. The security codes verify that 
operators, maintenance personnel, and engineers have permission to run 
secured commands, open secured graphic displays, or write to secured tags
at runtime.

Import FactoryTalk Site Edition Security Tags

Complete the following steps to import security tags on the PASS.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk View>Tools>Tag Import and Export Wizard. 

The Tag Import and Export Wizard dialog box appears. 

2. From the Operation pull-down, select Import FactoryTalk View tag 
CSV files and click Next.

IMPORTANT See Rockwell Automation Library of Process Objects, publication
PROCES-RM002, for a list of security codes and descriptions.

Use a PASS with 
these procedures.

PASS02A
284 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019

http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm002_-en-p.pdf


Configure the Process Automation System Server (PASS) Chapter 9
3. From the Project Type pull-down, select Site Edition and click Browse 
(ellipsis ‘…’).

The Select Destination Project dialog box appears.

4. Select the path of SE>HMI Projects>PlantPAx_HMI.

5. Select PlantPAx_HMI.sed and click Open.
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6. Click Next and Browse (ellipsis ‘…’) for the ProcessLibrary4-
SecurityAndConstantsTags.CSV file. This file is distributed with the 
PlantPAx Library of Process Objects Library.

7. Click Open.
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8. Click Next twice, and then click Finish.

The import results appear on the Database Import window.

9. To close the window, click ‘X’.
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Setting Group Security

Complete these steps to set security permissions to groups on the workstation.

1. Click the Programs  symbol and choose Rockwell 
Software>Studio 5000.

The Studio 5000 splash screen appears.

2. In the Studio 5000 splash page, select a recent project (PlantPAx in the 
example). 

3. In the Project Explorer, right-click PlantPAx>Projects>PlantPAx
and choose Open Project in Designer.

The FactoryTalk View Studio dialog box appears.

EWS01

Use an Engineering Workstation 
with these procedures.
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4. To verify that the security tags have been imported, choose 
PlantPAx>Area>PlantPAx_HMI>HMI Tags and double-click Tags.

5. In the FactoryTalk View Studio window, double-click 
PlantPAx>Runtime Security. 

The Runtime Security panel appears on the right side of the window.

6. Click Security Accounts .

IMPORTANT If the security tags have not been imported, see Import FactoryTalk 
Site Edition Security Tags on page 284 for procedures.
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The Security Settings dialog box appears.

7. Click Add.

The Select User and Computer dialog box appears.

8. Click a PlantPAx group and click OK.

The group name appears in the top half of the Security Settings
dialog box.

9. Repeat step 7 and step 8 until all PlantPAx groups are selected.

Each group has its own security code.
For example, ‘A’ for Operators, ‘B’ for 
Operating Supervisory.

See a list of security codes on page 291.
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10. Select 'All Users' and click Remove.

You can assign security to each PlantPAx group based on letters (A…G).

11. Select a group from the Users list.

The default is that all FactoryTalk View Security Codes are
checked Allow.

12. Click the Deny checkbox beside the FactoryTalk View Security Codes 
that you do not want to allow permission for the selected account.

For example, allow security of ‘A’ for an Operator but deny ‘B’, ‘C’, ‘D’.

13. Click OK.

14. Repeat step11 through step 13 for each user or group account that you 
want to set up with runtime security.

Table 28 - Recommended Group Security Codes

Group Security Code

Operators A

Operating Supervisor B

Maintenance C

Maintenance Supervisor D

Engineering E

Manager F

Administrator G
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The PlantPAx groups that you set up with runtime security appear in the 
Account section of the Runtime Security dialog box.

15. Click Save .
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Configure PanelView Plus This section describes how to configure the HMI Machine Edition software 
for use with PanelView applications.

Create a FactoryTalk View ME Project

In this section, you create a FactoryTalk View ME project.

Complete the following steps:

1. Click the Programs  symbol and choose Rockwell 
Software>Studio 5000.

The Studio 5000 splash screen appears.

2. In the Studio 5000 splash page, select a recent project (PlantPAx in 
the example). 

Use an Engineering Workstation 
with these procedures

EWS01
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3. Drag the desired PanelView object (2711P-K15C4A9 in the example) 
from the Library Management panel and drop it in the Process
Area panel.

The new graphic dialog box for the PanelView object you selected (1500 
PanelView Plus 6 in the example) appears.

4. Type the name of the PanelView graphic (PVS001 in the example).

5. Type the IP address of the PanelView object and click OK.

The new project dialog box for the PanelView object appears.
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6. Type the name of the PanelView project (PVS001 in the example) and 
click OK.

7. Connect any port on the switch to the PanelView.

Connection
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8. Drag the communications module from the chassis (LGXC01 in the 
example) and drop it on the PanelView.

The Configure Module dialog box appears.

9. Click OK.
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10. Drag the controller module from the chassis (LGXC01 in the example) 
and drop it on the PanelView module.

The Add New or Modify Existing Shortcut dialog box appears.

11. Click OK.
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12. In the Project Explorer panel, right-click the project name (PVS001 in 
the example) and choose Commit Project Changes.

The Commit Summary dialog box appears.

13. Click Commit. 
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14. Click Close to close the Committing Projects dialog box.

15. In the Project Explorer panel, right-click the project name (PVS001 in 
the example) and choose Open Project in Designer.

The FactoryTalk View Studio window appears.

TIP Do not close this window as it is used in later procedures.
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Configure FactoryTalk View ME Security

Runtime security must be set up to provide each account or user group with the 
correct FactoryTalk View security. Complete these steps.

1. If the FactoryTalk View Studio window is not already open, do the 
following:

a. Click the Programs  symbol and choose 
Rockwell Software>Studio 5000.

b. In the Studio 5000 splash page, select the PanelView project. 
c. In the Project Explorer, right-click on the PanelView project and 

choose Open Project in Designer.

2. In the Explorer panel of the FactoryTalk View Studio window, 
double-click PVS001>PVS001>PVS001>System>Runtime Security. 

The Runtime Security window appears.
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3. Click Add to insert local users groups.

4. Choose Create New>User group in the Select User or Group window to 
create PlantPAx user groups.

The New User Group dialog box appears.

5. Type the user group name and click OK.

6. Repeat step 4 and step 5 for all desired PlantPAx user groups.
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7. Click ‘Show users only’ and then click Create New>FactoryTalk User
to create a user.

8. In the General tab of the New User dialog box, type the PanelView user 
name followed by a password.
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9. In the Group Membership tab, click Add.

10. Select a PlantPAx group and click OK.

11. Click OK.

12. Repeat step 8 through step 11 for all desired users.

IMPORTANT Observe that the selected group is being added to the user; the user is not 
being added to the group.
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13. Click Add to insert all PlantPAx user groups.

14. In the Select User or Group dialog window, select a User Group and 
click OK.

The group name appears in the Account list.

15. Repeat step 13 and step 14 for all desired groups.
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We recommend that you remove the default security codes if you are 
using the Process Library objects. For more information, see the 
Rockwell Automation Library of Process Objects Reference Manual,
publication PROCES-RM002.

16. For each of the user groups, click a user group in the account section and 
type ‘Y’ (yes) or ‘N’ (no) for the respective security codes.

17. Click Close when all security codes are assigned to the groups.

18. When asked, confirm that you want to save Runtime Security.
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Configure Time Synchronization for PanelView Terminals

PanelView terminals are used for applications that monitor, control, and 
display information graphically. The terminals provide operators a quick and 
efficient status of their application.

Complete the following steps for the controller project:

1. If the Studio 5000 Logix Designer® application is not already open,
do the following:

a. Click the Programs  symbol and choose 
Rockwell Software>Studio 5000.

b. In the Studio 5000 splash page, select the controller project. 
c. In the Project Explorer, right-click on the controller project and 

choose Open Project in Designer.

2. When not using the 1756 HP -TIME module, create a Get System 
Value (GSV) instruction to capture the controller clock, according to 
the example that follows.
• Class Name – WallClockTime
• Attribute Name – LocalDateTime
• Dest – Create a DINT array [7] (LocalDateTime[0]…[6])

Complete the following steps for the PanelView project:

1. If FactoryTalk View Studio is not already open, do the following:

a. Click the Programs  symbol and choose 
Rockwell Software>Studio 5000.

b. In the Studio 5000 splash page, select the PanelView project. 
c. In the Project Explorer, right-click on the PanelView project and 

choose Open Project in Designer.

TIP We recommended that this GSV instruction be triggered every
minute (60 seconds).
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2. In the FactoryTalk View Studio window, double-click 
PVS001>PVS001>PVS001>System>Global Connections. 

The Global Connections panel appears at the right side of the window.

The following steps create Remote Time references.

3. For the first remote connection, click the Browse button (ellipsis ‘…’).

4. Find the proper tag and click Open.
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The tag appears in the Tag expression column.

5. Repeat step step 3 and step 4 for the rest of the remote connections.

When using the 1756 HP -TIME module, information is available.
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Download the Application

This procedure downloads the runtime application file from the workstation 
to the PanelView.

Complete the following steps:

1. If the FactoryTalk View Studio window is not already open, do the 
following:

a. Click the Programs  symbol and choose 
Rockwell Software>Studio 5000.

b. In the Studio 5000 splash page, select the PanelView project. 
c. In the Project Explorer, right-click on the PanelView project and 

choose Open Project in Designer.

2. From the Application menu, choose Create Runtime Application.

The Create Runtime Application dialog box appears.

3. Click Save to accept the default file name. 
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4. In the FactoryTalk View Studio ME window, click the

Transfer Utility  icon.

The Transfer Utility window appears.

5. Verify the Source file default path and select the destination 
PanelView terminal.

6. The first time that you download this file, click Replace 
Communications.

7. Click Download.
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8. When the download completes, a dialog box notifies you that the 
download is successful.

9. Click OK.
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Notes:
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Configure an Application Server Information 
Server (AppServ-Info) 

This chapter describes procedures for configuring the Information 
Management application server (AppServ-Info) with the
FactoryTalk View Historian Site Edition (SE) software and the
FactoryTalk® VantagePoint® server. 

The Historian SE tool lets you collect, manage, and analyze real-time data from 
the PlantPAx® system.

The VantagePoint software tool helps make informed business decisions with 
the plant floor data used as a gauge of the manufacturing process. You can use 
the VantagePoint software with mobile devices, tablets, and phones to generate 
reports via importing historical data tags.

Considerations Consider the following suggestions before starting this chapter:

FactoryTalk Historian
• When you plan your FactoryTalk Live Data location, be sure to enable 

buffering and high availability with failover capability.
• Consider a collective if you want high availability with redundant 

Historian servers.

FactoryTalk VantagePoint

Although the procedures in this chapter only expose historical data, you must 
decide the type of report variables that are required to generate your 
manufacturing intelligence.

IMPORTANT Before starting this chapter, make sure that the FactoryTalk® Historian 
template has been deployed and initialized. If you are not using the
Historian template, refer to Knowledgebase Answer ID 491889 - Migrating 
and/or Upgrading to FactoryTalk Historian Site Edition
at https://www.rockwellautomation.custhelp.com.

IMPORTANT We do not recommend installing data management (Historian) and
decision reporting (VantagePoint) software on the same AppServ-Info 
server for small-scale applications. Use separate servers to
maximize performance.
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Figure 17 shows the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 17 - AppServ-Info (Historian) Workflow 
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Configure Historian SE Server 
Collective

A server collective consists of two FactoryTalk Historian SE servers (primary 
and secondary) that have the same configuration database. The collective 
provides the same association between the key values in the FactoryTalk 
Historian SE tables on all servers. The collective also helps confirm that the 
archive data files have the same structure on all servers.

Keep the following in mind regarding server collectives:
• When creating a server collective, you must always us fully qualified host 

names, not IP addresses. Therefore, the name resolution functionality 
must work on the network.

• If you make one or more FactoryTalk Historian SE servers members of a 
collective, you must restart them after the server collective is created. 
Otherwise, FactoryTalk Administration Console does not recognize any 
of the third-party tag licenses you have on your servers.

• To create a server collective on computers that have the Windows 
Firewall turned on, you must manually open the TCP 445 port between 
the two computers. See the Microsoft documentation for more 
information.

• The Windows user that configures server collectives must be a domain 
user and must be mapped to the piadmin user.

• The same 'Windows user to piadmin user mapping' must be performed 
on both the primary and secondary server in the collective.

• Activate your server collective in the FactoryTalk Administration 
Console.

Create a Firewall Rule for Primary Historian Server

This section describes how to create an inbound rule for your 
Windows firewall on the primary Historian server (ASIH01A). Be sure
to add the 445 rule for FactoryTalk SE even if you see existing rules that allow 
port 445.

Complete the following steps.

1. In the bottom left corner of the Windows Desktop, click the

Windows  icon. 

IMPORTANT A server collective is required for high availability. If you are not using a 
collective, skip to Configure a Historian SE Server on page 331.

Use the Historian servers 
with these procedures.

ASIH01A ASIH01B
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 315



Chapter 10 Configure an Application Server Information Server (AppServ-Info)
2. Click Control Panel and choose Windows Firewall. 

The Windows Firewall Window appears.

3. Click Advanced Settings. 

The Windows Firewall with Advanced Security window appears.

4. Right-click Inbound Rules and choose New Rule. 
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The New Inbound Rule Wizard - Rule Type window appears.

5. Click Port and then click Next. 

6. Click Specific local ports, type '445' in the text box, and then click Next.
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7. Click Next on each of the successive dialog boxes to do the following:
• Allow the connection
• Apply the rule to the Domain, Private, and Public

The New Inbound Rule Wizard - Name appears.

8. Type a name for this rule (Collective Connection in the example) and 
click Finish. 

Your inbound rule for your firewall is created.

Create a Firewall Rule for Secondary Historian Servers

To create an inbound rule for your Windows firewall on secondary Historian 
servers, repeat step 1 through step 8.
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Change the Historian Identification 

In this section, you create a ServerID for one of the FactoryTalk
Historian servers.

Complete the following steps.

1. In Windows desktop, click File Explorer and navigate to 
c:\Program Files\Rockwell Software®\FactoryTalk 
Historian\Server\adm. 

2. Type 'cmd' and press Enter. 

The Command window appears and is in the c:\Program 
Files\Rockwell Software\FactoryTalk Historian\Server\adm directory. 

IMPORTANT Perform this section only if you are running VMware Template or if you have 
cloned a FactoryTalk Historian server. 
Otherwise, continue to Set Security Settings on page 321

Use a Historian server 
with these procedures.

ASIH01A or ASIH01B

IMPORTANT Make sure that you press 'Enter' after typing each command in the
following table.
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See Figure 18 on page 320 for reference as you type the commands in 
the following table: 

Figure 18 - Command Window 

If you have connected before, the next time you access this FactoryTalk 
Historian server, you see the following window. 

3. Click 'Accept the new ID' and click OK.

Command

piconfig

table piserver

mode edit

istr name, serverID

<hostname>, <new serverID>

@exit
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Set Security Settings

In this section, the security settings for the primary and secondary FactoryTalk 
Historian servers are set.

Security Settings for the Primary Historian Server

Set the security settings for the primary FactoryTalk Historian servers.

Complete the following steps.

1. Click the Programs  symbol and choose Rockwell 
Software®>FactoryTalk Historian SE>System Management Tools. 

The 'Security Settings - PI System Management Tools (Administrator)' 
window appears.

Use the Historian servers 
with these procedures.

ASIH01A ASIH01B
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2. Under Collectives and Servers, check the server that you want to set the 
security settings for. 

3. Under System Management Tools, choose Security>Security Settings.

The Security Settings slider appears on the right side of the window.

4. Set the slider to its lowest point and click Save.

5. In the Windows desktop, click the Programs  symbol and choose 
Administrative Tools>Services. 
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6. Right-click PI Base Subsystem and choose Restart. 

The PI Base Subsystem service restarts. When the status is 'running', 
continue with the next step.

7. Close the Services and Administrative Tools windows.

Security Settings for the Secondary Historian Server

In this section, the security settings for the secondary FactoryTalk Historian 
server are set.

Repeat step 1 through step 7 for the secondary Historian server.
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Connect Primary Historian Server to Secondary Historian Server

In this section, you make a connection from the primary Historian server 
(ASIH01A) to the secondary Historian server (ASIH01B).

Complete the following steps:

1. Open the PI SDK utility and click Connections.

2. Click in the white space and then click Add Server.

3. Type the server name (ASIH01B in the example) in the Network Node 
text box.

4. Accept the rest of the default entries and click OK.

Use the Historian server 
with these procedures.

ASIH01A
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5. In the PI Connection Manager window, right-click a server that is not 
necessary and choose Remove Selected Server. 

6. Repeat this step for servers only that you do not need.

Once you have deleted all unnecessary servers, the PI SDK Utility 
window looks similar to the following figure. 

7. Click Save.
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8. In the 'Security Settings - PI System Management Tools 
(Administrator)' window, make sure both FactoryTalk Historian servers 
(ASIH01A and ASIH01B in the example) are checked. The window 
appears similar to the following figure. 

Connect Secondary Historian Server to Primary Historian Server

To connect the secondary Historian server (ASIH01B) to the primary 
Historian server (ASIH01A), repeat step 1 through step 8 on the secondary 
server (ASIH01B).

IMPORTANT When you repeat step 3, type ASIH01A in the Network Node text box on the 
Add Server dialog box.

Use the Historian server 
with these procedures.

ASIH01B
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Create a Server Collective

In this section you create a FactoryTalk Historian collective (ASIH01) that 
includes FactoryTalk Historian servers ASIH01A and ASIH01B.

Create Collective and Add Historian Servers

Complete the following steps.

1. In the Windows desktop, click the Programs  symbol and choose 
Rockwell Software®>FactoryTalk Historian SE>FactoryTalk Historian 
SE System>Collective Manager. 

The PI Collective Manager (Administrator) window appears.

2. Click File and choose Create New Collective. 

The Create New Collective dialog box appears.

Use the Historian servers 
with these procedures.

ASIH01A
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3. Check both boxes and click Next. 

The Existing or New Primary dialog box appears.

4. Check 'A newly installed PI server' and click Next. 

The Select Primary and Collective Name dialog box appears.

5. Select the primary FactoryTalk Historian server from the pull-down list. 

If the server name does not appear in the pull-down list, click the ellipses 
 and select the server from the Connection Manager dialog box.

6. (Optional) Type a description for the collective primary.

7. Type a unique name for the new collective.

8. (Optional) Type a description for the collective and click Next.
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The Select Secondary Servers dialog box appears.

9. Select the secondary FactoryTalk Historian server from the pull-down 
list. 

If the server name does not appear in the pull-down menu, click Browse 
(ellipses ‘…’) and select the server from the Connection Manager
dialog box. 

10. (Optional) Type a description for the collective secondary.

11. Click Add.

The server is added to the server list.

12. (Optional) Add additional secondary servers by repeating step 9 
through step 11 with another server.

13. When you are finished adding secondary servers, click Next. 

The Select Archives dialog box appears.

14. Click Next on each of the successive dialog boxes to do the following:
• Accept the default number of archives to be copies
• Accept the default location for the temporary backup
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The Verify Selections dialog box appears.

15. Verify the information on this screen and click Next. 

The Conversion Process dialog box appears.

The Conversion Process page displays the status and individual steps of 
the conversion process.

The Server ID Mismatch window appears when the process completes.

16. Click 'Accept the new ID' and click OK.
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The Finished page appears.

17. Click Finish to complete the Create New Collective process. 

Configure a Historian SE 
Server

This section describes how to create a FactoryTalk Historian SE server.

Create a Historian Server

This section describes how to configure, test, and name a Historian 
server connection.

1. Click Start and choose Rockwell Software®>FactoryTalk 
Administration Console.

The Select FactoryTalk Directory dialog box appears. 

2. Click Network and then click OK. 

IMPORTANT To perform this procedure, make sure that you have completed step 1 
through step 7 on pages 321…323.

Use the Historian server 
with these procedures.

ASIH01 or ASIH01A (If 
working with a collective)
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The FactoryTalk Administration Console dialog box appears. 

3. In the FactoryTalk Administration Console, right-click 
Network>System>Connections>Historical Data and choose New 
Historian Server Connection. 

The 'New Historian Server Connection' dialog box appears. 

4. From the pull-down menu, select the Server or Collective Name.

5. Click Test Server Connection. 

If the connection is good, a green check mark appears along with the text 
'Server Found'.
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If the connection is not good, a yellow triangle appears along with the 
text 'No server found'. 

6. Click Finish. 

7. In the FactoryTalk Administration Console, right-click 
Network>System>Connections>Historical Data>'<Production 
Historian>'> and choose Properties.

The Historian Server Connection Properties dialog box appears.

8. Click the Licensing tab.

The dialog box now shows both the Primary and Secondary servers.

9. Type '1' in the Assigned column and click Apply.

10. Click Apply.

TIP If the connection to the server is not good:
• Make sure that the correct Historian server is called out
• Make sure that the Historian server is installed correctly

IMPORTANT This step also creates an instance of the FactoryTalk Live Data (FTLD) 
interface on the host.

IMPORTANT Depending on your licensing, the dialog box could appear 
differently. But, use the fhse.xxxK activation.
If using a collective, you must have two total and assigned licenses.

The example shows ‘1’ 
license stored locally in 
each collective server. If 
both activation licenses 
are on the activation 
server, you need to type 
‘2’. This applies to a 
collective only.
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Create Security Certificates

For security purposes on the collectives, you must create OSIsoft 
certificates on the Primary and Secondary servers. First, you must delete
the default certificate.

To delete the existing certificate, complete these steps.

1. In the Microsoft Windows Search bar, type mmc and press Enter.

2. On the console, select File and choose Add/Remove Snap-in.

3. In the left pane of the Add or Remove Snap-ins window, select 
Certificates.

4. Click Add.

5. Select Computer account and click Next.

6. Select Local computer (the computer this console is running on).

7. Click Finish.

8. Click OK.

9. In the left pane of the console, click the arrow  to expand the 
Certificates folder.

10. Click the arrow to expand OSIsoft LLC Certificates and select 
Certificates.

IMPORTANT Follow these instructions to initiate the script to use the collectives.

TIP Microsoft Management Console (mmc) hosts administrative tools that
you can use to administer networks, computers, services, and other
system components. 
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11. In the middle pane, right-click a selected certificate and choose Delete.

12. Click Yes on the confirmation window.

Run the PowerShell Script

After you delete the default OSIsoft certificate, run a PowerShell script to 
generate a certificate on the primary server. Complete these steps.

1. Click the Windows button and right-click Windows PowerShell.

2. Click More and choose Run as Administrator.
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3. Copy and paste the following script into PowerShell.

$CertStorePathName = "Cert:\LocalMachine\OSIsoft LLC Certificates"

if(!(Test-Path $CertStorePathName))

{
    New-Item -Path $CertStorePathName

}
if( (Get-ChildItem -Path $CertStorePathName | measure).count -eq 0)

{
    $myFQDN=(Get-WmiObject win32_computersystem).DNSHostName+"."+(Get-
WmiObject win32_computersystem).Domain

    $DNSName = @($myFQDN)

    #$NewCert = New-SelfSignedCertificate -CertStoreLocation 
Cert:\LocalMachine\My -FriendlyName $myFQDN $DNSName -Provider "Microsoft 
Enhanced RSA and AES Cryptographic Provider" -HashAlgorithm "SHA256"

    $NewCert = New-SelfSignedCertificate -CertStoreLocation 
Cert:\LocalMachine\My -DnsName $DNSName -NotAfter $(Get-
Date).AddYears(100)

    Move-Item $NewCert.PSPath -Destination $CertStorePathName

}
else

{
    Write-Host("Invalid number of certs detected in OSIsoft LLC certificate store -- 
please ensure there are no certificates already configured in " + 
$CertStorePathName)

} 

4. Return to the mmc console window.

5. Refresh certificates and the created certificate under OSIsoft is issued to 
the new PC name.
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Export the Certificate

Complete these steps.

1. From the mmc console window, right-click the certificate that you have 
generated and select All Tasks>Export.

2. From the Certificate Export Wizard, complete these steps.
a. Click Next on the Welcome window.
b. Select Yes, export the private key and click Next.
c. Leave defaults and click Next on the Export file format window.
d. On the Security dialog window, select Group or user names and make 

sure a domain administrator is added to the list.
e. Click Next.
f. On the File to Export dialog window, click Browse and type a name.
g. Select a desired storage location and click Save, and then Next.
h. Review the export settings and click Finish.
i. Click OK on ‘The export was successful’ message window.

3. In the mmc console window, right-click the certificate and
choose Delete.

Import the Certificate on the Primary Server

Complete these steps.

1. Click Programs>Rockwell Software>FactoryTalk Historian 
SE>FactoryTalk Historian SE System>Collective Manager.

2. In the left pane, select the collective.

3. Select Edit and choose Import Certificate.

4. Click OK on the security message window.

5. Navigate to the exported certificate and click Open.

6. Click OK on the ‘Certificate imported successfully’ message window.

Import the Certificate on the Secondary Server

Complete these steps.

1. Copy the new certificate .pfx file from the Primary server to the 
Secondary server.

2. Repeat the steps in Import the Certificate on the Primary Server to put 
the certificate on the Secondary server.
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Reinitialize the Secondary Server

To enable the Secondary server from the collective manager on the Primary 
server, complete these steps.

1. From the Collective Manager, select the Secondary server.

2. Right-click the Secondary server, and select Reinitialize Server.

3. From the Archives window, click Next.

4. Verify the backup location and click Next.

5. From the verify window, click Next.

6. When the sync process completes, click Finish.

At this stage, green check marks appear on both servers in the
Collective Manager.

Create a Default Node Interface

Node interface FTLD1 is automatically created when the Historian server is 
created. This interface must be deleted and two interfaces created on the 
proper servers. 

1. In the FactoryTalk Administrative Console, right-click on FTLD1 and 
choose Delete. 

2. To confirm the deletion, click Yes on the popup window.

3. To create an interface to collect data, right-click the Historian server and 
choose New Data Collection Interface.

You are creating a connector to the correct Historian server.

Use the Historian server 
with these procedures.

ASIH01 (no collective)
ASIH01A (with collective)
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The Data Collection Interface Properties dialog box appears. 

4. On the General tab, select the PASS hosting the interface
(PASS02A in the example) from the pull-down.

5. Click OK.

IMPORTANT You need a host for both node interfaces. For a redundant pair, the 
primary only is referenced.
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Create a Synchronization Path

A common folder is used for files that are used for handshaking and 
redundancy. 

Complete the following steps.

1. In File Explorer, right-click Local Disk (C:) and choose New>Folder.

2. Name the new folder FTHSE_Failover. 

IMPORTANT We recommend that you use a server that is not running LiveData.

Use a PASS server with 
these procedures.

PASS01

Node Interface

Node InterfaceHistorian

Synchronization
Folder

PASS01A

PASS02B

PASS02A

FTD

See page 346 for connecting node interfaces.

ASIH01
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3. Right-click the new folder and choose Properties.

The FTHSE_Failover Properties dialog box appears.

4. From the Sharing tab, click Advanced Sharing.
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5. From the Advanced Sharing dialog box, click Share this folder, and then 
click Permissions.

6. Select ‘Everyone’ and click Add.

7. Click Object Types.

8. Select Computers and click OK.
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9. Type PASS into the text box, and click Check Names.

10. Select a match from the search and click OK.

The example shows a primary and secondary server selected to create a 
folder for a redundant pair.

11. Click OK.
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12. To provide Read/Write access to the folder, select the primary server and 
click all three Allow checkboxes.

13. Click Apply.

14. Select the secondary server and click all three Allow checkboxes.

15. Click OK.
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16. To complete the procedure, click OK and Close.

Proceed to page 346 for procedures on how to configure a data pipeline 
between FactoryTalk data servers and FactoryTalk Historian servers.
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Configure a Node Interface This section describes how to configure FactoryTalk Live Data (FTLD) 
connectors. The FTLD interface is a FactoryTalk Live Data client that enables 
process data to be passed between a FactoryTalk Live Data server (for example, 
FactoryTalk Linx) and a FactoryTalk Historian server. Each instance of the 
FTLD Interface can provide data to a single FactoryTalk Historian SE server 
or collective.

Configure Primary Node Interface Server

This section describes how to connect the Historian server to the PASS server 
with node interfaces.

Configure the Server Connection

Complete the following steps:

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Historian SE>FactoryTalk Historian SE 
System>AboutPI-SDK. 

PASS02A

Use a PASS server
with these procedures.

Synchronization
Folder

FTD
Node 
Interface

Node 
InterfaceHistorian

PASS01A

PASS02A

PASS02B

See page 340 for creating a synchronization folder.
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The PI SDK Utility window appears. 

2. Expand PI SDK and click Connections.

3. Right-click anywhere in the white space and choose Add Server.

The Add PI Server dialog box appears. 

4. Type the Network Path (If you are using a collective, type the primary 
machine name) and click OK. 

5. Click the box next to the new server (ASIH01 in the example).
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If the connection is successful, the connection information appears in 
the same window.

6. If there are servers listed that are not required, right-click the server 
name and choose 'Remove selected server'.

7. When asked if you want to delete the server, click Yes.

8. Close the PI SDK Utility window. 

Creating a PI Buffer Service User

You must create a service user to enable PI buffering service.

1. From the Server Manager, click Tools and choose Active Directory Users 
and Computers.

2. Expand the domain folder (System.PlantPAx.local), right-click 
Managed Service Accounts and choose New>User.

Use a domain controller with 
these procedures.

PADCA
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The New Object - User dialog box appears.

3. Complete the User text boxes.

4. Click Next.

Item Description

First name Type a name for the PI buffering service.
IMPORTANT: The ‘PI ’preface is the name of the 
OSISoft product.

Initials Optional; you can leave blank.

Full name Type the same name for the PI buffering service.

User login name Type the same name for the PI buffering 
service and click the pull-down to select your 
domain folder.

User logon name (pre-Windows 2000) Use the SYSTEM\ default and type the same name 
for the PI buffering service.

IMPORTANT The logon password creates a service user, not a person. The service 
user grants access to system computers for placing data into 
memory (buffer).
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5. Type your password twice, and make sure that there is a check mark in 
the following boxes:
• User cannot change password
• Password never expires (indefinite service for system access)

6. Click Next and then click Finish.

Creating Security Mappings

This procedure associates the service user identity with the Historian mapping 
and trusts.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Historian SE>System Management Tools. 

Use an AppServ-Info server
with these procedures.

ASIH01A
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The PI System Management Tools window appears.

2. Do the following steps:
a. Under Servers, check the server that you want to set the security

settings for.
b. Under System Management Tools, choose Mappings & Trusts.

c. Click Add Mapping icon .
The Add New Mapping dialog box appears in the right pane.

d. Click Browse (ellipsis ‘…’).

The Add New Mapping dialog box appears in the right pane.

3. Select the PIBufferService user that you created earlier.

4. Click OK.
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5. Click Browse, then select a group from the Type pull-down men.

6. Select a desired identity and click OK.

7. Click Create.
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Configuring the Interface

Complete the following steps to configure buffering for the server that
you connected.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Historian SE>Interface Configuration Utility.

The PI Interface Configuration Utility window appears. 

2. From the Tools menu, choose Options.

PASS02A

Use a PASS server
with these procedures.
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3. Click ‘Load interfaces from a selected list of PI Data servers’.

4. Click a server box and then click OK.

5. From the Tools menu, choose Buffering.
354 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure an Application Server Information Server (AppServ-Info) Chapter 10
6. Click Yes, and then ‘Continue with configuration’ to initiate the 
Buffering Manager wizard.

7. Select Buffer and click Next.
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8. Click Change, type the user name and password (that you created 
earlier), and click Next.

 

IMPORTANT Do step 8 and step 9 on the Buffering Manager, if applicable. 
Otherwise, skip to step 10.

IMPORTANT If you miss the Change option on the New Install Wizard (or the 
option does not appear), you must configure the Service logon.
For procedures, see Configure Service Logon on page 361.
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9. Click Next.

10. Click Next again.
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11. Click ‘Exit new installation wizard’.

The following messages appear to complete the buffering configuration. 

12. Click Yes and OK to confirm the PI ICU dependency.
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13. From the Tools menu, choose Buffering and verify that your information 
matches the dialog box shown.

14. Close the Buffering Manager.

IMPORTANT If your Buffering Manager dialog box does not show a server with a 

green check mark , choose File>Add Server and repeat
step 8 and step 9 on pages 356-357.
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15. In the PI Interface Configuration Utility window, from the Tools menu 
choose Options.

The Options dialog box appears. 

16. Check 'Load interfaces from a selected list of PI servers'.

17. Make sure that the server is checked.

18. Click OK.
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Configure Service Logon

The following procedure is applicable only if the Change Option was not 
available on the New Install Wizard dialog box.

1. On the PASS server, right-click Start menu and choose
Computer Management.

2. In the left pane, open Local Users and Groups and right-click Groups 
and choose Administrators.

3. Click Add and type ‘SYSTEM\pibufferservice’.

4. Click Check Names.

5. Click OK.

6. To assign the logon service account, from the Start menu, click Programs 
and choose Administrative Tools>Services.

7. Right-click PIBuffer Subsystem and choose Properties.

8. On the Log On tab, click Browse.

9. Click Locations, choose ‘Entire Directory’, and click OK.

10. Type ‘SYSTEM\pibufferservice’ and click Check Names.

11. Click OK.
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Configure Secondary Node Interface Server

In this section, you connect to the PASS02A servers and configure buffering 
for the server.

Configure Server Connection

Repeat step 1 through step 8 on pages 346…348 for the PASS02B server.

Configure the Interface

Repeat step 1 through step 18 on pages 353…360 for the PASS02B server

Configure FactoryTalk Live 
Data Connectors

UniInt (Universal Interface) provides generic functions required by most 
interfaces, such as establishing a connection to the Historian Server node and 
monitoring the Historian Point Database for changes.

To minimize data loss during a single point of failure within a system, UniInt 
provides two failover schemas: (1) synchronization through the data source 
(Phase 1) and (2) synchronization through a shared file (Phase 2). 

Phase 1 UniInt Failover uses the data source itself to synchronize failover 
operations and provides a hot failover, no data loss solution when a single point 
of failure occurs. 

Phase 2 UniInt Failover uses a shared file to synchronize failover operations 
and provides for hot, warm, or cold failover. The Phase 2 hot failover 
configuration provides a no data loss solution for a single point of failure 
similar to Phase 1. 

The UniInt failover scheme requires the data source be able to communicate 
and service data to two interfaces simultaneously. Additionally, the failover 
configuration requires that the interface supports outputs. A redundant 
solution requires two separate interface nodes communicating with the data 
source.

In a hot failover configuration, the interface copy that is in a backup role
collects and queues data in parallel to the interface that is in the primary role.
The interface in the backup role does not send the data that is collected to the 
Historian server. However, if a failover occurs, the interface immediately sends 
its data to the Historian server. 

PASS02B

Use a PASS server
with these procedures.

IMPORTANT In this section, only Phase 2 UniInt Failover is addressed.

Use PASS servers
with these procedures.

PASS02BPASS02A
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Configure a FactoryTalk Live Data Primary Connector

The FactoryTalk Live Data 1 (FTLDInt1) is in the primary server (PASS02A 
in the example). 

Complete the following steps.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Historian SE>Interface Configuration Utility.

2. In the PI Interface Configuration Utility window, choose 
'FTLDint1 (FTLDInt1)->ASIH01' from the Interface pull-down list. 

3. If the Interface ID is not already ‘1’, change it to ‘1’.

4. Click Service, and then Yes on the popup window.

Use a PASS Server with 
these procedures.

PASS02A
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5. Select Failover from the list on the left.

6. Check Enable UniInt Failover.

7. Click 'Phase 2'. 

8. From the UFO Type pull-down list, choose HOT.

9. Click Browse to search for the Synchronization File path for the 
secondary instance.
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The 'Select UFO synchronization file' dialog box appears. 

10. Navigate to the Network>pass01>FTHSE_Failover directory (that was 
created in the previous section).

11. Click Open. 

The 'Select UFO synchronization file' dialog box closes.

12. Right-click in the tag area and choose 'Create UFO_State Digital Set on 
Server ASIH01'. 

13. When you receive the Successfully created Digital Set 'UFO_State' on 
server ASIH01 message, click OK.

14. Right-click in the tag area and choose 'Create all points (UFO Phase 2'). 
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15. When the status for FTLDInt1_UFO2_ActionID tags changes to 
'Created', click Apply.

The 'UniInt Failover’ configuration is not complete until the 'Other' 
interface is selected' message appears.

16. Click OK.

Another popup message appears that ‘changes made to the interface 
settings will not take effect until the interface service is stopped and 
started’.

17. Click OK.

Configure a FactoryTalk Live Data Secondary Connector

In this section you configure FactoryTalk Live Data Secondary connector.

Complete the following steps.

1. In the PI Interface Configuration Utility window, click the folder 
symbol (Create a New Interface instance from a .BAT file). 

The Open Interface Configuration File dialog box appears.

Use a PASS server with 
these procedures.

PASS02B
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2. Select LDInterface and click Open. 

3. Select the 'FTLDInt_FTLD.bat.bak' file and click Open. 

The Select Host PI Server dialog box appears.
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4. Make certain that the appropriate server is selected for each
pull-down menu.

5. Click OK.

6. Select Service from the list on the left of the PI Interface Configuration 
Utility - FTLDInt1 window. 

7. Type 'FTLD1' for the Display name and click Create.

8. Select General from the list on the left. 

9. If the Interface ID is not already '1', change it to '1'.
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10. Select Failover from the list on the left. 

11. Check 'Enable UniInt Failover'. 

12. Check 'Phase 2'. 

13. From the UFO Type pull-down list, choose HOT.

14. Click Browse to search for the UFO synchronization File Path.

15. Navigate to the Network>pass01>FTHSE_Failover directory
and click Open. 

The Select UFO synchronization file dialog box closes.
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16. Set the Failover IDs as shown in the following image. 

17. Click Browse to search for the secondary instance.

18. Select FTLDInt1 (under PASS02A in the example) and click OK.

A synchronize UFO settings popup window appears.

19. Click Yes to synchronize the UFO settings for this instance.
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The failover and synchronization information appears in the
respective fields.

Return to the primary server for the following steps.

1. In the PI Interface Configuration Utility window, click Apply.

2. In the PI Interface Configuration Utility window, click Browse. 

Use a PASS server with 
these procedures.

PASS02A
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The Browse for other FTLDInt IniInt Failover Interface dialog 
box appears.

3. Select the 'FTLDInt1 (PS=FTLD) (ID=1) (Phase=2)' line under 
PASS02B and click OK. 

4. Click the Programs  symbol and choose Administration 
Tools>Service.

5. Right-click FTLD1 and choose Properties
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6. From the Log On tab, click “local System account’ and click OK.

7. In the PI Interface Configuration Utility window, click Apply and then 
Play  to start the primary service (if not already running). 

8. If asked 'Would you like ICU to start this service for you?', click Yes.
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Return to the secondary server for the following steps.

1. Select the Interface that is shown in the following image and click Play 
 to start the secondary service. 

2. If asked 'Would you like ICU to start this service for you?', click Yes.

Confirm Unit Failover Diagnostics

1. In the Windows desktop, click the Programs  symbol and choose 
Rockwell Software>FactoryTalk Historian SE>System 
Management Tools. 

The PI System Management Tools (Administrator) window appears.

Use a PASS server with 
these procedures.

PASS02B

Use an AppServ-Info server
with these procedures.

ASIH01A
374 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure an Application Server Information Server (AppServ-Info) Chapter 10
2. Click Data>Current Values. 

3. Click the Tag Search  icon.

The Tag Search window appears.

4. Type *FTLD* in the Tag Mask and click Search. 

All *FTLD* tags are displayed.
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5. Click Select All and OK. 

The Tag Search window closes and all *FTLD* tags are displayed in the 
Current Values - PI System Management Tools (Administrator) window 
along with their values. 

6. If desired, click Play  to see the online status. 

IMPORTANT We recommend that you use PerfMon for all computers and proceed 
to Configure a Performance Monitor Interface on page 377.
If your system does not require this option, proceed to page 400
to configure FactoryTalk Historian connectivity.
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Configure a Performance 
Monitor Interface

The Windows Performance Monitor (PerfMon) interface provides continuous 
monitoring of historical data to evaluate the performance of a computer. The 
‘PI’ preface is the name of the OSISoft product.

Create PIPerfMon System User

You must create a user that is actually a service to have privileges within other 
computers on your system. This ‘user’ permits the system to access computers 
to obtain data for a performance capture.

Complete these steps.

1. From the Server Manager, click Tools and choose Active Directory Users 
and Computers.

The Active Directory Users and Computers dialog box appears.

2. Expand the domain folder (System.PlantPAx.local).

3. Right-click Managed Service Accounts and choose New>User.

Use a Domain controller 
with these procedures.

PADCA
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The New Object - User dialog box appears.

4. Complete the User text boxes.

5. Click Next.

Item Description

First name Type a name for the PI PerfMon service.
IMPORTANT: The ‘PI’ preface is the name of the 
OSISoft product.

Initials Optional; you can leave blank.

Full name Type the same name for the PI PerfMon service.

User login name Type the same name for the PI PerfMon service and 
click the pull-down to select your domain folder.

User logon name (pre-Windows 2000) Use the SYSTEM\ default and type the same name 
for the PI PerfMon service.

IMPORTANT The logon password creates a service user, not a person. The service 
user grants access to system computers for placing data into 
memory (buffer).
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6. Type your password twice, and make sure that there is a check mark in 
the following boxes:
• User cannot change password
• Password never expires (indefinite service for system access)

7. Click Next and then click Finish.

Configure the PIPerfMon Interface

You must enter an interface name and a points value. The points are the limit 
the interface uses based on the number of computers in your system. Each 
variable – CPU usage, RAM, disk space – is one point. You can use the number 
of points up to 20% of your FactoryTalk Historian SE software license.

Assign the License

Complete these steps to assign the interface license.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Administration Console.

2. Select Network and click OK.

Use an AppServ-Info server 
that has the interface with 
these procedures.

ASIH01
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3. Expand the System>Connections>Historical Data folders and
right-click Production Historian.

4. Select Properties.

5. On the Point Sources tab, type an interface name (such as PerfMon) and 
a value for the points limit.

The value is the expected number of performance points in the system.

6. Click OK.

7. Close the FactoryTalk Administration Console.

IMPORTANT Be patient because this dialog box could take a few minutes
to appear.
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Configure the Interface Utility

Complete these steps to configure the PIPerfMon interface.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk Historian SE>Interface Configuration Utility.

The Interface Configuration Utility dialog box appears.

2. Choose New Windows Interface Instance from BAT file from the 
Interface menu.

3. Select the PiPerMon.bat_new file under FactoryTalk Historian/PIPC/
Interfaces/PIPerfMon.
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4. Click Open.

5. Select the FactoryTalk Historian server and click OK.

6. Type a Point Source name and an Interface ID number.

7. Click Apply.

IMPORTANT The Point Source name must match the interface name that you 
typed in the Historian Production dialog box on page 380.
The Interface ID number must be unique in the system.
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8. Click OK to restart the interface service.

Import PIPerfMon Digital State

Complete these steps to import digital sets and states for the Performance 
Monitor service. Digital states create a relationship between values and text 
state names. 

For example, 0 = Good, confirmed good quality; 1 = Good, assumed
good quality.

1. Open the Historian folder by clicking the Program button  and
choosing Rockwell Software>FactoryTalk Historian SE>System 
Management Tools.

The Digital States - PI System Management Tools dialog box appears.

2. Under Servers, select the server that is being configured for the 
PIPerfMon interface.

Use these procedures with an 
AppServ-Info server or an 
Engineering Workstation that has 
FactoryTalk Historian installed.

ASIH01 EWS
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3. Under Points, open Digital States and click the Import button.

4. From the Import Digital Set(s) dialog box, click the folder icon.

5. Navigate to C:\Program Files (x86)\Rockwell Software\FactoryTalk 
Historian\PIPC\Interfaces\PIPerfMon

6. Select the PI_PIperfmon_DS.csv and click Open.
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7. Click Create Set(s).

8. Click Close.
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Create PIPerfMon Interface Health Points

Complete these steps to associate the PerfMon interface with the health tags 
that monitor a device heartbeat for diagnostics. The heartbeat count 
determines if the system is working. If there is a stoppage, you can analyze what 
prompted the fault or device error.

1. Click the Program button  and choose Rockwell 
Software>FactoryTalk Historian SE>Interface Configuration Utility.

2. From the Interface pull-down, select PIPerfMon.

3. From Health Points on the left, right-click
PIPerfMon.DeviceStatus and choose Create.

Use an AppServ-Info server 
that has the interface with 
these procedures.

ASIH01
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4. Right-click PIPerfMon.Heartbeat and choose Create.

5. Under Service, choose pibufss and click the left arrow to move to the 
Dependencies box.
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6. Type the same user name and password that you initially created for the 
service. See page 378.

7. Click Apply.
388 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Configure an Application Server Information Server (AppServ-Info) Chapter 10
8. Open Services, right-click PI Buffer Subsystem, and select ‘Automatic’
as the Startup type.

9. Click OK.

10. To restart the interface service, click OK.
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Monitor PIPerfMon Interface

Complete these steps to verify that the interface has a good working status.

1. Click the Program button  and choosing Rockwell 
Software>FactoryTalk Historian SE>System Management Tools.

The PI System Management Tools dialog box appears.

2. In left, top pane, search for the appropriate server with the interface.

3. In the lower, left pane, expand the Data folder and click Current Values.

After you search for tags you need, the Value category displays the
health state of the interface and the number of seconds between the 
heartbeat counts.

ASIH01 EWS

Use these procedures with an 
AppServ-Info server or an 
Engineering Workstation that has 
FactoryTalk Historian installed.
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Enable Performance Monitor This section describes how to enable PIPerfMon to collect data from system 
computers.

Adding PIPerfMon User

Complete these steps to create a performance monitor user.

1. Click the Windows  symbol.

2. Click Control Panel and choose User Accounts.

Perform this procedure in all system computers.

All servers ... ... and workstations
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3. Click Manage User Accounts and click Add.

4. Type the same user name and Domain that you did to grant system 
access for the PerfMon service. See page 388.

5. Click Next.
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6. Click Other and choose Performance Monitor Users.

7. Click Next and Finish.
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Adding PIPerfMon Firewall Rule

Complete these steps to configure port settings to allow external computer 
connections to extract system data.

1. Click the Windows  symbol.

2. Click Control Panel and choose Windows Firewall.

3. Click Advanced Settings.

Perform this procedure in all system computers.

All servers ... ... and workstations
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4. Expand the Windows Firewall folder, right-click Inbound Rules, and 
choose New Rule.

5. Click Port and then click Next.
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6. For TCP, click Specific local ports and type 135, 445.

.

7. Click Next.

IMPORTANT The two port numbers listed in step 6 must be configured to allow 
system data exchanges with external computers.
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8. Click Next for the Action step.

Do not change any settings.

9. Click Next for the Profile step.

Do not change any settings.
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10. Type a name and click Finish.
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Enabling PIPerfMon Counter Service

Complete these steps to enable the PIPerfMon service to start collecting 
information from system computers.

1. From the Start menu, click Programs and choose Administrative 
Tools>Services.

2. Right-click Performance Counter DLL Host and choose Properties.

3. Select Automatic as the Startup type and click OK.

Perform this procedure in all system computers.

... and workstationsAll servers ...
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Configure FactoryTalk 
Historian Connectivity

This section describes how to connect the system elements with the 
Historian server.

Complete the following steps.

1. On the Windows desktop, click the Programs  symbol and choose 
Rockwell Software>FactoryTalk Historian SE>FactoryTalk Historian 
SE System>AboutPI-SDK.

The PI SDK Utility window appears. 

2. Click the ‘+’ to expand the PI SDK folder and click Connections.

3. Right-click anywhere in the white space and choose Add Server. 

Use all workstations
with these procedures.

All EWS and OWS
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The Add PI Server dialog box appears. 

4. Type the Network Path and click OK.

5. Click the box next to the new server. 

If the connection is successful, the connection information appears in 
the same window.

6. If there are other servers listed that are not required, right-click on the 
server name and choose 'Remove selected server'. 

7. When asked if you want to delete the server, click Yes.

8. Close the PI SDK Utility window.

TIP If you are using a collective, type the primary server.
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View PI Builder Excel Add-in PI Builder lets you import and export PI points and Asset Framework objects 
to and from Microsoft Excel Add-in spreadsheet.

To view the information in an Excel spreadsheet, complete these steps.

1. Open your version of Microsoft Excel.

2. Click the PI Builder tab.

You can select the desired server to generate a report in the top, left 
corner of the spreadsheet.

IMPORTANT Microsoft Excel 32-bit software must be installed for these procedures.
This section uses Microsoft Excel 2013. Your version could be different.

Use an Engineering Workstation 
with these procedures.

EWS01

IMPORTANT PI Builder installation instructions are documented in the 
Virtualization User Manual, publication 9528-UM001.
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Configure FactoryTalk 
VantagePoint Historian Tags

This section shows how to import FactoryTalk Historian data tags. Data from 
multiple Historian SE servers can be brought together into a single decision 
support system by using VantagePoint as the information reporting software. 

Complete the following steps.

1. On the Windows desktop, click the Programs  symbol and choose 
Rockwell Software>FactoryTalk VantagePoint>Manager. 

The VantagePoint Manager window appears. 

2. In the directory tree under Sources, right-click FactoryTalk and choose 
New>Item. 

IMPORTANT Before proceeding with this section, make sure that FactoryTalk Historian is 
installed and configured.

Use the Reporting Application 
server with these procedures.

ASIV01
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The New FactoryTalk Connector - Connector Information dialog
box appears. 

3. Type the VantagePoint user password and click Next.

4. Click 'Yes, please' and Finish.

The FactoryTalk Import - Import Choices dialog box appears. 

5. Click 'I would like to import FactoryTalk Historian tags', and then 
click Next. 
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The Historian Import dialog box appears. 

6. Check the Historian that you want to use and click Next.

7. If you are not using an ME connector, click Finish.

8. When the 'Import successfully completed' dialog box appears, click OK.
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9. To confirm the import, click 
System>Sources>FactoryTalk>pass01>Historians><Production 
Historian> and look for 'Tags', where:
– Server = pass01
– Your Historian = Production Historian in the example.

10. To synchronize the Historian, right-click 
System>Sources>FactoryTalk><server>>Historians> 
<your Historian> and choose Synchronize. 

Synchronizing lets you update the VantagePoint references.

You are finished configuring the FactoryTalk VantagePoint Historian 
tags and synchronizing the Historian.

IMPORTANT Adding new Historian points in the system requires a 
synchronization action.
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Configure Asset Management (AppServ-Asset)

The Asset Management server (AppServ-Asset) provides a centralized tool to 
secure, manage, and track asset-related information. The pool of information 
provides analysis of system resources, including source controls, audits, and 
change notifications. 

This section describes how to configure an audit log. The log monitors and 
records user interactions with FactoryTalk® software products. For example, if
an operator changes a setpoint in a controller, the change is logged for
future reference.

FactoryTalk AssetCentre software includes Device Type Manager interfaces
and disaster recovery back-up files. For procedures on these tools, see
Chapter 8 in the PlantPAx® DCS Application Configuration User Manual,
publication PROCES-UM003.

Considerations Consider the following suggestions before starting this chapter:
• For more information on the PanelView™ audit log, refer to 

Knowledgebase Answer ID 58977, Using FactoryTalk AssetCentre
to receive audits from a PanelView Plus,
at http://www.rockwellautomation.custhelp.com.

• We strongly recommend additional licensing for disaster recovery that 
automatically backs up supported devices.
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Figure 19 shows the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 19 - AppServ-Asset Workflow 

Start

Configure Diagnostic Settings

See page 409

End

• View Audit Log
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Configure Diagnostic 
Settings

The Audit Log monitors FactoryTalk-enabled software products and logs user 
actions. Complete these steps to configure the Audit Log so that it can be 
viewed in FactoryTalk AssetCentre. 

1. Click the Programs  symbol and choose Rockwell 
Software®>FactoryTalk Administration Console.

The Select FactoryTalk Directory dialog box appears. 

2. Select Network and click OK.

The FactoryTalk Administration Console window appears. 

3. Right-click Tools>FactoryTalk Diagnostics and choose Setup.

IMPORTANT All servers and workstations must be configured by using FactoryTalk 
Administration Console or FactoryTalk View Studio. The examples in this 
section use the FactoryTalk Administration Console.

Use all servers and workstations
with these procedures.
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The Diagnostics Configuration window appears. 

4. In the Message Routing section, click FT View Diagnostics List.

5. In the 'Message categories' section, configure the desired level
of diagnostics.

6. In the Message Routing section, click Local Log.

Recommended Settings

Message Categories Notes

Operator If Info is checked, screen access is stored as an Event. If Secured also is 
checked, the information is logged into the Event tag of FactoryTalk 
AssetCentre software.
IMPORTANT: This setting does not show which computer accesses the 
system; only on FactoryTalk Diagnostics Viewer.

Engineer If Audit is checked, Alarm acknowledgments are audited and displayed 
regardless of the destination. HMI display changes (on FactoryTalk View 
Studio software) also are logged.

Developer If Audit is checked, HMI tag value changes are audited regardless of
the destination.

Secure If Audit is checked, any changes on Studio 5000® are audited under the 
Secured destination.

TIP Click Help for more information on the message categories.

Recommended Settings
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7. Repeat step 5.

8. Click Apply and then click OK.

The Diagnostics Configuration window closes. 

View Audit Log

A log of activity lets you view the messages. Complete these steps.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk AssetCentre Client>AssetCentre Client.
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2. Click Logs and then Audit Log.

3. Click ‘X’ to Close.
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Access the Attachments

The Microsoft Excel spreadsheet and text files that are attached to this PDF 
file contain security and switch information to customize application 
requirements. Each security tab in the Excel spreadsheet has specific ‘Allow’ 
and ‘Deny’ security permissions.

To use the attachments, click the Attachments link (paper clip) and
double-click the desired file.

See How to Use Attachments on page 414.

Open Content

As a precaution when you open programs or files, select one of the choices
and click OK.
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How to Use Attachments

The Excel spreadsheet contains several tabs to access security permissions for 
policy groups. Click a desired tab and use the suggested security along with the 
procedures in Define FactoryTalk System Policies on page 193.

The four text files contain switch configuration information. Double-click
the .txt file to open the respective file in a text editor, such as Notepad. Copy 
and paste the switch configuration data into the CLI interface in the 
PuTTy software.

You can use these files to directly configure your switches according to this 
manual's directions by downloading the file contents into each of your 
switches. If you use these files to configure your switch, we strongly 
recommend that you verify all switch settings by logging into the switches and 
viewing/verifying switch configuration by using the Device Manager.

See Using a Terminal Emulator (PuTTY) on page 41 for procedures.
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Define a Workgroup and DeskLock Utility

If you don’t use a domain, you must configure a workgroup to make sure that 
the name resolution is correct for the network. Workgroups are supported for 
systems with 10 or fewer workstations and servers.

This appendix also includes procedures for how to enable an optional
DeskLock Utility.

Complete the following steps.

1. In Windows Notepad, open the file 
C:\Windows\System32\Drivers\Etc\host and enter the IP addresses and 
machine names for the computers in the workgroup.

Use a tab between each IP address and machine name.

2. Copy the revised host file to all computers in the system.

Use all system computers 
with these procedures.
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3. Configure each server network adapter with the correct IP address.

4. Use a ping command to test name resolution, for example, ping PASS01.

5. Click ‘X’ to close.
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Enable the Windows 
DeskLock Utility (optional)

The FactoryTalk® View DeskLock utility, which is available for any workstation
computer, provides control options for smaller environments that do not use 
domain management.

DeskLock is installed with FactoryTalk View software.

Complete these steps.

1. Click the Programs symbol and choose Rockwell 
Software®>FactoryTalk View>Tools>DeskLock.

2.

3. Click Set Up DeskLock.

4. Login and click the Desktop tab.

5. Select ‘Replace existing desktop with DeskLock’ and click OK.

Use all workstations 
with these procedures.

EWS, OWS
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 417



Appendix B Define a Workgroup and DeskLock Utility
6. In the popup window, type the name of the application option in the 
Name text box. 

For example, type ‘Client’ if FactoryTalk View Client is to be
an application.

You can enable up to 10 applications in the DeskLock.

7. Click the Password tab to configure local password management.

8. Click the Behavior tab to configure Hot Key settings and the 
Ctrl+Alt+Del options.
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9. To open the DeskLock under the Local Computer Policy, click 
Microsoft Management Console.

10. To enable DeskLock options and settings, restart your computer.
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Notes:
420 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Appendix C

Firewall Configurations

Common Ports Table 29 shows the most common ports that need to be considered during the 
firewall configuration.

Rockwell Automation
TCP/UDP Ports

Table 30 shows the TCP/UDP ports for Rockwell Automation® firmware and 
software products.

For periodic updates, see the Knowledgebase Answer ID 29402
at http://www.rockwellautomation.custhelp.com.

Table 29 - Common Firewall Port Descriptions

Port Type Usage

25 TCP SMTP mail

80 TCP Standard WWW port

123 UDP Network Time Protocol

135 TCP Remote process calls

137 UDP File and printer sharing

138 UDP

139 TCP

445 TCP Use in the Collective configuration and file and print sharing

1433 TCP Communication to SQL server

1434 UDP Browsing for SQL server

21060 UDP Rockwell Automation® trace diagnostics

21061 UDP

Table 30 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments

23 TCP Telnet Trusted®
AADvance before release 1.3

Diagnostic command-line interface
(see also 55555)

25 TCP SMTP 1769-L35E, 1769-L32E,1756-ENBT,
1756-EN2T,1756-EWEB,1768-ENBT,
1768-EWEB,1788-ENBT,1763-L16x
1766-L32x,FactoryTalk® AssetCentre, 
FactoryTalk® Transaction Manager, RSSQL

Outbound email only

67…68 UDP DHCP/BOOTP 1756-ENET,1756-ENBT,1756-EWEB,
1756-EN2T,1794-AENT,1734-AENT,
1769-L35E, 1769- L32E,1788-ENBT,
1761-NET-ENI,1785-LXXE,1785-ENET
,1791ES,1763-L16x,1766-L32x, PowerFlex® 
Drives, PowerMonitor™ 3000, PanelView™

Client only
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69 UDP TFTP 5820-El For binary download, used in conjunction
with BOOTP

80 TCP HTTP 1756-ENET,1756-ENBT,1756-EWEB,
1794-AENT,1734-AENT,1769-L35E,
1769-L32E,1788-ENBT,1761-NET- ENI
1785-LXXE,1785-ENET,1747-L55x,
1763-L16x,1766-L32x, PowerFlex Drives, 
PowerMonitor 3000, PanelView, RSBizWare™, 
RSView®32, FactoryTalk View SE, FactoryTalk® 
VantagePoint®, FactoryTalk ViewPoint

FactoryTalk ViewPoint and VantagePoint EMI 
server can use any other custom assigned port

123 UDP NTP PowerMonitor 3000, AADvance Network time protocol

135 TCP RPC/Endpoint Mapper FactoryTalk, RSMACC™ DCOM endpoint mapper

161 UDP SNMP 1756-ENET,1756-ENBT,1794-AENT,
1734-AENT, 1769-L35E, 1769-L32E,
1788-ENBT, 1761-NET-ENI, 1785- LXXE,
1785-ENET,1747-L55x,1766- L32x,
5820-EI, PowerFlex Drives, PowerMonitor 3000, 
PanelView

300…400 UDP Proprietary PowerMonitor 3000 Master/slave configuration

400…402 TCP RPC FactoryTalk Transaction Manager, RSSQL Transaction manager, compression server,
and configuration server

443 TCP HTTPS FactoryTalk ViewPoint When using web server with secure certificate

502 TCP ModbusTCP AADvance, Trusted® Master or slave (AADvance),
Slave only (Trusted)

1001…1009 UDP Proprietary 1426 PowerMonitor 5000 Waveform synchronized broadcast

Dynamic 
(1024…65535+)

TCP DCOM FactoryTalk DCOM dynamic ports

1089 TCP/UDP ff-annunc 1788-EN2FFR FOUNDATION Fieldbus

1090 ff-fmx

1091 ff-sm

1132 TCP SNCP AADvance Safety Network Control Protocol, used by OPC, 
workbench debugger, and binding networks

1330 TCP rnaprpc FactoryTalk Object RPC

1331 TCP rnaserv FactoryTalk Service control

1332 TCP rnaserveping FactoryTalk Server health

1433 TCP N/A FactoryTalk® AssetCentre (server),
FactoryTalk VantagePoint RSMACC

SQL server communication (default port)

1434 UDP N/A FactoryTalk AssetCentre (server),
FactoryTalk VantagePoint

Recommended static destination port for MSSQL 
to minimize the number of ports open on a 
firewall
See the Knowledgebase Answer ID 287932 at 
http://www.rockwellautomation.custhelp.com

1947 TCP/UDP N/A SafeNet Sentinel Local License Manager Windows Service installed by Sentinel USB HASP 
driver. This service is not required for USB dongle 
to function. 
See the Knowledgebase Answer ID 570831 at 
http://www.rockwellautomation.custhelp.com

2000 TCP Modbus RTU AADvance (Slave only), Trusted (Master or slave, 
used for OPC and SOE)

RTU packaged in serial stream. Other ports can
be assigned

Table 30 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
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2010…2011 UDP Discover tool AADvance Used to configure systems. The tool sends 
broadcast to 2010 and systems reply to port 
2011

2222 UDP EtherNet/IP 1756-ENBT,1794-AENT,1734-AENT,
1769-L35E, 1769-L32E,1788-ENBT

I/O communication that is used by products that 
only support I/O over EtherNet/IP

2222 TCP CSP 1785-Lxxe,1785-ENET,1771-DMC(x),
1747-L55x,5820-EI, PowerMonitor II,
RSLinx® Classic, INTERCHANGE™

This is the source port for connections

3060 TCP rnadirft FactoryTalk Directory server file transfer

3622 TCP/UDP ff-Ir-port 1788-EN2FFR FOUNDATION Fieldbus

4000 UDP Peer-to-peer Trusted Original simplex protocol

4120 TCP RPC RSBizWare Production server

4121 Server manager

4122 PlantMetrics™ server

4123 Task manager

4124 Scheduler server

4125 Scheduler CTP server

4446 TCP TCP/IP FactoryTalk Diagnostics (CPR SR3) See the Knowledgebase Answer ID 68260 at 
http://www.rockwellautomation.custhelp.com

5000 UDP Peer-to-peer Trusted, AADvance Enhanced (new) protocol

5241 TCP TCP/IP FactoryTalk Diagnostics (CPR9 SR4 and greater) See the Knowledgebase Answer ID 68260 at 
http://www.rockwellautomation.custhelp.com

5450 TCP FactoryTalk Historian Site Edition PI network manager

5454 Analysis Framework v1.x

5455

5456 ACE 2 scheduler

5457 Asset Framework server

5458 PI notifications

5459 Asset Framework to OLEDB Enterprise

6000 TCP Workbench Trusted Online debugger

6543 TCP rnaalarming FactoryTalk Alarming server

7002…7004 TCP FactoryTalk AssetCentre (default) FactoryTalk AssetCentre services

7600 TCP FactoryTalk Event multiplexor

7700 Event server

7710 Directory server

7720 TCP RSView SE,
FactoryTalk View SE

HMI server

7721 Server Framework

7722 HMI activation

7723 Historical Data Log reader

8080 TCP HTTP RSBizWare Production server, reports

8081 Server manager

8083 TCP HTTP CTP Server

Table 30 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
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Appendix C Firewall Configurations
10001…10006 TCP Serial data AADvance Transparent communication interface, where an 
Ethernet host can talk through AADvance to a 
serial port

27000…27009 TCP TCP/IP FactoryTalk® Activation Server,
FactoryTalk Activation Manager

Foir more application required to run 
FLEXSVR,exe. an d LMGRD,exe, see the 
Knowledgebase Answer ID 35717 and 184922 at 
http://www.rockwellautomation.custhelp.com

44818 TCP/UDP EtherNet/IP 1756-ENET,1756-ENBT,1756-EWEB,
1794-AENT,1734-AENT,1769-L35E,
1769-L32E,1788-ENBT,1761-NET- ENI,
1785-LXXE,1785-ENET,1747- L55x,
1763-L16x,1766-L32x, PowerMonitor3000, 
PanelView, RSLinx Classic, FactoryTalk Linx, 
INTERCHANGE (rsicd)

Messaging, data transfer, upload/download, 
peer messaging, and so forth; used mainly by 
RSLinx

49281 TCP TCP/IP FactoryTalk Live Data,
FactoryTalk View SE HMI tag server

HMI tag server

55555 TCP Telnet AADvance from release 1.3 Diagnostic command-line interface

60093 TCP TCP/IP FactoryTalk Diagnostics (CPR9 SR2 and earlier) See the Knowledgebase Answer ID 68260 at 
http://www.rockwellautomation.custhelp.com

65207 TCP TCP/IP FactoryTalk VantagePoint Incuity® server advertiser

Table 30 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
424 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019

https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/


Index

A
A and B

LAN 63
access

level
define for group 160

software restriction 165
activation

FactoryTalk 175
manager 175

adapter
local communication 210
network configuration 210

additional resources 13
aggregation

port link 38
alarm and event

database 281
enable redundancy 279
server creation 254

AppServ
Info Historian 313

area
import active directory 189

assets
central analysis 407
central analysis tracking 407
server configuration 409
workflow 408

assign
users to groups 125

audit 196
view audit 411

authority
identifier 220

C
canvas

Logix 5000 Architect 206
central directory

FactoryTalk 169
child domain controller

configuration 86
CIP VLAN

enable 31
code

restrictions 224, 225
communication

restriction 223
restrictions 220

components
FactoryTalk architecture 167

computers
DHCP server 117
DNS server 116

configuration
asset management 407
child domain controller 86
code restrictions 224, 225
communication restriction 223
communication restrictions 220
controller security 203
data restrictions 223, 224
DHCP server 99, 102
Excel add-in 402
FactoryTalk components 167
FactoryTalk groups 185
FactoryTalk security 183
FactoryTalk users 185
failover 110
GPS time sync 236
group policies 131
Historian server 313
HMI server 247
initial switch setting 20
IP address 86
layer 2 switch 55
live data connectors 362
network overview 15
node interfaces 346
NTP server 133
PanelView Plus 293
parent domain 79
PASS 243
primary node interface server 346
reporting server 403
secondary node interface server 362
smartports 47
switch express setup 21
system servers 77
time sync 231
users and groups 118
workgroup 415

connectivity
Historian server 362, 400

connectors
live data connctors

configuration 362
control network

overview 45
controller

child domain 86
directory name 219
enable security 217
modify properties 207
PTP time sync 241
redundant switches 73
ring switches 59
security 199, 203
security workflow 204
switches 54

conventions
manual 10

copy
primary HMI folder 260
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 425



Index
create 41
alarm and event server 254
data server 250
routing and HSRP 41
VLAN 29

D
data

restrictions 223, 224
server

enable redundancy 266
server shortcut 250

database
alarm and event 281

default
domain controller policy 133
domain policy (NTP) 143
terminal server 193

description 47
ports 47
SW007 and SW008 55, 57, 60, 62, 65, 69

desklock
Windows utility 417

DHCP
enable scope 104
server

computers 117
domain controller 99

server configuration 102
supervisory scope 107

directory
areas 189
FactoryTalk 169

disaster recovery
software 407

DNS server
computers 116

document
conventions 10
purpose 9

domain
controller

default policy 133
DHCP 99
enforce policy 140
users and groups 118

join 113
NTP policy default 143
policy enforcment 158

drive
USB protection 161, 163

E
enable

CIP VLAN 31
controller security 217
DHCP scope 104
DHCP supervisory scope 107
PTP 35
Rapid PVST+ 33
switch routing 37

etherchannel
port link aggregation 38

Ethernet
bridges PTP 239

Excel
add-in configuration 402

express setup
switch 21

external
security 183

F
FactoryTalk

activation 175
directory

configuration 167
controller name 219

ME configure security 300
patches 177
product security 199
same log on 194
SE security 284, 300
security 183
workflow 168

failover
configuration 110

firewall
Windows 171

FTD
configuration 167, 169
controller name 219
network directory 172
PASS 243

G
gateway

VLAN routing 43
GPS

time sync 236
time sync example 232

group
add to group membership 303
define access level 160
membership

add groups 303
policy

management 131
workflow 132

security levles 198
user assignment 125

H
Historian

configuration 313
connectivity 362, 400
create synchronization path 340
workflow 314
426 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Index
HMI
security 284
server

configuration 247
enable redundancy 257
primary 247

hot standy routing
protocol 41

hybrid group
security 183

I
I/O

network star 57
switches 55

I/O network
switch configuration 52

identifier
authority 220

interface
delete node default 338

internal
security 183
users and groups 191

IP address
check setting 20
configuration 86
VLAN 18

J
join

domain 113

L
LAN

A and B 63
layer 2

switch 29, 31, 33, 35, 47, 54
switch configuration 55
switches 21

layer 3
switch 29, 31, 33, 35, 47
switches 21

local directory 167
log

view audit 411
log on

FactoryTalk 194
Logix 5000 Architect

canvas 206
lookup

FactoryTalk directory 169

M
management

group policy 131

manager
activation 175

manual
conventions 10

MCC
star switches 56
switch 62
switches 72

modify
controller property 207

N
naming

controller directory 219
conventions 10

network
adapter 210
directory 167
directory definition 172
I/O 57
I/O switch configuration 52
overview 15

node interface
configuration 346
delete default 338
primary server configuration 346
secondary server configuration 362

NTP
default domain policy 143
server configuration 133
time sync example 231

O
overview

configuration network 15
control network 45

P
PanelView

configure time sync 306
download runtime application 309
Plus

configuration 293
parent domain

configuration 79
PASS

configuration 243
configure HMI server 247
FTD 243
workflow 244

patches
FactoryTalk 177
PCDC 177

PCDC
patches 177

PlantPAx
infrastructure

workflow 19, 46
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 427



Index
policy
domain controller default 133
enforce domain 158
enforce domain controller 140
FactoryTalk security 199
PlantPAx users object 160
security 197

port 47
descriptions 51
link aggregation (etherchannel) 38

ports
I/O network 57

Precision Time Protocol (PTP) 35
primary

copy folder to secondary 260
HMI server 247

product
FactoryTalk policies 199

property
controller modification 207

protection
USB drive 161, 163

protocol
hot standy routing 41

PRP
I/O switches 71
reboxes 68

PTP
controllers 241
enable 35
Ethernet bridges 239

purpose
document 9

R
Rapid PVST+

enable 33
redbox

controller 64
PRP distribution 68

redundancy
data server 266
enable on alarm and event server 279
HMI server 257

redundant
controller 73
star switches 63

redundant star
switches 63

reference
manual scope 9

report
server configuration 403
spreadsheet 402

restrict
code 224, 225
communication 220, 223
data 223, 224
system access 195

restriction
software access 165

ring
controller switches 59
topology 58

routing
and HSRP 41
enable switch 37
hot standby 41
VLAN gateway 43

runtime
download to PanelView 309
security 304

S
scope

DHCP 104
reference manual 9

security 196
audit 196
configure FactoryTalk View ME 300
controller 203
enable controller 217
FactoryTalk 183
FactoryTalk SE 284, 300
HMI 284
hybrid group 183
levels for group 198
runtime 304
system policies 197
workflow 184

server
NTP configuration 133

setting
check IP address 20
configure switch 20

shortcut
data server 250

smartports
configuration 47

software
access restriction 165

spreadsheet
reports 402

star
topology 53

static
IP address’ IP address

static 74
supervisory

DHCP scope 107
SW007 and SW008

description 55, 57, 60, 62, 65, 69
428 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019



Index
switch
check IP address 20
controller 54
controller ring 59
enable routing 37
express setup 21
I/O 55
initial setting 20
layer 2 configuration 55
MCC 56, 62, 72
port descriptions 51
PRP I/O (redbox) 71
redboxes 64
redundant star 63
ring 58

switch configuration
I/O network 52

sync
time configuration 231

synchronization path
Historian 340

system
access restrictions 195
security policies 197
server

configuration 77
workflow 18

T
terminal server

default 193
time

GPS sync 236
PTP synced controllers 241
sync 231

configure for PanelView 306
Ethernet bridges 239
workflow 233

sync GPS reference 232
sync NTP server 231

topology
ring 58
star 53
workflow 46

track
assets 407

U
USB drive

protection 161, 163
user manual

overview 15
users

assignment groups 125
PlantPAx policy object 160

users and groups
configuration 118, 185
internal 191

V
visual

naming conventions 10
VLAN

creation 29
IP address range 18
SW007 and SW008 55, 57, 60, 62, 65, 69

W
Windows

desklock utility 417
firewall 171

workflow
asset management 408
controller security 204
FactoryTalk

components 168
security 184

group policy 132
Historian server 314
PASS 244
PlantPAx

infrastructure 19, 46
system servers 18
time sync 233

workgroup
configuration 415
Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019 429



Index
Notes:
430 Rockwell Automation Publication PROCES-UM001C-EN-P - June 2019





Publication PROCES-UM001C-EN-P - June 2019
Supersedes Publication PROCES-UM001B-EN-P - August 2018 Copyright © 2019 Rockwell Automation, Inc. All rights reserved. Printed in the U.S.A.

Rockwell Automation Support
Use the following resources to access support information.

Documentation Feedback
Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete the 
How Are We Doing? form at http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf.

Technical Support Center Knowledgebase Articles, How-to Videos, FAQs, Chat, User 
Forums, and Product Notification Updates. https://rockwellautomation.custhelp.com/ 

Local Technical Support Phone Numbers Locate the phone number for your country. http://www.rockwellautomation.com/global/support/get-support-now.page 

Direct Dial Codes Find the Direct Dial Code for your product. Use the code to 
route your call directly to a technical support engineer. http://www.rockwellautomation.com/global/support/direct-dial.page 

Literature Library Installation Instructions, Manuals, Brochures, and 
Technical Data. http://www.rockwellautomation.com/global/literature-library/overview.page 

Product Compatibility and Download 
Center (PCDC)

Get help determining how products interact, check 
features and capabilities, and find associated firmware. http://www.rockwellautomation.com/global/support/pcdc.page 

.

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

Rockwell Automation maintains current product environmental information on its website at http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page.

Allen-Bradley, CompactLogix, ControlLogix, FactoryTalk, FactoryTalk Network Manager, Incuity, Integrated Architecture, INTERCHANGE, NetBIOS, Open Controller, PanelView, PlantMetrics, PlantPAx, PowerFlex, PowerMonitor, Rockwell 
Automation, Rockwell Software, RSBizWare, RSLinx, RSLogix 5000, RSMACC, Stratix, Studio 5000 Architect, Studio 5000 Logix Designer, Trusted, and VantagePoint are trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.Trademarks not belonging to Rockwell Automation are property of their respective companies.

http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page

	PlantPAx Distributed Control SystemInfrastructure Configuration
	Important User Information
	Table of Contents
	Preface
	Purpose of the User Manual
	New and Updated Information
	Manual Conventions
	Default User Name
	Rebranding of FactoryTalk Linx Software
	Action Identifier

	Configure Programs Menu
	Additional Resources

	Configure Network Infrastructure
	Overview
	PlantPAx Topology Examples
	VLAN Basics

	Common Network Switch Configurations
	Verify Workstation IP Address Settings
	Configure the Switch Express Setup
	Complete Switch Optimization

	Distribution Switch Configuration
	Enable Switch Routing
	Configure EtherChannels (Link Aggregation)
	Configure Switch Ports
	Using a Terminal Emulator (PuTTY)
	Enabling IP Helper


	Control Network Switch Configurations
	Before You Begin
	Configure Smartports
	Identify Connected Devices with a Port Description

	I/O Network Switch Configuration
	Star Topology Switch Configuration
	Configure Controller Switches
	Configure I/O Switches
	Configure MCC Switches

	Ring Topology Switch Configuration
	Configure Controller Switches
	Enable a DLR
	Configure MCC Switches

	Redundant Star Switch Configuration
	Configure Controller Switches
	Configure PRP Distribution
	Enable PRP I/O (RedBox) Switch
	Configure MCC Switches

	Optimize Switches for Redundant Controllers
	Configure Switch Routing
	Configure a Static IP Address


	Configure System Servers
	Considerations
	Configure the Primary Domain Controller
	Configure a Secondary Domain Controller
	Create a Reverse DNS Lookup Zone
	Map Host Name to IP Address

	Enable DHCP in the Primary and Secondary Controllers
	Add DHCP Server Role
	Configure DHCP Server
	Enable DHCP Scope (Control Network)
	Enable DHCP Scope (Supervisory Network)
	Configure Failover

	Join the Domain
	Confirm Computers in DNS Server
	Confirm Computers in DHCP Server

	Create Groups and Users
	Unit Groups
	Role Groups
	Area Groups
	Create Users
	Assign Users to a Group


	Configure Group Policy Management
	Considerations
	Default Domain Controller Policy
	Configuring the NTP Server
	Configuring Windows Time Service
	Enforcing the Domain Controller Policy

	Default Domain Policy
	Configuring an NTP Client
	Configuring Windows Time Service
	Configuring Password Strength
	Configuring Account Lockout Policy
	Configuring Kerberos Policy
	Configuring an Interactive Logon
	Enforcing the Domain Policy

	PlantPAx Users Policy Object
	Define Group Access Level
	USB Drive Protection
	Configure Portable Device Enumerator Service
	Software Access Restriction


	Configure FactoryTalk Components
	Considerations
	Configure the FactoryTalk Directory
	Enable Windows Firewall
	Define Network Directory

	Use FactoryTalk Activation to Apply Licenses
	Open Activation Manager

	Use FactoryTalk Patches From the PCDC

	Configure FactoryTalk Security
	Considerations
	Configure FactoryTalk Users and Groups
	Assign User Domain to FactoryTalk Directory
	Create Internal Users and Groups

	Define FactoryTalk System Policies
	Use Default Terminal Client
	Use the Same FactoryTalk Log On
	Restrict Application Authorization
	Audit Security Actions

	Define the Security System Policy
	Define FactoryTalk Product Policies
	Create Permission Sets

	Configure the Controller
	Consideration
	Use Architect for Controller Initiation
	Change Controller Properties
	Configure Network Adapters
	Synchronize the Project
	Configure RSLinx Classic Software
	Download the Controller
	Enable Controller Security
	Create a Controller Logical Name
	Configure Authority Identifier
	Configure Communication Restrictions
	Configure Data Restrictions
	Configure Code Restrictions


	Configure Time Synchronization
	Considerations
	Configure UTC Time Source
	Configure Internet Time Synchronization
	NTP to PTP Clock Conversion
	Configure GPS Time Synchronization

	Configure PTP Time Synchronization for Ethernet Bridges
	Enable Switch Port Modes
	Configure PTP Time Synchronization for Controllers


	Configure the Process Automation System Server (PASS)
	Considerations
	Configure Servers on PASS
	Configure the Application
	Configure the HMI Server
	Primary HMI Server
	Configure the Data Server
	Configure the Alarm and Event Server

	Commit Project
	Configure Redundancies
	Enable HMI Redundancy
	Enable Data Server Redundancy
	Shortcut Configuration Paths
	Redundant ControlLogix Controller
	Enable Alarm and Event Redundancy

	Create Alarm and Event Database
	Define HMI Security
	Configure FactoryTalk SE Security

	Configure PanelView Plus
	Create a FactoryTalk View ME Project
	Configure FactoryTalk View ME Security
	Configure Time Synchronization for PanelView Terminals
	Download the Application


	Configure an Application Server Information Server (AppServ-Info)
	Considerations
	FactoryTalk Historian
	FactoryTalk VantagePoint

	Configure Historian SE Server Collective
	Create a Firewall Rule for Primary Historian Server
	Create a Firewall Rule for Secondary Historian Servers
	Change the Historian Identification
	Set Security Settings
	Create a Server Collective

	Configure a Historian SE Server
	Create a Historian Server
	Create a Synchronization Path

	Configure a Node Interface
	Configure Primary Node Interface Server
	Configure Secondary Node Interface Server

	Configure FactoryTalk Live Data Connectors
	Configure a FactoryTalk Live Data Primary Connector
	Configure a FactoryTalk Live Data Secondary Connector
	Confirm Unit Failover Diagnostics

	Configure a Performance Monitor Interface
	Create PIPerfMon System User
	Configure the PIPerfMon Interface
	Import PIPerfMon Digital State
	Create PIPerfMon Interface Health Points
	Monitor PIPerfMon Interface

	Enable Performance Monitor
	Adding PIPerfMon User
	Adding PIPerfMon Firewall Rule
	Enabling PIPerfMon Counter Service

	Configure FactoryTalk Historian Connectivity
	View PI Builder Excel Add-in
	Configure FactoryTalk VantagePoint Historian Tags

	Configure Asset Management (AppServ-Asset)
	Considerations
	Configure Diagnostic Settings
	View Audit Log


	Access the Attachments
	Open Content
	How to Use Attachments

	Define a Workgroup and DeskLock Utility
	Enable the Windows DeskLock Utility (optional)

	Firewall Configurations
	Common Ports
	Rockwell Automation TCP/UDP Ports

	Index

	Back Cover


System Policies

		System Policies		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Create Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Delete		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Execute		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow



























































































































































































































































































































































































































































































































































Product Policies

		Product Policies		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		RSLogix5000

		Feature Security

		Project: New		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Print: Modify Options		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Secure		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Toolbar: Configure		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Firmware: Update		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Workstation: Modify Options		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Studio 5000 Architect

		Feature Security

		Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Open		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Save		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Batch

		. Batch Campaign

		. . Commands

		Abort Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Abort Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Add New Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Add New Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		All Properties		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Append Batch to Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		ConfigServers		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Delete Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Delete Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Disable Triggers		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Enable Triggers		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Hold Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Hold Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Move Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Move Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Pause Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Pause Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Restart Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Restart Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Start Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Start Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Stop Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Stop Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. BatchView and ActiveX

		. . View

		Alarm Summary		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Arbitration		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Batch List		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Configuration		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Event Journals		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Exit		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Kelp		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Phase Control		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Phase Summary		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Procedure as SFC		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Procedure as Table		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Pompts		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Signatures		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. . Phase Commands

		Abort		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Ack		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Acquire		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Clear Fail		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Disconnect		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Hold		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Pause		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Phase Auto Mode		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Phase Semi-Auto Mode		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Release		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Reset		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Restart		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Resume		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Start		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Stop		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. . Commands

		Abort		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Ack		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Acquire		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Add Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Auto		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Bind		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Bind Ack		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Clear Fail		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Comment		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Disconnect		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Force Transition		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Hold		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Manual		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		MatSvrControl		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Override		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Override Clear		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		ParamChange		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		ReativeStep		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Release		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Remove		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Reorder		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Restart		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Resume		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Semi-Auto		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Start		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Stop		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Timer-Compete		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Timer-Reset		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. Equipment Editor

		. . Access Modes

		Full Edit		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		View Only		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. Recipe Editor

		. . Access Modes

		Full Edit		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		View Only		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Asset Centre

		Address Book Policies

		View Address Book		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Edit Address Book		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Archive Policies

		Override Archive Check In		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Configure Database Limitations		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Override Archive Undo ChkOut		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Override Removal Local Copies		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Config Personal Arc File Assoc		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Config Personal Arc Work Fold		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Config System Arc File Assoc		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Config System Arc Work Fold		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Run Archive DB Cleanup Wiz		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Calibration Management Policies

		Display Calibration Mgm Data		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Perform Calibration Mgm		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Administer Calibration Users		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		General Policies

		Switch to Design mode		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Log Policies

		View Event Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		View Audit Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		View Diag and Health Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Change Diag and Health Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		View Diag and Health Log Sts		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Run Log DB Cleanup Wizard		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Process Device Config Policies

		Enable or Disable DTMs		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Edit DTM Network

		Run PDC Field Edition		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Schedule Policies

		Create a new schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Edit a schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Delete a schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		View a schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Command a Schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Searching

		Create a Search		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		ControlFlash

		Feature Security

		Firmware: Update		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		FactoryTalk View

		Feature Security

		Configure Secure Web Site		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		RSLinx Classic

		Feature Security

		Clear DDE/OPC Event Log		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config CIP Options		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config Client Applications		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config ControlLogix Gateway		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config DDE/OPC Topic		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config Drivers and Shortcuts		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config Gateway		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config Network Properties		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Edit DDE/OPC Project		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Edit Options		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Reset Station Diag Counters		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Shutdown		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		View NT Event Log		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		RSNetWorx

		Feature Security

		Access Configurations		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Go Online		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Modify Configurations		Deny		Deny		Allow		Allow		Allow		Allow		Allow







Computers and Groups

		Computers and Groups		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Create Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Delete		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Execute		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		FT Transaction Manager

		Start, Stop and Assemble Cfg		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		RSLinx Enterprise

		Network Browse		Deny		Deny		Allow		Allow		Allow		Allow		Allow



















































































































































































































































































































































































































































































































































Network and Devices

		Network and Devices		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		RSLogix5000

		Add-On Instruction: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Add-On Instruction: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Add-On Instruction: Modify		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Alarm: Clear Alarm Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Clear Fault		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Lock/Unlock		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Modify Mode		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Modify Revision		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Modify Type		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Unsecure		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Clear Log Data Value		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Enable/Disable		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Modify		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Read Log Data Value		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Firmware: Update		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Language: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Language: Switch Language		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Maintenance High		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Maintenance Low		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Motion: Command Axis		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Motion: Modify Configuration		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Nonvolatile Memory: Load		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Nonvolatile Memory: Store		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Phase: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Phase: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Phase: Manual Control		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Phase: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		PLC/SLC: Modify Tag Mappings		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Print: Report		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Program: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Program: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Program: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Compact		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Download		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Export		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Go Online		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Modify Path		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Open		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Save		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Save As		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Upload		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Manual Control		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Modify Logic		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Gen/Del Signature		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Lock/Unlock		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Modify Component		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Modify Tag Mappings		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Force		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Modify Constant Property		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Modify Constant Tag Value		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Modify Values		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Task: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Task: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Task: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Trend: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Trend: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Trend:Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Trend: Run		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		User Defined Type: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		User Defined Type: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		User Defined Type: Modify		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Sequence Manager

		Event Server: Cfg Archiv Service		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Event Server: Cfg Client Service		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Event Server: Cfg Decod Service		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Parameter: Change Parameter		Deny		Allow		Allow		Allow		Allow		Allow		Allow

		Parameter: En/Dis Expression		Deny		Allow		Allow		Allow		Allow		Allow		Allow

		Parameter: Force Param Eval		Deny		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Abort		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Change Active Steps		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Change Mode		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Change Ownership		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Clear Failures		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Hold		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Pause and Resume		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Reset		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Restart		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Set ID		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Start		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Stop		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Abort		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Clear Failures		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Hold		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Pause and Resume		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Reset		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Restart		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Start		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Stop		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Transition: Force Expression		Allow		Allow		Allow		Allow		Allow		Allow		Allow















































































































































































































































































































































Users and Groups

		Users and Groups		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Create Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Delete		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Execute		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow



























































































































































































































































































































































































































































































































































Connections

		Connections		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Create Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Delete		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Execute		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow






























































































































































































































































































































































































































































































































































!

! Last configuration change at 13:35:38 UTC Wed Aug 15 2018 by admin

! NVRAM config last updated at 13:45:57 UTC Wed Aug 15 2018 by admin

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

service unsupported-transceiver

!

hostname SW001

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

switch 2 provision 1783-ims28rac

system mtu routing 1500

no ip source-route

ip routing

ip arp inspection vlan 1000

ip arp inspection vlan 1000 logging dhcp-bindings none

no ip cef optimize neighbor resolution

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode forward 

!

!

crypto pki trustpoint TP-self-signed-861450112

 enrollment selfsigned

 subject-name cn=IOS-Self-Signed-Certificate-861450112

 revocation-check none

 rsakeypair TP-self-signed-861450112

!

!

crypto pki certificate chain TP-self-signed-861450112

 certificate self-signed 01 nvram:IOS-Self-Sig#6.cer

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

cip security password 105C061A0E00170700

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery cause loopdetect

errdisable recovery interval 30

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding not-operating fcs-error 

 syslog link-fault not-forwarding not-operating fcs-error 

 notifies link-fault not-forwarding not-operating fcs-error 

 relay-major not-forwarding 

!

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

!

!

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501

 name VLAN0501 

!

vlan 502

 name VLAN0502 

!

vlan 503

 name VLAN0503 

!

vlan 504

 name VLAN0504 

!

vlan 505

 name VLAN0505 

!

vlan 506

 name VLAN0506 

!

vlan 507

 name VLAN0507 

!

vlan 508

 name VLAN0508 

!

vlan 509

 name VLAN0509 

!

vlan 601

 name VLAN0601 

!

vlan 602

 name VLAN0602 

!

vlan 603

 name VLAN0603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Output-accesspoint

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 19 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 40 

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

! 

!

!

!

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel1

 description SW040

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 spanning-tree link-type point-to-point

!

interface Port-channel2

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

!

interface Port-channel3

 description connection to Vertec .12

 switchport access vlan 501

 switchport mode access

!

interface Port-channel4

 description connection to Vertec .13

 switchport access vlan 501

 switchport mode access

!

interface Port-channel5

 description SW020

 switchport trunk native vlan 301

 switchport mode trunk

!

interface Port-channel6

 description SW030

 switchport trunk native vlan 301

 switchport mode trunk

!

interface GigabitEthernet1/1

 description connection to Vertec .12

 switchport access vlan 501

 switchport mode access

 channel-group 3 mode on

!

interface GigabitEthernet1/2

 description connection to Vertec .12

 switchport access vlan 501

 switchport mode access

 channel-group 3 mode on

!

interface GigabitEthernet1/3

 description connection to Vertec .13

 switchport access vlan 501

 switchport mode access

 channel-group 4 mode on

!

interface GigabitEthernet1/4

 description connection to Vertec .13

 switchport access vlan 501

 switchport mode access

 channel-group 4 mode on

!

interface GigabitEthernet1/5

 description SW020

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 5 mode active

!

interface GigabitEthernet1/6

 description SW020

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 5 mode active

!

interface GigabitEthernet1/7

 description SW030

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 6 mode active

!

interface GigabitEthernet1/8

 description SW030

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 6 mode active

!

interface GigabitEthernet1/9

 description SW040

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 channel-group 1 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/10

 description SW040

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 channel-group 1 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/11

 description SW050

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 description SW051

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/21

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/22

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/23

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/24

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/25

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 channel-group 2 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/26

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 channel-group 2 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/27

!

interface TenGigabitEthernet1/28

!

interface Vlan1

 ip address dhcp

!

interface Vlan300

 ip address 172.18.0.1 255.255.255.0

!

interface Vlan501

 ip address 172.18.1.1 255.255.255.0

!

interface Vlan502

 ip address 172.18.2.1 255.255.255.0

!

interface Vlan503

 ip address 172.18.3.1 255.255.255.0

!

interface Vlan504

 ip address 172.18.4.1 255.255.255.0

!

interface Vlan505

 ip address 172.18.5.1 255.255.255.0

!

interface Vlan506

 ip address 172.18.6.1 255.255.255.0

!

interface Vlan507

 ip address 172.18.7.1 255.255.255.0

!

interface Vlan508

 ip address 172.18.8.1 255.255.255.0

!

interface Vlan509

 ip address 172.18.9.1 255.255.255.0

!

interface Vlan601

 ip address 172.20.1.1 255.255.255.0

!

interface Vlan602

 ip address 172.20.2.1 255.255.255.0

!

interface Vlan603

 ip address 172.20.3.1 255.255.255.0

!

ip forward-protocol nd

!

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

snmp-server community PlantPax RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change

snmp-server enable traps ospf cisco-specific state-change shamlink interface

snmp-server enable traps ospf cisco-specific state-change shamlink neighbor

snmp-server enable traps ospf cisco-specific errors

snmp-server enable traps ospf cisco-specific retransmit

snmp-server enable traps ospf cisco-specific lsa

snmp-server enable traps license

snmp-server enable traps bfd

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps bgp cbgp2

snmp-server enable traps ether-oam

snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change inconsistency

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps pki

snmp-server enable traps trustsec authz-file-error cache-file-error keystore-file-error keystore-sync-fail random-number-fail src-entropy-fail

snmp-server enable traps trustsec-policy peer-policy-updated authz-sgacl-fail

snmp-server enable traps trustsec-sxp conn-srcaddr-err msg-parse-err conn-config-err binding-err conn-up conn-down binding-expn-fail oper-nodeid-change binding-conflict

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps hsrp

snmp-server enable traps ipmulticast

snmp-server enable traps ike policy add

snmp-server enable traps ike policy delete

snmp-server enable traps ike tunnel start

snmp-server enable traps ike tunnel stop

snmp-server enable traps ipsec cryptomap add

snmp-server enable traps ipsec cryptomap delete

snmp-server enable traps ipsec cryptomap attach

snmp-server enable traps ipsec cryptomap detach

snmp-server enable traps ipsec tunnel start

snmp-server enable traps ipsec tunnel stop

snmp-server enable traps ipsec too-many-sas

snmp-server enable traps isis

snmp-server enable traps msdp

snmp-server enable traps ospfv3 state-change

snmp-server enable traps ospfv3 errors

snmp-server enable traps power-ethernet group 2

snmp-server enable traps power-ethernet police

snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps ipsla

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps trustsec-interface unauthorized sap-fail authc-fail supplicant-fail authz-fail

snmp-server enable traps trustsec-server radius-server provision-secret

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

no vstack

!

line con 0

 login local

line vty 0 4

 login local

 transport input ssh

line vty 5 15

 login local

 transport input ssh

!

ntp server 172.18.1.10 prefer

!

end






!

! Last configuration change at 12:00:08 UTC Sun Aug 13 2034 by admin

! NVRAM config last updated at 12:00:12 UTC Sun Aug 13 2034 by admin

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

service unsupported-transceiver

!

hostname SW011

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

switch 2 provision 1783-ims28nac

system mtu routing 1500

no ip source-route

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode forward 

!

!

!

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery cause loopdetect

errdisable recovery interval 30

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding fcs-error 

 syslog link-fault not-forwarding fcs-error 

 notifies link-fault not-forwarding fcs-error 

 relay-major not-forwarding 

!

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501-509,601-603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Output-accesspoint

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 19 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 40 

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel2

 description Group 2 Connection from SW011 to SW001

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

!

interface GigabitEthernet1/1

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/2

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 speed 100

 duplex full

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/3

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/4

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/5

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/6

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/7

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/8

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/9

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/10

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/11

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/21

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/22

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/23

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/24

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/25

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 channel-group 2 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/26

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 channel-group 2 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/27

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/28

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface Vlan1

 cip enable

!

interface Vlan300

 ip address 172.18.0.11 255.255.255.0

!

ip default-gateway 172.18.0.1

ip forward-protocol nd

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

!

snmp-server community rockwell RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps license

snmp-server enable traps bfd

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps ether-oam

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps pki

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps power-ethernet group 2

snmp-server enable traps power-ethernet police

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

no vstack

!

line con 0

 login local

line vty 0 4

 login local

 transport input none

line vty 5 15

 login local

 transport input none

!

ntp server 172.18.1.10

!

end






!

! Last configuration change at 18:53:33 UTC Fri Aug 3 2018 by admin

! NVRAM config last updated at 18:53:33 UTC Fri Aug 3 2018 by admin

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

!

hostname SW020

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

system mtu routing 1500

no ip source-route

ip arp inspection vlan 1000

ip arp inspection vlan 1000 logging dhcp-bindings none

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode gmc-bc 

ptp priority1 126 

ptp priority2 127 

!





!

crypto pki trustpoint TP-self-signed-856779392

 enrollment selfsigned

 subject-name cn=IOS-Self-Signed-Certificate-856779392

 revocation-check none

 rsakeypair TP-self-signed-856779392

!

!

crypto pki certificate chain TP-self-signed-856779392

 certificate self-signed 01 nvram:IOS-Self-Sig#3.cer

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

cip security password 075F751817594D5542425F5F527E72707A6360

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery interval 30

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding not-operating fcs-error 

 syslog link-fault not-forwarding not-operating fcs-error 

 notifies link-fault not-forwarding not-operating fcs-error 

 relay-major not-forwarding 

!

alarm facility power-supply rps disable

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

!

!

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501-502 

!

vlan 503

 name VLAN0503 

!

vlan 504 

!

vlan 505

 name VLAN0505 

!

vlan 506

 name VLAN0506 

!

vlan 507-509,601-603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  police 4000000

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

! 

!

!

!

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel1

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

!

interface GigabitEthernet1/1

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 1 mode active

!

interface GigabitEthernet1/2

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 1 mode active

!

interface GigabitEthernet1/3

!

interface GigabitEthernet1/4

!

interface GigabitEthernet1/5

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/6

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/7

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/8

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/9

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/10

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/11

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface Vlan1

 no ip address

 no ip route-cache

 shutdown

!

interface Vlan300

 ip address 172.18.0.20 255.255.255.0

!

interface Vlan301

 no ip address

!

interface Vlan501

 ip address 172.18.1.200 255.255.255.0

 cip enable

!

ip default-gateway 172.18.0.1

ip forward-protocol nd

!

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

snmp-server community PlantPAx RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change

snmp-server enable traps ospf cisco-specific state-change shamlink interface

snmp-server enable traps ospf cisco-specific state-change shamlink neighbor

snmp-server enable traps ospf cisco-specific errors

snmp-server enable traps ospf cisco-specific retransmit

snmp-server enable traps ospf cisco-specific lsa

snmp-server enable traps license

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps bgp cbgp2

snmp-server enable traps ether-oam

snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change inconsistency

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps trustsec-sxp conn-srcaddr-err msg-parse-err conn-config-err binding-err conn-up conn-down binding-expn-fail oper-nodeid-change binding-conflict

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps hsrp

snmp-server enable traps ipmulticast

snmp-server enable traps isis

snmp-server enable traps msdp

snmp-server enable traps ospfv3 state-change

snmp-server enable traps ospfv3 errors

snmp-server enable traps power-ethernet police

snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps ipsla

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

vstack

!

line con 0

 password 7 1500040F0F3D2E2824

 login

line vty 0 4

 password 7 1500040F0F3D2E2824

 login local

 transport input telnet ssh

line vty 5 15

 password 7 1500040F0F3D2E2824

 login local

 transport input telnet ssh

!

ntp server 172.18.1.10 prefer

!

end






!

! Last configuration change at 18:49:00 UTC Fri Aug 3 2018 by admin

! NVRAM config last updated at 18:49:00 UTC Fri Aug 3 2018 by admin

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

service unsupported-transceiver

!

hostname SW030

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

system mtu routing 1500

no ip source-route

ip routing

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode gmc-bc 

ptp priority1 126 

ptp priority2 127 

!

dlr ring 1

 mode supervisor

  precedence 255

dlr ring 2

 mode supervisor

  precedence 255

  control-vlan-id 503

dlr ring 3

 mode supervisor

  control-vlan-id 504





dlr ring 1

 ring-dhcp

  snooping enable



dlr ring 2

 ring-dhcp

  snooping enable



dlr ring 3

 ring-dhcp

  snooping enable



!

crypto pki trustpoint TP-self-signed-857057152

 enrollment selfsigned

 subject-name cn=IOS-Self-Signed-Certificate-857057152

 revocation-check none

 rsakeypair TP-self-signed-857057152

!

!

crypto pki certificate chain TP-self-signed-857057152

 certificate self-signed 01 nvram:IOS-Self-Sig#2.cer

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

no spanning-tree vlan 501

cip security password 111B16061C050E0008

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery cause loopdetect

errdisable recovery interval 30

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding not-operating fcs-error 

 syslog link-fault not-forwarding not-operating fcs-error 

 notifies link-fault not-forwarding not-operating fcs-error 

 relay-major not-forwarding 

!

alarm relay-mode negative

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

!

!

!

vlan configuration 1006-1008

  no ip igmp snooping

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501-502 

!

vlan 503

 name VLAN0503 

!

vlan 504

 name VLAN0504 

!

vlan 505-509,601-603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Output-accesspoint

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 19 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 40 

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

! 

!

!

!

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel1

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

!

interface GigabitEthernet1/1

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 1 mode active

!

interface GigabitEthernet1/2

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 1 mode active

!

interface GigabitEthernet1/3

 switchport trunk native vlan 301

 switchport mode trunk

 ptp sync limit 10000

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/4

 switchport trunk native vlan 301

 switchport mode trunk

 ptp sync limit 10000

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/5

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 1

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/6

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 1

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/7

 switchport access vlan 503

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 2

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/8

 switchport access vlan 503

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 2

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/9

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 3

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/10

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 dlr ring 3

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/11

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 macro description ab-multiport-device

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 300

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 description controller VLAN501

 switchport access vlan 501

 switchport trunk native vlan 300

 ptp sync limit 10000

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface Vlan1

 no ip address

 shutdown

!

interface Vlan300

 ip address 172.18.0.30 255.255.255.0

!

interface Vlan301

 no ip address

!

interface Vlan501

 ip address 172.18.1.210 255.255.255.0

 cip enable

!

interface Vlan503

 ip address 172.18.3.1 255.255.255.0

!

interface Vlan504

 ip address 172.18.4.1 255.255.255.0

!

ip forward-protocol nd

!

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

ip route 0.0.0.0 0.0.0.0 172.18.0.1

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

snmp-server community PlantPAx RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change

snmp-server enable traps ospf cisco-specific state-change shamlink interface

snmp-server enable traps ospf cisco-specific state-change shamlink neighbor

snmp-server enable traps ospf cisco-specific errors

snmp-server enable traps ospf cisco-specific retransmit

snmp-server enable traps ospf cisco-specific lsa

snmp-server enable traps license

snmp-server enable traps bfd

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps bgp cbgp2

snmp-server enable traps ether-oam

snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change inconsistency

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps pki

snmp-server enable traps trustsec authz-file-error cache-file-error keystore-file-error keystore-sync-fail random-number-fail src-entropy-fail

snmp-server enable traps trustsec-policy peer-policy-updated authz-sgacl-fail

snmp-server enable traps trustsec-sxp conn-srcaddr-err msg-parse-err conn-config-err binding-err conn-up conn-down binding-expn-fail oper-nodeid-change binding-conflict

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps hsrp

snmp-server enable traps ipmulticast

snmp-server enable traps ike policy add

snmp-server enable traps ike policy delete

snmp-server enable traps ike tunnel start

snmp-server enable traps ike tunnel stop

snmp-server enable traps ipsec cryptomap add

snmp-server enable traps ipsec cryptomap delete

snmp-server enable traps ipsec cryptomap attach

snmp-server enable traps ipsec cryptomap detach

snmp-server enable traps ipsec tunnel start

snmp-server enable traps ipsec tunnel stop

snmp-server enable traps ipsec too-many-sas

snmp-server enable traps isis

snmp-server enable traps msdp

snmp-server enable traps ospfv3 state-change

snmp-server enable traps ospfv3 errors

snmp-server enable traps power-ethernet police

snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps ipsla

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps trustsec-interface unauthorized sap-fail authc-fail supplicant-fail authz-fail

snmp-server enable traps trustsec-server radius-server provision-secret

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

no vstack

!

line con 0

 password 7 095E410A1212121E07

 login

line vty 0 4

 login local

 transport input telnet ssh

line vty 5 15

 login local

 transport input telnet ssh

!

ntp server 172.18.1.10

!

end






!

! Last configuration change at 13:30:20 UTC Wed Aug 15 2018

! NVRAM config last updated at 13:42:06 UTC Wed Aug 15 2018

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

!

hostname SW040

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

system mtu routing 1500

no ip source-route

ip routing

ip arp inspection vlan 1000

ip arp inspection vlan 1000 logging dhcp-bindings none

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode gmc-bc 

ptp priority1 126 

ptp priority2 127 

!





!

crypto pki trustpoint TP-self-signed-857110400

 enrollment selfsigned

 subject-name cn=IOS-Self-Signed-Certificate-857110400

 revocation-check none

 rsakeypair TP-self-signed-857110400

!

!

crypto pki certificate chain TP-self-signed-857110400

 certificate self-signed 01 nvram:IOS-Self-Sig#1.cer

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

cip security password 044904050436494205

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery interval 30

port-channel load-balance src-dst-ip

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding not-operating fcs-error 

 syslog link-fault not-forwarding not-operating fcs-error 

 notifies link-fault not-forwarding not-operating fcs-error 

 relay-major not-forwarding 

!

alarm facility power-supply rps disable

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

!

!

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501-504 

!

vlan 505

 name VLAN0505 

!

vlan 506

 name VLAN0506 

!

vlan 507-509,601-603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

! 

!

!

!

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel1

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 spanning-tree link-type point-to-point

!

interface PRP-channel1

 switchport trunk native vlan 301

 switchport mode trunk

 spanning-tree bpdufilter enable

!

interface GigabitEthernet1/1

 switchport trunk native vlan 301

 switchport mode trunk

 no cdp enable

 ptp vlan 501

 macro description switch-automation

 alarm profile ab-alarm

 no lldp transmit

 no lldp receive

 spanning-tree portfast edge

 spanning-tree link-type point-to-point

 prp-channel-group 1

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/2

 switchport trunk native vlan 301

 switchport mode trunk

 no cdp enable

 ptp vlan 501

 macro description switch-automation

 alarm profile ab-alarm

 no lldp transmit

 no lldp receive

 spanning-tree link-type point-to-point

 prp-channel-group 1

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/3

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 channel-group 1 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/4

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 channel-group 1 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/5

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/6

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/7

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/8

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/9

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/10

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/11

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface Vlan1

 no ip address

 shutdown

!

interface Vlan300

 ip address 172.18.0.40 255.255.255.0

!

interface Vlan501

 ip address 172.18.1.220 255.255.255.0

 cip enable

!

interface Vlan505

 ip address 172.18.5.1 255.255.255.0

!

interface Vlan506

 ip address 172.18.6.1 255.255.255.0

!

ip forward-protocol nd

!

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

ip route 0.0.0.0 0.0.0.0 172.18.0.1

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

snmp-server community PlantPAx RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change

snmp-server enable traps ospf cisco-specific state-change shamlink interface

snmp-server enable traps ospf cisco-specific state-change shamlink neighbor

snmp-server enable traps ospf cisco-specific errors

snmp-server enable traps ospf cisco-specific retransmit

snmp-server enable traps ospf cisco-specific lsa

snmp-server enable traps license

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps bgp cbgp2

snmp-server enable traps ether-oam

snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change inconsistency

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps trustsec-sxp conn-srcaddr-err msg-parse-err conn-config-err binding-err conn-up conn-down binding-expn-fail oper-nodeid-change binding-conflict

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps hsrp

snmp-server enable traps ipmulticast

snmp-server enable traps isis

snmp-server enable traps msdp

snmp-server enable traps ospfv3 state-change

snmp-server enable traps ospfv3 errors

snmp-server enable traps power-ethernet police

snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps ipsla

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

vstack

!

line con 0

 password 7 1500040F0F3D2E2824

 login

line vty 0 4

 password 7 1500040F0F3D2E2824

 login local

 transport input telnet ssh

line vty 5 15

 password 7 1500040F0F3D2E2824

 login local

 transport input telnet ssh

!

ntp server 172.18.1.10 prefer

!

end



